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About This Guide

This Novell® Messenger 2.0 Administration Guide helps you configure and manage your Novell
Messenger system.

Chapter 1, “Understanding Your Novell Messenger System,” on page 13
Chapter 2, “Managing the Messaging Agent,” on page 25

Chapter 3, “Managing Messenger Client Users,” on page 77

Chapter 4, “Enabling and Managing Archiving,” on page 131

Chapter 5, “Managing Chat Rooms,” on page 173

Appendix A, “Documentation Updates,” on page 189

Audience

This guide is intended for network administrators who administer Messenger.

Feedback

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comments feature at the bottom of each page of the
online documentation, or go to www.novell.com/documentation/feedback.html and enter your
comments there.

Documentation Updates

For the most recent version of the Messenger 2.0 Administration Guide, visit the Novell GroupWise
Messenger 2.0 documentation Web site (http://www.novell.com/documentation/nm?2).

Additional Documentation

For additional Messenger documentation, see the Messenger 2.0 Installation Guide at the Novell
GroupWise® Messenger 2.0 documentation Web site (http://www.novell.com/documentation/nm2).

Documentation Conventions

In Novell documentation, a greater-than symbol (>) is used to separate actions within a step and
items in a cross-reference path.

A trademark symbol (®, ™ etc.) denotes a Novell trademark. An asterisk (*) denotes a third-party
trademark.

When a single pathname can be written with a backslash for some platforms or a forward slash for
other platforms, the pathname is presented with a backslash. Users of platforms that require a
forward slash, such as Linux* or UNIX*, should use forward slashes as required by your software.

About This Guide

1"


http://www.novell.com/documentation/nm2
http://www.novell.com/documentation/nm2
http://www.novell.com/documentation/nm2
http://www.novell.com/documentation/nm2
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User Comments

We want to hear your comments and suggestions about this manual and the other documentation
included with this product. Please use the User Comment feature at the bottom of each page of the
online documentation, or go to www.novell.com/documentation/feedback.html and enter your
comments there.
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Understanding Your Novell
Messenger System

By following the instructions in the Messenger 2.0 Installation Guide, you set up a basic Messenger
system. With the help of the Messenger Installation program, you installed software and created
Novell® eDirectory™ objects. The following topics help you understand your initial Messenger
system:

¢ Section 1.1, “Software Components,” on page 13

¢ Section 1.2, “eDirectory Objects,” on page 15

¢ Section 1.3, “Language Availability,” on page 22

1.1 Software Components

During installation of your Messenger system, you selected components to install, as described in
“Installing a Novell Messenger System” in the Messenger 2.0 Installation Guide.

Figure 1-1 Install Components Page of the Messenger Installation Program

Novell Messenger Server, Setup &l
Installation Options
Create a new spstem or add a server to an existing system. N
% Create or update a system: Extend the directory schema, create the necessary

directory objects, and install or update the Movel
Messenger software on a server.

" Install or update a server; Install or update the Novel Messenger software on a
SETYEL,

" Extend schema anly: Extend the directory schema only.

" Admin files only: Only install the neceszary files to administer a Movell

Messenger system through ConsoleCne.

Cancel 1

Installation Guide j

NOTE: The Installation program interface illustrated throughout this section is available when
installing from a Windows* workstation, but not when installing on Linux, where a text-based
interface is used.

¢ Section 1.1.1, “Messaging Agent,” on page 14
¢ Section 1.1.2, “Archive Agent,” on page 14

¢ Section 1.1.3, “Administration Files,” on page 14

Understanding Your Novell Messenger System
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1.1.1 Messaging Agent

One Messaging Agent runs in your Messenger system. The Messaging Agent performs the
following activities:

+ Accesses Novell eDirectory on behalf of users to authenticate users to the Messenger system
when they start the Messenger client, to search for contacts as users build their contact lists, to
save users' option settings for the Messenger client, and so on

¢ Transfers instant messages back and forth between Messenger users

+ Maintains presence information about Messenger users so that the Messenger client can show
user availability status (such as online, busy, away, and idle)

+ Passes conversations to the Archive Agent if archiving is enabled
The Messaging Agent is highly scalable. If you are setting up a large Messenger system, you should
run the Messaging Agent on a dedicated server with a processor speed of 1-2 GHz and with 1 GB of
RAM. The Messaging Agent has been tested to easily support 1000 active conversations on such
hardware. If you assume that 2% of Messenger users might be conversing simultaneously, you could
plan on your Messenger system including as many as 50,000 users. Although Messenger has not
been tested with this many actual users, you can be confident that it can scale to meet the needs of a

very large number of users. For more information on the Messaging Agent, see Chapter 2,
“Managing the Messaging Agent,” on page 25.

1.1.2 Archive Agent

If you need to retain a long-term record of all conversations, you can enable archiving. For example,
you might need to retain conversations for legal reasons, as an aspect of a corporate e-mail retention
policy.

In order to enable archiving, you need to run one Archive Agent in your Messenger system. The
Archive Agent performs the following activities:

+ Accesses eDirectory on behalf of authorized Messenger users in order to grant them access to
the Messenger archive

+ Receives completed conversations from the Messaging Agent and stores them in the
Messenger archive

¢ Indexes the archived conversations so that they can be searched by authorized Messenger users
¢ Performs searches in the Messenger archive for authorized Messenger users

¢ Manages expiration of old conversations

+ Repairs the Messenger archive in case of damage to its database

For more information on the Archive Agent, see Chapter 4, “Enabling and Managing Archiving,” on
page 131.

1.1.3 Administration Files
Messenger system administration is performed by using ConsoleOne®. The Messenger snap-in to

ConsoleOne can be installed with the version of ConsoleOne that runs on Windows workstations
and servers, NetWare® servers, or Linux workstations and servers. After the initial installation of

14 Novell Messenger 2.0 Administration Guide



your Messenger system, you can install the Messenger snap-in to ConsoleOne to additional
workstations and servers by using the Admin Files Only option of the Messenger Installation

program.

1.2 eDirectory Objects

When you create your Messenger system, the following eDirectory objects are created:

¢ Section 1.2.1, “Messenger Service,” on page 15
¢ Section 1.2.2, “Servers and Agents,” on page 16
¢ Section 1.2.3, “Scope Profiles,” on page 17

¢ Section 1.2.4, “LDAP Profiles,” on page 18

¢ Section 1.2.5, “Chat,” on page 19

¢ Section 1.2.6, “Hosts,” on page 20

¢ Section 1.2.7, “Policies,” on page 21

¢ Section 1.2.8, “User Properties,” on page 21

1.2.1 Messenger Service

During creation of your Messenger system, you specified where you wanted to create your
Messenger system in eDirectory, as described in “Installing a Novell Messenger System” in the

Messenger 2.0 Installation Guide.

Figure 1-2 System Configuration Page of the Messenger Installation Program

System Configuration
Specify the tree and contest of a new system or paint to an existing
system

Specify the directory tree and context to create a new Novell Messenger system in or the
tree and context of an existing Movell Messenger system container:

Tree: |CORP_TREE =l

IGroupWise

Browse... I

Cantext:

Specify the names of the following directorny objects:

System container object: IMessengerS ervice

Server object; IPHV-GWSEHVEH

Server object context: PRV-GWSERVER. MessengerS ervice. Groupiwize

IrztallShield

Installation Guide |

< Back | Mext > | Cancel |

The MessengerService object created at that location represents your Messenger system in

eDirectory.

Understanding Your Novell Messenger System
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Figure 1-3 MessengerService Object

Novell Console@ne
File Edit

View Tools Help

E s/ S| @]

HeZ B el 2 s e

[ predoctestzServer
%) ScopeContainer
¥4 PalicyContainer
o LDAPContainer
HostCantainer
ChatCaontainer

ChatCantainer
HostContainer
o LDAPContainer
*a PolicyContainer
[ prv-doctestzSene—
%) ScopeContainer
B predoctestz

€@ PRV-DOCTEST2-W
= |

" T

-

G items é]

szer: admin.corporate I'I'ree: DOCTEST2

The MessengerService container object provides container objects for a variety of types of
Messenger objects. It might be convenient for you to store all Messenger objects under the
MessengerService container, but this is not required. You can create Messenger objects elsewhere in

the eDirectory tree, if necessary.

1.2.2 Servers and Agents

During creation of your Messenger system, you selected a location where the Messenger agents
were installed, as described in “Installing a Novell Messenger System” in the Messenger 2.0

Installation Guide.

Figure 1-4 Server Information Page in the Messenger Installation Program

Server Information
Select the installation path and the type of server an which pou will
un the Movell Messenger Agents.

Server & Meatware
= Microsoft Windows Server
¥ | Iristall agenits as Windows services

¥ | Irstall and configure SNEP for the b essengen &aents

Installation path:

IIz:\NoveII\NM

Browse... |

IrztallShield

Installation Guide | < Back | Mext > I

Cancel |

As aresult, you have one Messenger Server object (named after the server where you installed the
Messenger agents) that contains objects for the Messaging Agent and Archive Agent. These agent
objects store the configuration information for the agents.
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Figure 1-5 Server and Agent Objects

Novell ConsoleQne

File Edit Yiew Tools Help
Helz|®|e|c|a 2/salal o = mslel
@MYWDrId = %MessagingAgent

- NDS (9 ArchiveAgent
2§ DOCTEST2

&2 corporate

E@ MessengerSenice

ChatCantainer

HostContainer

& LDAPContainer

#-¥43 PalicyContainer

8, ScopeCantainer

B predoctestz

€2 PRV-DOCTEST2-W

= |

-

‘| e dlm ke i mff*l = 2 tems %

szer: admin.corporate I'I'ree: DOCTEST2

If you do not want to enable archiving, or if you want to run the Archive Agent on the same server
with the Messaging Agent, one Messenger Server object is sufficient. If you want to enable
archiving and run the Archive Agent on a different server, you should remove the initial Archive
Agent object and then rerun the Messenger Installation program to create a second Messenger
Server object that contains just an Archive Agent object. For instructions, see Chapter 4, “Enabling
and Managing Archiving,” on page 131.

1.2.3 Scope Profiles

During creation of your Messenger system, you provided a list of eDirectory contexts that contain
User objects that you want to include in your Messenger system, as described in “Installing a Novell
Messenger System” in the Messenger 2.0 Installation Guide.

Figure 1-6 User Configuration Page in the Messenger Installation Program

Setup
User Configuration
Select the context(s] that Novell Messenger should uze to N
authenticate and search for users

Llge the Add button below to add a contest to the list. To remove a contest highlight it and
press the remove button.

OU=dey,0U=prv.0=novel Add |
Remove |

™ Include sub contexts. If more granular control is needed, use ConsoleOne to
modify the scope profile object created by the install
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This list of contexts was stored in the Default Scope Profile object in eDirectory.
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Figure 1-7 Scope Container Object and Contents
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You can add users to your Messenger system at any time by adding their eDirectory contexts to the
Default Scope Profile object, as described in “Editing the Default Scope Profile to Include
Additional eDirectory Users” on page 79.

If you want to subdivide your Messenger users into groups based on their e-mail addresses, you can
create multiple scope profiles, as described in Section 3.3, “Providing User Searches Based on E-
Mail Addresses,” on page 92.

1.2.4 LDAP Profiles

During creation of your Messenger system, you chose between direct access and LDAP access to
eDirectory, as described in “Installing a Novell Messenger System” in the Messenger 2.0
Installation Guide.

Figure 1-8 Directory Access Page in the Messenger Installation Program

Directory Access
The Movell Meszenger agents can access eDirectory directly or N
through an LDAP server.
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& Use direct access
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This choice applies initially to how the Messenger agents access eDirectory to obtain their
configuration settings from their eDirectory objects. This access method information is stored in the
agent startup files. Without additional configuration, the eDirectory access method chosen during
installation also applies to how the Messaging Agent accesses eDirectory on behalf of Messenger
users when they log in to Messenger, search for contacts, establish conversations, and so on.

You might want the Messaging Agent to access eDirectory differently on behalf of Messenger users
than how the agents access eDirectory to obtain their configuration information. If so, you will
create an LDAP Profile object in the LDAP Container object.

Figure 1-9 LDAP Container Object and Contents
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An LDAP profile is used instead of a scope profile to provide a list of LDAP servers that the
Messenger agents can contact when they need eDirectory access. By creating an LDAP profile, you
have more LDAP-specific options available when you configure eDirectory access, as described in
“Providing LDAP Access to eDirectory for Messenger Users” on page 81.

1.2.5 Chat

The Messenger Chat container is used to store chat room objects. When a chat room is created, a
chat room object is created in the Chat Container. The chat room objects contain the information
about the chat room, including who owns the chat room, the name of the chat room, access, and
other such information.
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Figure 1-10 Chat Container and Contents
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You can use the chat room objects to edit the chat rooms on the system. You can assign new owners,
rename the chat rooms, change access and other such settings. For more information on chat room
administration, see Chapter 5, “Managing Chat Rooms,” on page 173.

1.2.6 Hosts

Messenger Host objects (referred to as host profiles) are used to divide Messenger users into groups
based on the Internet domain portion of their Messenger addresses (which you configure to be
equivalent to their e-mail addresses). No host profiles are created by default in your Messenger

system.

Figure 1-11 Host Container and Contents
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You can organize your Messenger system at any time by using hostnames and Messenger addresses,
as described in Section 3.3, “Providing User Searches Based on E-Mail Addresses,” on page 92.
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1.2.7 Policies

During creation of your Messenger system, a Default Policy object is created that establishes some
basic Messenger user policies.

Figure 1-12 Policy Container and Contents
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User policies for controlling specific functionality of the Messenger client, creating a default contact
list, setting default privacy, establishing default contact list information, and creating default custom
statuses can be established at any time, as described in Section 3.4, “Setting User Policies,” on

page 97.

1.2.8 User Properties

During creation of your Messenger system, all User objects that are located within the scope of your
Messenger system have a Novell Messenger tab added to their object properties.

Figure 1-13 User Object Properties for a Messenger User
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The properties on each User object enable you to override user policies for each user as needed, as
described in Section 3.4, “Setting User Policies,” on page 97.

1.3 Language Availability

You can run the Messenger Installation program, administer your Messenger system in ConsoleOne,
and run the Messenger agents in the following languages:

+ English

+ French

¢ German

¢ Spanish

+ Portuguese
All available administration languages are automatically installed.

By default, the Messenger Installation program, ConsoleOne, and the Messenger agents start in the
language of the operating system, if it is available. If the operating system language is not available
for Messenger, the next default language is English. In the Installation program, you can select from
among the available languages to override the English default. When starting the Messenger agents,
you can use the /language startup switch to override the English default on Windows servers.

You can run the Messenger client in the following languages:

¢ Arabic

¢ Czech

¢ Chinese - Simplified
¢ Chinese - Traditional
¢ Danish

¢ Dutch

+ English

¢ Finnish

+ French

¢ German

¢ Hebrew

¢ Hungarian

+ Italian

+ Japanese

+ Korean

¢ Norwegian

¢ Polish

+ Portuguese

+ Russian
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¢ Spanish
+ Swedish

Users can select the languages they want when they install the Messenger client.

By default, the Messenger client starts in the language of the operating system, if it is available. If
the operating system language is not available, the next default language is English. In the
Messenger client, you can click Tools > Options, then select an interface language from those that
have been installed. When starting the Messenger client, you can use the /1 startup switch to override
the English default and select an interface language from those that have been installed.
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Managing the Messaging Agent

The Messaging Agent is the heart of your Messenger system. To review its various roles, see
“Messaging Agent” on page 14. The following sections help you manage and monitor the
Messaging Agent in your Messenger system:

¢ Section 2.1, “Starting the Messaging Agent,” on page 25

¢ Section 2.2, “Configuring the Messaging Agent in ConsoleOne,” on page 31

¢ Section 2.3, “Establishing Messaging Security with SSL Encryption,” on page 33

¢ Section 2.4, “Changing the Agent User Password,” on page 35

¢ Section 2.5, “Monitoring the Messaging Agent,” on page 36

+ Section 2.6, “Optimizing Messaging Agent Performance,” on page 52

¢ Section 2.7, “Managing the Messaging Server,” on page 54

¢ Section 2.8, “Using Messaging Agent Startup Switches,” on page 57

2.1 Starting the Messaging Agent

When you finish creating your Messenger system, the Installation program can start the Messenger
agents for you. If you installed the Messenger agents on a Windows server, the Messaging Agent
console appears on the Windows server console, as follows:

Figure 2-1 Messaging Agent Console
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If you installed the Messenger agents on a NetWare™ server, the Messaging Agent console appears
on the NetWare server console.

If you installed the Messenger agents on a Linux server, the Messaging Agent, by default, runs as a
daemon and has no comparable user interface. However, you can, if desired, start it in a terminal
window so that status messages are displayed, as described in “Starting the Linux Messaging Agent
in a Terminal Window” on page 27, and you can monitor the Messaging Agent from your Web
browser, as described in “Using the Messaging Agent Web Console” on page 38.
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The following sections help you start the Messaging Agent manually, as well as automatically
whenever the server restarts:

¢ Section 2.1.1, “Starting the NetWare Messaging Agent,” on page 26
¢ Section 2.1.2, “Starting the Linux Messaging Agent,” on page 26
¢ Section 2.1.3, “Starting the Windows Messaging Agent,” on page 28

¢ Section 2.1.4, “Changing the eDirectory Access Method for Starting the Messaging Agent,” on
page 29

2.1.1 Starting the NetWare Messaging Agent

The Installation program creates the nmstart .ncf file in the Messenger agent installation
directory (sys: \novell\run by default). This file contains lines similar to the following
example:

load sys:\novell\nm\ma\nmma.nlm @sys:\novell\nm\ma\strtup.ma
load sys:\novell\nm\aa\nmaa.nlm @sys:\novell\nm\aa\strtup.aa

If you do not plan to enable archiving, edit the nmstart .ncf file and comment out the second line
so that the Archive Agent does not start when the nmstart.ncf file is run.

To start the Messaging Agent manually:

1 Enter sys:\novell\nm\nmstart.ncf at the NetWare server console prompt.

The Messaging Agent console appears.
To start the Messaging Agent automatically when the NetWare server restarts:
1 Add the following line to the autoexec.ncf file in the sys: \system directory:
sys:\novell\nm\nmstart.ncf

If you want to start the Messaging Agent in protected mode, you must be using LDAP access to
Novell® eDirectory™. See “Using LDAP Access for the Messaging Agent” on page 30. In addition,
when you stop the Messaging Agent agent in protected mode, you must manually unload the address
space.

2.1.2 Starting the Linux Messaging Agent

You have several alternatives for starting the Messaging Agent on Linux:

¢ “Starting the Linux Messaging Agent as a Daemon” on page 26
¢ “Starting the Linux Messaging Agent in a Terminal Window” on page 27

¢ “Configuring the Linux Messaging Agent to Start Automatically As a Startup Service” on
page 27

Starting the Linux Messaging Agent as a Daemon

To start the Messaging Agent as a daemon, use the startup script provided in the /etc/init.d
directory.

1 At the Linux server, become root by entering su and the root password.
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2 Change to the /etc/init.d directory.
3 To start the Messaging Agent, enter the following command:
./novell-nmma start

You can also use the stop, restart, and status options for the Messaging Agent from the same
directory.

Messaging Agent log files are created in the /var/opt/novell/log/messenger
directory. The Messaging Agent can be monitored using the agent Web consoles from your
Web browser, as described in “Using the Messaging Agent Web Console” on page 38.

Starting the Linux Messaging Agent in a Terminal Window
To start the Messaging Agent in a terminal window, run the Messaging Agent executable.

1 At the Linux server, become root by entering su and the root password.
2 Change to the /opt/novell/messenger/bin directory.
3 To start the Messaging Agent, enter the following command:

./nmma @/etc/opt/novell/messenger/strtup.ma

Agent status information and messages are displayed in the terminal window.

To stop the Messaging Agent when it is running in a terminal window, press Ctrl+C and the
Messaging Agent performs a normal shutdown.

Configuring the Linux Messaging Agent to Start Automatically As a Startup Service
A startup service starts automatically each time the server reboots.

¢ “Configuring the Messaging Agent as a Startup Service on SUSE Linux” on page 27

+ “Configuring the Messaging Agent as a Startup Service on Red Hat Linux” on page 27
Configuring the Messaging Agent as a Startup Service on SUSE Linux

1 At the Linux server, become root by entering su and the root password.
2 If eDirectory for Linux is installed, enter the following command:
insserv novell-nmma

or

If eDirectory for Linux is not installed, use the following command to override the dependency
on the ndsd service:

insserv —-f novell-nmma

If you later want to remove the Messaging Agent as a startup service, enter the following command
in a terminal window:

insserv -r novell-nmma

Configuring the Messaging Agent as a Startup Service on Red Hat Linux

1 At the Linux server, become root by entering su and the root password.

2 Enter the following command:
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chkconfig --add novell-nmma

If you later want to remove the Messaging Agent as a startup service, enter the following command
in a terminal window:

chkconfig --del novell-nmma

2.1.3 Starting the Windows Messaging Agent

Follow the instructions for the Windows installation option you chose:

+ “Starting the Messaging Agent As a Windows Application” on page 28
+ “Starting the Messaging Agent As a Windows Service” on page 28

Starting the Messaging Agent As a Windows Application
To start the Messaging Agent manually:

1 Click Start > Programs > Novell Messenger Agents > Messaging Agent.

You might want to create a desktop shortcut for this action.
To start the Messaging Agent automatically whenever the server restarts:

1 Click Start > Settings > Taskbar & Start Menu > Advanced > Add.

2 Browse to the directory where you installed the Messaging Agent (\novell\nm\ma).

3 Double-click nmma . exe, then add the startup file (strtup.ma) to the command line.
Example: nmma.exe @strtup.ma

4 Click Next.

5 Select the Startup folder, provide a name for the shortcut, then click Finish.

Starting the Messaging Agent As a Windows Service
To start the Messaging Agent manually:

1 Click Start > Settings > Control Panel.
2 Double-click Administrative Tools > Services.

3 Right-click the Novell Messenger Messaging Agent service, then click Start.
To start the Messaging Agent automatically whenever the server restarts:

Click Start > Settings > Control Panel.

Double-click Administrative Tools > Services.

Right-click the Novell Messenger Messaging Agent service, then click Properties.
Set Startup Type to Automatic.

A B WON =

Click OK to save the Windows service startup setting.

If you do not want to run the Archive Agent along with the Messaging Agent, make sure that
the Novell Messenger Archive Agent service is disabled.
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To start the Messaging Agent without a user interface on the Windows server desktop:

Click Start > Settings > Control Panel.
Double-click Administrative Tools > Services.

Right-click the Novell Messenger Messaging Agent service, then click Properties.

A WODN =

Click Log On, then deselect Allow Service to Interact with Desktop.

If you suppress the Messaging Agent console in this manner, the Messaging Agent can still be
monitored from the Messaging Agent Web console, as described in “Using the Messaging
Agent Web Console” on page 38.

5 Click OK to save the Windows service logon setting.

2.1.4 Changing the eDirectory Access Method for Starting the
Messaging Agent

The Messaging Agent cannot start if it cannot read its configuration settings from the Messaging
Agent object in eDirectory. During installation, an eDirectory access method was selected, as
described in “Installing a Novell Messenger System” in the Messenger 2.0 Installation Guide.

Figure 2-2 Directory Access Page in the Messenger Installation Program

Directory Access
The Movell Messenger agents can access eDirectory directly or N

through an LDAP server.

Specify how the agents should access the directony,

% Use direct access

Replica Address: I
[E.0. M st M ]

" Use LDAP to access the directary

Haost: I
[IE00, H e, H ]

Fart:
389 o7 B3E [SEL] I388

Fioot Certificate:
[e.g. =publichrooteert.der] I Brawse... |
IztallShield

Installation Guide | < Back | Mext > I Cancel |

The information for that eDirectory access method was stored in the Messaging Agent startup file as
settings for the following startup switches:

Table 2-1 Startup Switches

Access Method Startup Switch Description

Use Direct Access /dirreplicaipaddr ~ Specifies the IP address of the server where the eDirectory
replica resides (for direct access on a Linux or Windows
server; not applicable on a NetWare server).

Use LDAP to /Idapipaddr Specifies the IP address of the LDAP server.
Access the
Directory
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Access Method Startup Switch Description

/Idapport Specifies the port number on which the LDAP server listens for
service requests. Port 636 indicates an SSL connection; port
389 indicates a non-SSL connection.

/Idapssl Indicates whether or not the LDAP server uses an SSL
connection, depending on whether or not you filled in the Root
Cetrtificate field.

/Idapsslkey Specifies the full path to the root certificate for the server if SSL
is in use.

To change the directory access method selected during installation, follow the appropriate set of
instructions:

¢ “Using LDAP Access for the Messaging Agent” on page 30

¢ “Using Direct Access for the Messaging Agent” on page 30

Using LDAP Access for the Messaging Agent

1 Edit the Messaging Agent startup file (strtup.ma).
On Linux, the startup file is located in /etc/opt/novell/messenger.

On NetWare and Windows, the startup file is located in the Messenger Agent installation
directory. You can edit the startup file from the Messaging Agent console. See “Controlling the
Messaging Agent from the Messaging Agent Console” on page 38.

2 On Linux and Windows, comment out the /dirreplicaaddr switch.

On a NetWare server, this switch does not apply, because the eDirectory replica resides on the
NetWare server.

3 Scroll down to the bottom of the startup file.

4 Remove the comment character (;) from the /ldap* switches and provide the required LDAP
information, as listed in Table 2-1.

5 Save the startup file.
6 Stop and then start the Messaging Agent so that it reads its updated startup file and uses LDAP
access to eDirectory.

If you have already created an LDAP profile to configure eDirectory access for Messenger users, as
described in “Providing LDAP Access to eDirectory for Messenger Users” on page 81, the LDAP
profile continues to be used for users, while the startup switches now control how the Messaging
Agent accesses eDirectory to obtain its configuration information.

Using Direct Access for the Messaging Agent

1 Edit the Messaging Agent startup file (strtup.ma).
On Linux, the startup file is located in /etc/opt/novell/messenger.

On Windows and NetWare, the startup file is located in the Messenger Agent installation
directory. You can edit the startup file from the Messaging Agent console. See “Controlling the
Messaging Agent from the Messaging Agent Console” on page 38.
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2 Remove the comment character (;) from the /dirreplicaaddr switch and provide the IP address
of the eDirectory replica that you want the Messaging Agent to access.

On a NetWare server, this switch does not apply, because the eDirectory replica resides on the
NetWare server.

3 Scroll down to the bottom of the startup file.
4 Comment out the /Idap* switches.

Removing the LDAP information causes the Messaging Agent to access the eDirectory replica
directly.

5 If you want users to continue to use LDAP access, create an LDAP profile for them, as
described in “Providing LDAP Access to eDirectory for Messenger Users” on page 81

6 Save the startup file.

7 Stop and then start the Messaging Agent so that it reads its updated startup file and uses direct
access to eDirectory.

2.2 Configuring the Messaging Agent in
ConsoleOne

The advantage to configuring the Messaging Agent in ConsoleOne®, as opposed to using startup

switches in the Messaging Agent startup file, is that the Messaging Agent configuration settings are
stored in eDirectory.

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Select the Messenger Server object where the Messaging Agent runs.

Novell ConsoleOne
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LAD) My iorld =
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3 Right-click the Messaging Agent object, then click Properties.

Table 2-2 summarizes the Messaging Agent configuration settings in the Messaging Agent object
property pages and how they correspond to Messaging Agent startup switches (as described in
Section 2.8, “Using Messaging Agent Startup Switches,” on page 57):
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Table 2-2 Messaging Agent Configuration Settings in the Messaging Agent Object Property Pages

ConsoleOne Properties
Pages and Settings

Corresponding Tasks and Startup Switches

Identification Page

IP Address

DNS Host Name
Bind to This Address
Client/Server Port
Description

General Page

Enable Messenger Services

Enable SNMP

Work Path

Security Page

Certificate Path

SSL Certificate

SSL Key File

Set Password

Enable SSL for Client/Server
Enable SSL for Message Transfer
Protocol

Log Settings Page

Log Level

Enable Disk Logging
Log Files Path

Log Maximum Age
Log Maximum Size

Web Console Page

HTTP Port

HTTP Username

HTTP Password

Enable SSL for Web Console

Performance Page

Maximum Number of Users
Client/Server Threads

Default Number of Connections
Idle TiImeout

Maximum Number of Connections
Maximum Query Results

Messaging page

Displays the Messaging Agent server information established
during installation.

Turns on and turns off the availability of instant messaging for all
Messenger users.

See “Using SNMP Monitoring Programs” on page 48,
See also /nosnmp.

See “Moving the Messaging Agent Working Directory” on
page 56.

See Section 2.3, “Establishing Messaging Security with SSL
Encryption,” on page 33.
See also /certpath, /certfile, /keyfile, /keypassword, and /ssl.

See “Using Messaging Agent Log Files” on page 45.
See also /loglevel, /log, /logdays, /logmax, and /logdiskoff.

See “Setting Up the Messaging Agent Web Console” on page 38.
See also /httpport, /httpuser, /httppassword, and /httpssl.

See Section 2.6, “Optimizing Messaging Agent Performance,” on
page 52.
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ConsoleOne Properties

Pages and Settings Corresponding Tasks and Startup Switches

Messaging Queue Path See “Moving the Messaging Agent Conversation Holding Queue”
on page 153.

Enable Client Download through a See “Using the Novell Messenger Download Page” on page 111.
Browser

After you install the Messaging Agent software, you can further configure the Messaging Agent by
using a startup file. See Section 2.8, “Using Messaging Agent Startup Switches,” on page 57 to
survey additional ways the Messaging Agent can be configured.

2.3 Establishing Messaging Security with SSL
Encryption

Secure Sockets Layer (SSL) ensures secure communication between programs by encrypting the
complete communication flow between the programs. The Installation program offered the
opportunity to configure the Messaging Agent for SSL encryption, as described in “Installing a
Novell Messenger System” in the Messenger 2.0 Installation Guide.

Figure 2-3 Security Configuration Page in the Messenger Installation Program
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If you set up SSL encryption during installation, the Installation program copied the certificate file
and key file you specified to the \novell\nm\certs directory to ensure availability for the
Messenger agents.

If you did not set up SSL encryption during installation, you can easily do so after installation. If you
have not already set up SSL encryption on your system, you must complete the following tasks:
¢ Section 2.3.1, “Generating a Certificate Signing Request and Private Key,” on page 34

¢ Section 2.3.2, “Submitting the Certificate Signing Request to a Certificate Authority,” on
page 34
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+ Section 2.3.3, “Installing the Certificate on the Server,” on page 34
¢ Section 2.3.4, “Configuring the Messaging Agent for SSL,” on page 34

2.3.1 Generating a Certificate Sighing Request and Private Key

Before the Messaging Agent can use SSL encryption, you must send a Certificate Signing Request
(CSR) to a Certification Authority (CA) and receive a public certificate file in return. The CSR
includes the hostname of the server where the Messaging Agent runs. The Messaging Agent and the
Archive Agent can use the same certificate if they run on the same server. The CSR also includes
your choice of name and password for the private key file that must be used with each certificate.
This information is needed when configuring the Messaging Agent to use SSL encryption.

One way to create a CSR is to use the GroupWise GWCSRGEN utility. See “Generating a
Certificate Signing Request” in “Security Administration” in the GroupWise GroupWise §
Administration Guide for instructions. This utility takes the information you provide and creates a
. csr file to submit to a Certificate Authority. You might want to name the . csr file after the
server it goes with, for example, server name.csr.

2.3.2 Submitting the Certificate Signing Request to a
Certificate Authority

To receive a server certificate, you need to submit the Certificate Signing Request

(server name.csr file) to a Certificate Authority. If you have not previously used a Certificate
Authority, you can use the keywords “Certificate Authority” to search the Web for Certificate
Authority companies. The Certificate Authority must be able to provide the certificate in Base64/
PEM or PFX format.

IMPORTANT: You cannot use an eDirectory root certificate (rootcert . der file) as a public
certificate.

The process of submitting the CSR varies from company to company. Most provide online
submission of the request. Follow their instructions for submitting the request.

The Novell Certificate Server™, which runs on a NetWare server with Novell eDirectory, enables
you to establish your own Certificate Authority and issue server certificates for yourself. For more
information, see the Novell Certificate Server site (http://www.novell.com/products/certserver).

2.3.3 Installing the Certificate on the Server

After processing your CSR, the Certificate Authority returns to you a certificate
(server name.crt) file and a private key (server name. key) file. Copy the files to the
certs subdirectory of the Messenger agent installation directory.

2.3.4 Configuring the Messaging Agent for SSL

After you have a public certificate and a private key file available on the server where the Messaging
Agent runs, you are ready to configure the Messaging Agent to use SSL encryption.

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Right-click the Messenger Server object, then click Properties.
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3 Click Server > Security.

Properties of prv-doctest2Server @
Server ~ || NDS Rights = | Cther | Rights to Files and Folders |
Securty
Certificate Path: |iptinavelimessengericarts =)
Securty
SSL Certificate: [servercertpem O
SSL Ky Fll: [serverkey pem 0
Set Password
I Enable 551
Page Options Cancel Help

4 Fill in the following fields:

Certificate Path: This field defaults to \novell\nm\certs for NetWare and Windows,
and /opt/novell/messenger/certs for Linux.

IMPORTANT: The certificate path must be located on the same server where the Messenger
agents are installed. If your SSL certificate and key file are located on a different server, you
must copy them into the directory specified in the Certificate Path field so that they are always
accessible to the Messenger agents.

SSL Certificate: Browse to and select the public certificate file. Or, if it is located in the
directory specified in the Certificate Path field, you can simply type the filename.

SSL Key File: Browse to and select your private key file. Or, if it is located in the directory
specified in the Certificate Path field, you can simply type the filename.

Set Password: Provide the key file password you established when you submitted the
certificate signing request.

Enable SSL: Select this option to enable SSL encryption for your Messenger system.

Because you provided the SSL information on the Messenger Server object, it applies to both
the Messaging Agent and the Archive Agent if both agents are running on the same server. The
same information can be provided on the Security page of each Messenger agent if necessary.

5 Click OK to save the SSL settings.
6 Stop and then start the Messaging Agent to start using SSL encryption.
Corresponding Startup Switches: You can also use the /certpath, /certfile, /keyfile, /keypassword,

and /ssl startup switches in the Messaging Agent startup file to configure the Messaging Agent to
use SSL encryption.

2.4 Changing the Agent User Password

When the Messaging Agent and Archive Agent are installed, the user’s eDirectory password that is
used to read the configuration that starts the agents is stored in the startup file for each agent. Prior to
Messenger 2.0.2 Hot Patch 1, this password was stored in plain text. By default in Messenger 2.0.2
Hot Patch 1, the password is obfuscated to prevent it from being read.
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If you want to check whether the password has been obfuscated, look in the startup files. The
password is prepended with $$: if it has been obfuscated.

The GWMPassword utility is used to change the password in the startup file for both the Messaging
Agent and the Archive Agent.

¢ Section 2.4.1, “Changing the Agent User Password On NetWare or Windows,” on page 36
¢ Section 2.4.2, “Changing the Agent User Password on Linux,” on page 36

2.4.1 Changing the Agent User Password On NetWare or
Windows

Before using the utility, you must verify the following prerequisite:
¢ A drive must be mapped to the location of the startup file.
To change the password:

1 In Windows, click Start > Run, then enter cmd to open a command window.
2 Use the following command to change the password:

c:\gwm202\server\utility\gwmpwd\gwmpwd.exe --startup=<path to
startup file> --password=<new password>

Replace c¢:\gwm202 with the location where the hot patch files were extracted.

2.4.2 Changing the Agent User Password on Linux

Before using the utility, you must verify the following prerequisites:

¢ Make suer you have installed Messenger 2.0.2 Hot Patch 1.

¢ A drive must be mapped to the location of the startup file.

1 After installing Messenger 2.0.2 Hot Patch 1, change to the /opt/novell/messenger/
bin/ directory.

2 Become root by entering sux and the root password.

3 Use the following command to change the password:

./gwmpwd --startup=<path to startup file> --password=<new
password>

2.5 Monitoring the Messaging Agent

By monitoring the Messaging Agent, you can determine whether or not its current configuration is
meeting the needs of your Messenger users. You have a variety of tools to help you monitor the
operation of the Messaging Agent:

*

Section 2.5.1, “Using the Messaging Agent Console on NetWare and Windows,” on page 37

*

Section 2.5.2, “Using the Messaging Agent Web Console,” on page 38

*

Section 2.5.3, “Using Messaging Agent Log Files,” on page 45

*

Section 2.5.4, “Using GroupWise Monitor,” on page 47
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¢ Section 2.5.5, “Using Novell 6.5 Remote Manager,” on page 47
¢ Section 2.5.6, “Using SNMP Monitoring Programs,” on page 48

2.5.1 Using the Messaging Agent Console on NetWare and
Windows

The following topics help you use the Messaging Agent console on NetWare and Windows:

+ “Monitoring the Messaging Agent from the Messaging Agent Console” on page 37
¢ “Controlling the Messaging Agent from the Messaging Agent Console” on page 38

NOTE: The Messaging Agent console is not available on Linux. Use the Web console instead, as
described in “Using the Messaging Agent Web Console” on page 38.

Monitoring the Messaging Agent from the Messaging Agent Console

The Messaging Agent console provides information, status, and message statistics about the
Messaging Agent to help you assess its current functioning.

Figure 2-4 Messaging Agent Console

T Novell Messenger Messaging Agent @ EI E| E|

File Configuration Log Help

Meszagingigent SERVER . MeszengerService Wind - Up Time: 0 Dayz 0OHrz 3 Minz

Statuz Statistics

Processing | Requests: 0 Erraors: 1]
Llzers: 0 | | Requests Pending: ]
Archive Queue: 1]

14:50:56 EBS CFG Log Path: o \MNovel\W ik matlogs ~
14:50:56 EB3 CFG Log to disk: Yes

14:50:56 EBS CFG Log Level: Mormal

14:50:56 EE3 CFG Log Max Age [in days): 14

14:50:56 EBS CFG Log Max Size (in MB]: 128

14:50:56 EBS CFG wWeb Conzole: Dizabled

14:50:56 EES Building the client extractor...

14:51:01 EBS Client extractor succeszsfully buil...

14:51:01 EBS ARC Archive queue initialization. ..

14:51:01 EE3 MTP Meszage Transfer Pratocol intialization. ..

14:51:01 EBS SPL Client/Server initializatior...

14:51:02 E74 TCP Starting MMMA-TCP-LISTENER

14:51:02 FBE TCP Starting MMMA-TCP-DISPATCHER b’

The Messaging Agent console includes several areas of information:

Table 2-3 Messaging Agent Console Information

Information Description

Information Box Identifies the Messaging Agent, displays description information provided in
ConsoleOne, and shows how long the Messaging Agent has been running.

Status Box Displays the number of current Messenger client users and the number of
conversations that are queued for archiving. The rotating processing bar shows
that the Messaging Agent is running.

Managing the Messaging Agent

37



Information Description

Statistics Box Displays the number of requests that the Messaging Agent has received from

Messenger clients or from the Archive Agent, along with the number of requests
that it has been unable to respond to. Pending requests might indicate a need to

optimize Messaging Agent performance to better serve Messenger users.

Log Message Box Displays the same information that is being written to the Messaging Agent log

file. The amount of information displayed depends on the current log settings for
the Messaging Agent. See “Using Messaging Agent Log Files” on page 45. The
information scrolls up automatically.

Controlling the Messaging Agent from the Messaging Agent Console

You can perform the following tasks to monitor and control the Messaging Agent from the
Messaging Agent console at the server where the Messaging Agent is running:

Table 2-4 Performing Messaging Agent Tasks

Task NetWare

Windows

Stop the Messaging Agent F7

Edit the startup file F10 > Edit Startup File
Display current agent N/A
settings

Display the current log file F9
Display a selected log file F10 > View Log Files

Change log settings for the  F10 > Logging Options
current agent session

Start a new log file F10 > Cycle Log
Display online help F1

File > Exit
Configuration > Edit Startup File

Configuration > Agent Settings

Log > Auto Scroll Off > scroll as needed
Log > View Log
Log > Log Settings

Log > Cycle Log
Help > Help

2.5.2 Using the Messaging Agent Web Console

The Messaging Agent Web console enables you to monitor and control the Messaging Agent from
any location where you have access to a Web browser and the Internet. This provides substantially
more flexible access than the Messaging Agent console, which can only be accessed from the server

where the Messaging Agent is running.

+ “Setting Up the Messaging Agent Web Console” on page 38

+ “Accessing the Messaging Agent Web Console from Your Web Browser” on page 39

+ “Monitoring the Messaging Agent at the Web Console” on page 40

+ “Accessing the Messaging Agent Web Console from GroupWise Monitor” on page 45

Setting Up the Messaging Agent Web Console

1 In ConsoleOne, browse to and expand the MessengerService object.
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2 Select the Messenger Server object to display its contents.
3 Right-click the Messaging Agent object, then click Properties.
4 Click Agent > Web Console.

Properties of MessagingAgent @|

Agent - | NDSRights v | Other | Rights to Files and Folders |
Weh Conzole

HTTF Fort 5314 j‘

HTTP Authertication

Usermane T

Password: Set Password

[ Enable SSL for Wb Console

Page Options Cancel Help

5 Fill in the following fields:

HTTP Port: Specify the port number for the Messaging Agent to listen on for service requests
from your Web browser; for example, 8313.

Username: If you want to restrict access to the Messaging Agent Web console, specify a user
name for the Messaging Agent to prompt for before allowing access to the Web console.

Password: Specify the password for the Messaging Agent to prompt for before allowing
access to the Web console.

Enable SSL for Web Console: Select this option if you want the Messaging Agent to use SSL
encryption when communicating with your Web browser.

In order to use SSL encryption for the Web console, you must properly configure the
Messaging Agent, as described in Section 2.3, “Establishing Messaging Security with SSL
Encryption,” on page 33.

6 Click OK to save the Web console settings.
7 Stop and then start the Messaging Agent to put the HTTP settings into effect.

Corresponding Startup Switches: You can also use the /httpport, /httpuser, /httppassword, and /
httpssl startup switches in the Messaging Agent startup file to enable and secure the Messaging
Agent Web console.

Accessing the Messaging Agent Web Console from Your Web Browser
To monitor the Messaging Agent from your Web browser, view the following URL:
http://Messenger_server:agent port

where Messenger server represents the IP address or hostname of the server where the Messaging
Agent is running and agent_port represents the port number you specified in Step 5 in “Setting Up
the Messaging Agent Web Console” on page 38. For example:

http://172.16.5.18:8313
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Figure 2-5 Messaging Agent Web Console Status Page
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Monitoring the Messaging Agent at the Web Console

The Messaging Agent Web console provides several pages of information to help you monitor the
performance of the Messaging Agent. The bar at the top of the Messaging Agent Web console
displays the name of the agent. Below this bar appears the Web console menu that lists the pages of
information available in the Messaging Agent Web console.

+ “Monitoring Messaging Agent Status” on page 41

¢ “Checking Monitor Agent Configuration” on page 42
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¢ “Checking the Messaging Agent Operating System Environment” on page 42
* “Viewing and Searching Messaging Agent Log Files” on page 43

Monitoring Messaging Agent Status

When you first access the Messaging Agent Web console, the Status page is displayed.

Figure 2-6 Messaging Agent Web Console Status Page
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The Web console provides more detailed status information than the Messaging Agent console.
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Click Current Users to display a list of current Messenger users and their IP addresses. Click the
User ID, then click Disconnect User to disconnect the user.

Click C/S Handler Threads to display the Messaging Agent client/server threads, the number of
requests each thread has handled, and each thread's current activity.

Click Chat Rooms to display a list of current chat rooms and their CN name, owner, and number of
active participants. Click Re-initialize Chat List to re-initialize the chat room process. By re-
initializing the chat room process, chat rooms that are added in ConsoleOne are added to the list of
chat rooms. Users can also use ConsoleOne to access the chat rooms after they have been added.

Checking Monitor Agent Configuration

On the Messaging Agent Web console menu, click Configuration to display Messaging Agent
configuration information.

Figure 2-7 Messaging Agent Web Console Configuration Page
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Ohject DH: messaginzagent pri-doctestservermessengetservice cotporate
Patent DH: pre-doctest2Zerver MessengerService corporate
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Checking the Messaging Agent Operating System Environment

On the Messaging Agent Web console menu, click Environment to display information about the
operating system where the Messaging Agent is running. On a NetWare server, the following
information is displayed:
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Figure 2-8 Messaging Agent Web Console Environment Page for NetWare
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On a Linux server, the following information is displayed:

Figure 2-9 Messaging Agent Web Console Environment Page for Linux
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On a Windows server, the following information is displayed:

Figure 2-10 Messaging Agent Web Console Environment Page for Windows

03 Data
Windows NT (TM) “ersion 4.0 {Build 1381} Senice Pack b

Viewing and Searching Messaging Agent Log Files

On the Messaging Agent Web console menu, click Log Files to display and search Messaging Agent

log files.
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Figure 2-11 Messaging Agent Web Console Log Files Page
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To view a particular log file, select the log file, then click View Events.

To search all log files for a particular string, type the string in the Events Containing field, select
Select All, then click View Events. You can also manually select multiple log files to search. The
results of the search are displayed on a separate page, which can be printed.

To start a new log file, click Cycle Log.

To view your log settings for the current Messaging Agent session, click Event Log Settings to
display the Configuration page. To change your log settings for the current Message Agent session,
click Event Log on the Configuration page.
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Figure 2-12 Message Agent Web Console Event Log Settings Page
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Accessing the Messaging Agent Web Console from GroupWise Monitor

If you use GroupWise® Monitor to monitor your GroupWise agents, you can add the Messaging
Agent to the list of monitored agents. Continue with “Using GroupWise Monitor” on page 47.

2.5.3 Using Messaging Agent Log Files

Error messages and other information about Messaging Agent functioning are written to log files as
well as displaying on the Messaging Agent console. Log files can provide a wealth of information
for resolving problems with Messaging Agent functioning.

1 In ConsoleOne, browse to and expand the MessengerService object.

2 Select the Messenger Server object.

3 Right-click the Messaging Agent, then click Properties.

4 Click Agent > Log Settings.
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Properties of MessagingAgent El

Agent  ~ | NDSRights v | Other | Rights to Files and Folders |
Log Settings

LogLevel yormal

Disk Logaing

¥ Ensble disk logging
Log Files Pt [fvariaptinaveliogimessengerina =l
Log Maxium Age (daysy [ 14 =]

Lo Maximur Size (ME): 128 -5

Page Options... Cancel Help

5 Fill in the following fields:

Log Level: Controls the amount of information logged by the Messaging Agent. Logged
information is displayed in the log message box and written to the Messaging Agent log file
during the current agent session. The default is Normal, which displays only the essential
information suitable for a smoothly running Messaging Agent. Use Verbose to display the
essential information, plus additional information helpful for troubleshooting. Use Diagnostic
where very detailed, code-specific information is required.

Enable disk logging: Select this option so that the information displayed in the message log
box at the Messaging Agent console is also saved to disk in log files.

Log Files Path: Specify the directory where the Messaging Agent stores its log files. On
NetWare and Windows, the default location is the 1ogs subdirectory of the Messaging Agent
installation directory. On Linux, the default location is /var/opt/novell/log/
messenger/ma.

Typically you find multiple log files in the specified directory. The first four characters
represent the date. The next three identify the agent. A three-digit extension allows for multiple
log files created on the same day. For example, a log file named 051 8nma . 001 indicates that
it is a Messaging Agent log file, created on May 18. If you restarted the Messaging Agent on
the same day, a new log file started, named 0518nma.002.

Log Maximum Age: Specify how many days to keep Messaging Agent log files on disk. The
default is 14 days.

Log Maximum Size: Specify the maximum amount of disk space for all Messaging Agent log
files. When the specified disk space is consumed, the Messaging Agent deletes existing log
files, starting with the oldest. The default is 128 MB.

6 Click OK to save the log file settings.
7 Stop and then start the Messaging Agent to put the new log settings into effect.

Corresponding Startup Switches: You can also use the /log, /loglevel, /logdays, and /logmax
startup switches in the Messaging Agent startup file to configure Messaging Agent log files.
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2.5.4 Using GroupWise Monitor

GroupWise Monitor can be configured to monitor the Messaging Agent as well as the GroupWise
Agents (Post Office Agent, Message Transfer Agent, Internet Agent, and WebAccess Agent). For
background information about GroupWise Monitor, see “Monitor” in the GroupWise Group Wise §
Administration Guide.

1 Enable the Messaging Agent Web console, as described in “Setting Up the Messaging Agent
Web Console” on page 38

2 At the Windows Monitor Agent console, click Configuration > Add Novell Messenger System.

Add Novell Messenger System El

MNovell Meszenger Spstem Object | Browse, | oK
Specify a usemame and password to access the directory Cancel
User Mame ‘ Browse: Help

Password ‘

Specify haw ta access the directony

Use direct access

Replica Address:
(2. Ry, K. 1R, K]

3 Fill in the following fields:
Novell Messenger System Object: Browse to and select the MessengerService object.

User Name: Browse to and select a User object that has sufficient rights to enable the Monitor
Agent to access Messenger agent object properties in eDirectory.

Password: Specify the eDirectory password associated with the selected User object.
4 Provide the same eDirectory access information as you provided during installation:
Use Direct Access: Select this option if the Messaging Agent uses direct access to eDirectory.

+ Replica Address: If the Messaging Agent is installed on a Windows server, provide the
IP address of a server where the Messaging Agent can access a replica of eDirectory. If the
Messaging Agent is installed on a NetWare server, you do not need to specify this
information because there is an eDirectory replica on the NetWare server

5 Click OK to save the information about your Messenger system.

The Messaging Agent appears in the root agent group, along with the Archive Agent if it is
running on the same server. You might want to create an agent group specifically for the
Messenger agents. See “Creating and Managing Agent Groups” in “Monitor” in the
GroupWise GroupWise 8 Administration Guide.

2.5.5 Using Novell 6.5 Remote Manager

If the Messaging Agent is running on a NetWare 6.5 server, you can use the IP Address Management
feature in Novell Remote Manager (NetWare Remote Manager > Manage Server > IP Address
Management) to view the IP address and port configuration for the Messaging Agent. This is also
true for the Archive Agent running on a NetWare 6.5 server.

You access Novell Remote Manager by entering the following URL in a Web browser:

http://server address:8008
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For example:

http://192.168.0.0:8008

For more information about using Novell Remote Manager, see the NetWare 6.5 documentation
(http://www.novell.com/documentation/nw65).

2.5.6 Using SNMP Monitoring Programs

You can monitor the Messaging Agent from the Management and Monitoring component of Novell
ZENworks® for Servers, ManageWise®, or any other SNMP management and monitoring program.
When properly configured, the Messaging Agent sends SNMP traps to network management
consoles for display along with other SNMP monitored programs. It also responds to requests for
configuration and status information from SNMP management and monitoring programs.

Although the Messaging Agent is SNMP-enabled by default, the server where the Messaging Agent
is installed must be properly configured to support SNMP, and the Messaging Agent object in
eDirectory must be properly configured as well. To set up SNMP services for your Messenger
server, complete the following tasks:

+ “Setting Up SNMP Services for the Messaging Agent” on page 48

¢ “Copying and Compiling the Messaging Agent MIB File” on page 51

¢ “Customizing Your ManageWise Installation to Monitor the Messaging Agent” on page 51

¢ “Configuring the Messaging Agent for SNMP Monitoring” on page 52

Setting Up SNMP Services for the Messaging Agent
Select the instructions for the platform where the Messaging Agent runs:

+ “Setting Up SNMP Services on a NetWare Server” on page 48
¢ “Setting Up SNMP Services on a Linux Server” on page 49
+ “Setting Up SNMP Services on a Windows Server” on page 50

Setting Up SNMP Services on a NetWare Server

The Messaging Agent supports SNMP through the SNMP services loaded on the NetWare server.
SNMP services are provided through the SNMP NLM™. The SNMP NLM initiates and responds to
requests for monitoring information and generates trap messages.

If the SNMP NLM is not loaded before the Messaging Agent, Messaging Agent still loads and
functions normally, but SNMP support is disabled. The Messaging Agent does not attempt to auto-
load snmp .nlm.
1 Go to the console of the NetWare server where you want to implement SNMP services.
The server should already have the Messenger agents installed.
2 Enter the command to load the SNMP NLM:
Syntax: 1load snmp v control=x monitor=y trap=z

where v represents Verbose, meaning to display informational messages, and x, y and z are
replaced with your system SNMP community strings for SNMP SETs, GETs and TRAPs.

Example: 1oad snmp v control=private monitor=public trap=all
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The TCP/IP NLM automatically loads snmp . n1m, using default values for the community
strings. If your system uses different community string values, load snmp . n1m before
tcpip.nlm.

If the SNMP NLM is already loaded, you can add the control and trap parameters by entering
the following at the console prompt:

snmp control= trap=
3 To automatically load these commands, include them in the autoexec.ncf file.
For more information about implementing SNMP services, see your NetWare documentation.

4 Skip to “Copying and Compiling the Messaging Agent MIB File” on page 51.

Setting Up SNMP Services on a Linux Server

The Linux Messaging Agent is compatible with NET-SNMP. An older version of SNMP called
UCD-SNMP cannot be used with the Linux Messaging Agent. NET-SNMP comes standard with the
versions of Red Hat* Linux supported for Messenger 1.0 for Linux, but it does not come standard
with the supported versions of SUSE® Linux. If you are using SUSE Linux, you must update to
NET-SNMP in order to use SNMP to monitor the Linux Messaging Agent.

1 Make sure you are logged in as root.

2 If NET-SNMP is not already set up on your Linux server, use the following command to
configure SNMP:

snmpconf -g basic_ setup

The snmpconf command creates the snmpd . conft file in one of the following directories,
depending on your version of Linux:

/usr/share/snmp
/usr/local/share/snmp
~/ .snmp

3 Locate the snmpd. conf file on your Linux server.
4 In a text editor, modify the snmpd. conf file:
4a Add the following line:
dlmod Gwmweb /opt/novell/messenger/lib/libnmsnmp.so.1l
4b Save and exit the snmpd. conf file.
5 Restart the SNMP daemon (snmpd) to put the changes into effect.

6 In a text editor, modify the nmsnmp . conf file in the /etc/opt/novell /messenger
directory:

6a Set/daemonPort to a unique port number for the Messaging Agent to listen on; for
example, 8305.

6b If you have not already configured the Messaging Agent Web console, as described in
“Setting Up the Messaging Agent Web Console” on page 38, assign an HTTP port for the
Messaging Agent.

You can set the HTTP port in ConsoleOne, using the same steps as for setting up the Web
console, or you can set /maPort to a unique port number, such as 8301. If you want to use
SNMP with the Archive Agent, you can also provide an HTTP port for it by using /aaPort
if you update the nmsnmp . conf file, rather than providing the settings in ConsoleOne.

6¢ Save and exit the nmsnmp . conf file.
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7 In ConsoleOne, enable SNMP:
7a Browse to and right-click the Messenger Server object, then click Properties.
7b Click Server > General.
7c Select Enable SNMP.
7d Click OK to save the setting.
8 Restart the Messaging Agent.
9 Skip to “Copying and Compiling the Messaging Agent MIB File” on page 51.

Setting Up SNMP Services on a Windows Server

The SNMP service is usually not included during the initial Windows operating system installation.
The SNMP service can be easily added at any time. To add or configure the SNMP service, you
must be logged in as a member of the Administrator group.

To add the SNMP service to a Windows 2000 server:

1 From the Control Panel, double-click Add/Remove Programs.
2 Click Add/Remove Windows Components.
3 Select Management and Monitoring Tools.
4 Click Details, then select Simple Network Management Protocol.
For more information about configuring the SNMP service, see your Windows 2000

documentation.

The Messenger Installation program includes an option for installing SNMP support. However, if
the Windows server where you installed the Messaging Agent did not yet have SNMP set up, that
installation option was not available. Now that you have set up SNMP, you can install Messaging
Agent SNMP support.

Rerun the Messenger Installation program, using the Install Server option as described in the
Messenger 2.0 Installation Guide, noticing that the Install and Configure SNMP for the Messenger
Agents option is now available and selected.

Figure 2-13 Server Information Dialog Box With the SNMP Option Selected

Server Information
Select the installation path and the type of server an which pou will N

run the Novell Messenger Agents.

Server: " Nefware
& Microsoft Windows 5 erver
[V Install agents as ‘Windows services

[V Install and configure SHMP for the Messenger Agents

Installation path:

| \Navelhhb
Browsze... |

Irztall5hield

Installation Guide | < Back | Mext > I Cancel |
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When you have finished installing the Messenger Agent, continue with “Copying and Compiling the
Messaging Agent MIB File” on page 51.

Copying and Compiling the Messaging Agent MIB File

An SNMP-enabled Messaging Agent returns information contained in a Management Information
Base (MIB). The MIB is an ASCII data structure that defines the information gathered. It also
defines the properties that can be monitored and managed on the SNMP-enabled Messaging Agent.

Before you can monitor an SNMP-enabled Messaging Agent, you must compile the nmma . mib file
by using your SNMP management program. On NetWare and Windows, the Messenger agent MIBs
are located downloaded GroupWise Messenger 2 image in the \ server\ snmp directory. On
Linux, the Messenger MIBs are located in the /etc/opt/novell/messenger/mibs
directory after installation.

1 Copy the nmma . mib file to the location required by your SNMP management program.

For example, ManageWise users would copy the nmma . mib file to the
\mw\nms\snmpmibs\current directory. ZENworks for Servers users can access the
nmma . mib file in the downloaded GroupWise Messenger 2 image.

2 Compile or import the nmma . mib file as required by your SNMP management program.
For example, to compile the nmma . mib file for ZENworks for Servers:
2a In ConsoleOne, right-click the Site Server object, then click Properties > MIB Pool.
2b Click Modify Pool > Add.
2c Browse to and select the nmma . mib file, then click OK.
2d Click Compile.

2e Make sure that the server where the Messaging Agent is running is configured to send
SNMP traps to the ZfS Site Server.

+ On a NetWare server, add the IP address or hostname of the ZfS Site Server to the
traptarg.cfg file in the sys: \etc directory.

+ On a Windows server, add the IP address or hostname of the ZfS Site Server to the
list of trap destinations. From the Windows 2000 Control Panel, double-click
Administrative Tools, then click Services > SNMP Service > Properties > Traps.

Refer to your SNMP management program documentation for specific instructions.

3 Ifyou are using ManageWise, continue with “Customizing Your ManageWise Installation to
Monitor the Messaging Agent” on page 51.

or

If you are not using ManageWise, skip to““Configuring the Messaging Agent for SNMP
Monitoring” on page 52.

Customizing Your ManageWise Installation to Monitor the Messaging Agent

The downloaded GroupWise Messenger 2 image includes a file that helps ManageWise monitor the
Messenger agents more effectively. These capabilities are available only with ManageWise, not with
ZENworks for Servers.

The nmma . mib file includes the standard SNMP management information. In addition, the file
includes annotations that enhance the Alert functions of ManageWise.
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For example, the Summary provides more detailed information than the Description does in other
SNMP management programs. The ManageWise annotations are embedded in comments; therefore,
they have no affect on other SNMP management programs

When Messaging Agent alarms appear in ManageWise, you can double-click the alarm to display
the alarm information contained in the Messenger Alarm help file. To enable this feature, copy the
nmalarm.hlp file from the \ server\ snmp directory in the downloaded GroupWise Messenger
2 image to the \mw\nms\help directory on your ManageWise station. This help file explains the
alarms the Messaging Agent might produce by giving a description, cause, and action for each
alarm.

Configuring the Messaging Agent for SNMP Monitoring

In order for SNMP monitoring programs to monitor the Messaging Agent, the Messaging Agent
must be configured with an SNMP community string.

1 In ConsoleOne, browse to and expand the MessengerService object.
2 Right-click the Messenger Server object, then click Properties.

3 Click Server > General.

Properties of prv-doctest2Server @

Server ~ | NDS Rights + | Cther | Rights to Files and Falders |
Genersl |
[¥ Enable Messenger Services
I~ Enable Shup
SHMP Commun ity: |
Path Settings |
Software Path [romtinovelimessengerisoftware i8]
ark Path: [marioptinovelimessengeraemp £
Page Options... Cancel Help

Make sure that Enable SNMP is selected.

In the SNMP Community field, provide your system SNMP community GET string.
Click OK to save the SNMP settings.

Stop and then start the Messaging Agent to put the SNMP settings into effect.

N OO g b

2.6 Optimizing Messaging Agent Performance

You can adjust how the Messaging Agent functions to optimize its performance. Before attempting
optimization, you should run the Messaging Agent long enough to observe its efficiency and its
impact on other network applications running on the same server. See Section 2.5, “Monitoring the
Messaging Agent,” on page 36.
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Also, remember that optimizing your network hardware and operating system can make a difference
in Messaging Agent performance.

1 In ConsoleOne, browse to and expand the MessengerService object.

2 Select the Messenger Server object.

3 Right-click the Messaging Agent object, then click Properties.

4 Click Agent > Performance.

Praperties of MessagingAgent EI
Agent "~ | NDS Rights = | Other | Rights to Files and Folders |
Performance
Maximum number of users, 5120 ::‘
CliertiServer threads, 15 -3

Directory Setiings

Detaul ruker of connections: [ 10 -]
Il tinsout (seconds: =
Wi ramber of conrections. [ 50 %]
Maximum aquery resuts: [ w3

Page Options ‘ Cancel | | Help |

5 Fill in the following fields to configure how the Messaging Agent communicates with
Messenger users:

Maximum number of users: Specify the maximum number of Messenger users that you want
the Messaging Agent to be able to service at once. The default is 5120, which should be
adequate for a very large Messenger system.

Client/Server threads: Specify the number of client/server threads that you want the
Messaging Agent to start. The Messaging Agent uses its client/server threads to service
Messenger clients, to download Messenger client software to users, and to communicate with
the Archive Agent if archiving is enabled. Up to half of the client/server threads can be used for
downloading the Messenger client software if demand requires it.

The default number of client/server threads is 15. For a large Messenger system, you could
increase the number to 50 or more, depending on the system resources of the server where the
Messaging Agent is running.

6 Fill in the following fields to configure how the Messaging Agent communicates with
eDirectory when using direct access:

Default number of connections: Specify the minimum number of direct access connections
you want open between the Messaging Agent and eDirectory. The direct access connections
between the Messaging Agent and eDirectory are used to authenticate Messenger users when
they start the Messenger client, to perform searches for Messenger users when users build their
contact lists, to save user option settings for the Messenger client, and for other directory-based
operations. By default, the number of connections is 10.

Do not set the default number of connections to be greater than the number of client/server
threads. This results in open connections that could never be serviced by the Messaging Agent.
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Idle direct access connections occupy memory, but using an existing connection is faster than
creating a new connection. The default number of connections is always kept open, even if
some are idle.

Idle timeout: If more than the default number of direct access connections are open between
the Messaging Agent and eDirectory, and if any connection is idle for the specified amount of
time, the idle connection is closed. By default, this time is 30 seconds.

Maximum number of connections: Specify the maximum number of eDirectory connections
that the Messaging Agent can create. The default is 50 connections.

Do not set the maximum number of connections to be greater than the number of client/server
threads. This results in open connections that could never be serviced by the Messaging Agent.

Maximum query results: Specify the maximum number of contacts you want the Messaging
Agent to return when Messenger users search for other Messenger users when adding contacts
to their contact lists.

7 Click OK to save the Messaging Agent performance settings.
8 Stop and then start the Messaging Agent to put the new performance settings into effect.
Corresponding Startup Switches: You can also use the /maxconns, /threads, /

dirdefaultconnections, /diridletimeout, /dirmaxconnections, and /dirquerymaxresults startup
switches in the Messaging Agent startup file to configure Messaging Agent performance.

2.7 Managing the Messaging Server

As your Messenger system grows and evolves, you might need to reconfigure the server where the
Messaging Agent runs or move Messaging Agent directories to different locations.

¢ Section 2.7.1, “Binding the Messaging Agent to a Specific [P Address,” on page 54

¢ Section 2.7.2, “Changing the Messaging Server's Network Address,” on page 55

¢ Section 2.7.3, “Moving the Messaging Agent Working Directory,” on page 56

2.7.1 Binding the Messaging Agent to a Specific IP Address

On a server with multiple IP addresses, the Messaging Agent binds to all available IP addresses, and
Messenger clients can communicate with the Messaging Agent on all available IP addresses unless
you bind them to a specific address.

1 Stop the Messaging Agent on the server.

2 In ConsoleOne, browse to and expand the MessengerService object.

3 Right-click the Messaging Agent object, then click Properties.

4 Click Agent > Identification
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Properties of prv-doctest2Server @|

Serwer v | NDS Rights v | Other | Rights tn Files and Folders |
Idertification

Host Address
& 1P Address: .

" DMS Hostname: ‘

I Bindto this address

Description:

Page Options... Cancel Help

5 Select IP Address, then specify the IP address, in dotted decimal format, that you want to bind
the Messaging Agent to.

or

Select DNS Host Name, then provide the DNS host name you want to bind the Messaging
Agent to.

6 (Optional) Select Bind to this address.
7 Click OK to save the new address information.

8 Start the Messaging Agent.

2.7.2 Changing the Messaging Server's Network Address

If you change the IP address or DNS hostname of the server where the Messaging Agent is running,
you must also update the server information for your Messenger system.
1 Stop the Messaging Agent on the server.

2 Reconfigure the server, following the appropriate procedure for the operating system
(NetWare, Linux, or Windows).

3 In ConsoleOne, browse to and expand the MessengerService object.
4 Right-click the Messaging Agent object, then click Properties.
5 Click Agent > Identification.
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Properties of prv-doctest2Server El

Serwer v | NDS Rights v | Other | Rights tn Files and Folders |
Idertification

Host Address
& 1P Address: .

" DMS Hostname:

I Bindto this address

Description:

Page Options... Cancel Help

6 Select IP Address, then specify the server's new IP address.

or

Select DNS Host Name, then provide the server's new DNS hostname.
7 Click OK to save the new network address information.

8 Start the Messaging Agent.

2.7.3 Moving the Messaging Agent Working Directory

The Messaging Agent uses its working directory for saving various temporary files during message
processing.

1 Stop the Messaging Agent on the server.

2 Copy the Messaging Agent working directory to the desired location.

On NetWare and Windows, the Messenger working directory is \novell\nm\temp by
default. On Linux, the default is /opt/novell/messenger/temp.

3 In ConsoleOne, browse to and expand the MessengerService object.
4 Right-click a Messaging Agent object, then click Properties.

5 Click Server > General.
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Properties of prv-doctest2Server E|

Serwer + | NDS Rights + | Cther | Rights to Files and Folders |
General
[ Enable Messenger Services
I Enable Shp
SMMP Commmurity. [
Path Settings
Software Pati |ioptinavelimessengersattmare [}
ork Path: | marioptinovellmessengeremp £
Page Options... Cancel Help

6 In the Work Path field, change the path to the working directory to the current location.

7 Click OK to save the new working directory location.

8 Start the Messaging Agent.

9 Delete the previous working directory to conserve disk space.
By default, the Messaging Agent and the Archive Agent use the same working directory if they are
running on the same server, as specified on the General tab of the Messenger Server object. If you
want the Messaging Agent to use a separate working directory, you can specify the working

directory on each agent object (Agent tab > General page > Work Path field). The location specified
for the Messaging Agent object overrides the location specified for the Messenger Server object.

2.8 Using Messaging Agent Startup Switches

You can override settings provided in ConsoleOne by using startup switches in the Messaging Agent
startup file (strtup.ma). On NetWare and Windows, the startup file is located in the Messenger
Agent installation directory. On Linux, the startup file is located in /etc/opt/novell/
messenger . You can override startup switches provided in the startup file by using startup
switches on the command line. For more information about starting the Messaging Agent, see
Section 2.1, “Starting the Messaging Agent,” on page 25.

This section contains information on the following startup switches:

¢ Section 2.8.1, “/certfile,” on page 60

¢ Section 2.8.2, “/certpath,” on page 61

¢ Section 2.8.3, “/cluster (NetWare only),” on page 61

¢ Section 2.8.4, “/dirdefaultconnections,” on page 61

¢ Section 2.8.5, “/diridletimeout,” on page 62

+ Section 2.8.6, “/dirmaxconnections,” on page 62

¢ Section 2.8.7, “/dirpoolresettime,” on page 62

¢ Section 2.8.8, “/dirquerymaxresults,” on page 63

¢ Section 2.8.9, “/dirreplicaipaddr (Linux and Windows only),” on page 63

¢ Section 2.8.10, “/diruseralias,” on page 63
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¢ Section 2.8.11, “/diruserauthbind,” on page 63
¢ Section 2.8.12, “/diruserforcedirect,” on page 64
¢ Section 2.8.13, “/home,” on page 64

¢ Section 2.8.14, “/httppassword,” on page 64

¢ Section 2.8.15, “/httpport,” on page 65

¢ Section 2.8.16, “/httpssl,” on page 65

¢ Section 2.8.17, “/httpuser,” on page 65

+ Section 2.8.18, “/ip,” on page 65

¢ Section 2.8.19, “/keepalive,” on page 66

¢ Section 2.8.20, “/keyfile,” on page 66

¢ Section 2.8.21, “/keypassword,” on page 66

¢ Section 2.8.22, “/language (Windows only),” on page 67
¢ Section 2.8.23, “/ldapipaddr,” on page 67

¢ Section 2.8.24, “/Idapport,” on page 68

¢ Section 2.8.25, “/Idappwd,” on page 68

¢ Section 2.8.26, “/Idapssl,” on page 68

¢ Section 2.8.27, “/Idapsslkey,” on page 68

¢ Section 2.8.28, “/ldapuser,” on page 69

¢ Section 2.8.29, “/log,” on page 69

¢ Section 2.8.30, “/logdays,” on page 70

¢ Section 2.8.31, “/logdiskoff,” on page 70

¢ Section 2.8.32, “/loglevel,” on page 70

¢ Section 2.8.33, “/logmax,” on page 70

¢ Section 2.8.34, “/maxconns,” on page 71

¢ Section 2.8.35, “/mtpconnecttimeout,” on page 71
¢ Section 2.8.36, “/mtpdatatimeout,” on page 71
¢ Section 2.8.37, “/mtpipaddr,” on page 72

¢ Section 2.8.38, “/mtpport,” on page 72

¢ Section 2.8.39, “/mtpssl,” on page 72

¢ Section 2.8.40, “/nomtp,” on page 72

¢ Section 2.8.41, “/nosnmp,” on page 73

+ Section 2.8.42, “/password,” on page 73

¢ Section 2.8.43, “/port,” on page 73

¢ Section 2.8.44, “/queue,” on page 73

¢ Section 2.8.45, “/ssl,” on page 74

¢ Section 2.8.46, “/threads,” on page 74

¢ Section 2.8.47, “/user,” on page 74
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The following table summarizes the Messaging Agent startup switches and how they correspond to

configuration settings in ConsoleOne.

Table 2-5 Messaging Agent Startup Switches

NetWare Messaging
Agent

Linux Messaging
Agent

Windows Messaging
Agent

ConsoleOne Setting

[cerftfile
/certpath

[cluster

/dirdefaultconnections

/diridletimeout

/dirmaxconnections

/dirpoolresettime
/dirquerymaxresults
N/A

[diruseralias
/diruserauthbind
[diruserforcedirect
/home
/httppassword
/httpport

/httpuser

/httpssl

lip

/keepalive
/keyfile
/keypassword
N/A
/Idapipaddr
/Idapport
/ldappwd
/ldapssl

--certfile
--certpath
N/A

dirdefaultconnections
--diridletimeout

--dirmaxconnections

--dirpoolresettime
--dirquerymaxresults
--dirreplicaipaddr
--diruseralias
--diruserauthbind
--diruserforcedirect
--home
--httppassword
--httpport

--httpuser

--httpssl

--ip

--keepalive
--keyfile
--keypassword
N/A
--ldapipaddr
--ldapport
--ldappwd

--ldapssl

[certfile
/certpath
N/A

/dirdefaultconnections

/diridletimeout

/dirmaxconnections

/dirpoolresettime
/dirquerymaxresults
/dirreplicaipaddr
[diruseralias
/diruserauthbind
/diruserforcedirect
/home
/httppassword
/httpport

/httpuser

/httpssl

lip

/keepalive
/keyfile
/keypassword
/language
/Idapipaddr
/ldapport
/ldappwd
/ldapssl

SSL Certificate
Certificate Path
N/A

Default Number of Connections
(LDAP profile)

Idle Timeout (LDAP profile)

Maximum Number of
Connections (LDAP profile)

N/A

Maximum Query Results
N/A

N/A

N/A

N/A

N/A

HTTP Password

HTTP Port

HTTP Username

Enable SSL for Web Console

Host IP Address with Bind to this
Address selected

N/A

SSL Key File

SSL Set Password

N/A

LDAP Connection IP Address
LDAP Connection Port

LDAP Profile Set Password
LDAP Connection SSL Enabled
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NetWare Messaging

Linux Messaging

Windows Messaging

ConsoleOne Setting

Agent Agent Agent

/ldapsslkey --ldapsslkey /ldapsslkey LDAP Connection Root
Certificate

/ldapuser --ldapuser /ldapuser LDAP Profile Username

/log --log /log Log Files Path

/logdays --logdays /logdays Log Maximum Age

/logdiskoff --logdiskoff /logdiskoff Enable Disk Logging

/loglevel --loglevel /loglevel Log Level

/logmax --logmax /logmax Log Maximum Size

/maxconns --maxconns /maxconns Maximum Number of Users

/mtpconnecttimeout  --mtpconnecttimeout /mtpconnecttimeout N/A

/mtpdatatimeout --mtpdatatimeout /mtpdatatimeout N/A

/mtpipaddr --mtpipaddr /mtpipaddr Host Address (Archive Agent)

/mtpport --mtpport /mtpport Message Transfer Port (Archive
Agent)

/mtpssl --mtpssl /mtpssl Enable SSL for Message
Transfer Protocol (Archive Agent)

/nomtp --nomtp /nomtp N/A

/nosnmp --nosnmp /nosnmp Enable SNMP

/password --password /password Set Password

/port --port /port Client/Server Port

/queue --queue /queue Messaging Queue Path

/ssl --ssl /ssl Enable SSL for Client/Server

/threads --threads /threads Client/Server Threads

user --user user Username

2.8.1 /certfile

Specifies the full path to the public certificate files used to provide secure SSL communication
between the Messaging Agent and other programs. See Section 2.3, “Establishing Messaging
Security with SSL Encryption,” on page 33.

Linux Messaging

NetWare Messaging Agent Agent

Windows Messaging Agent

Syntax: [cerffile-[svA][vol:\dinfile --certfile=/dir/file

[certfile-\svAvodinfile

[certfile-[drive:]\dinfile
[certfile-\\svAsharename\din\file
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Linux Messaging

NetWare Messaging Agent Windows Messaging Agent

Agent
Example: /certfile-\novell\nm\ma\certs\nm.crt --certfile=/certs/  /cerffile-
[cerftfile- gw.crt \novell\nm\ma\certs\nm.crt
svr2\sys:\novell\nm\ma\certs\nm.crt [certfile-
[certfile- m:\novell\nm\ma\certs\nm.crt
\\svr2\sys\novell\nm\ma\certs\nm.crt [cerffile-

\\s2\c\novell\nm\mal\certs\nm.crt

See also /certpath, /keyfile, and /keypassword.

2.8.2 /certpath

Specifies the full path to the directory where public certificate file are stored on your system. See
Section 2.3, “Establishing Messaging Security with SSL Encryption,” on page 33.

Linux Messaging

NetWare Messaging Agent Windows Messaging Agent

Agent
Syntax: /certpath-[svA][vol:]\dir/certpath- --certpath=/dir [certpath-[drive:]\dir
\\svAvoAdir [certpath-\\svAsharename\dir
Example: /certpath-\novell\nm\ma\certs --certpath=/certs /certpath-\novell\nm\ma\certs
[certpath- [certpath-m:\novell\nm\ma\certs
svr2\sys:\novel\nm\ma\certs [certpath-
[certpath- \\svr2\c\novel\nm\ma\certs

\\svr2\sys\novell\nm\ma\certs

See also /certfile, /keyfile, and /keypassword.

2.8.3 /cluster (NetWare only)

Informs the Messaging Agent that it is running in a clustering environment. See “Implementing
Messenger in a NetWare Cluster” in “Novell Cluster Services on NetWare” in the Group Wise 8
Interoperability Guide.

If you are running the Messaging Agent on the latest version of NetWare 6.x and Novell Cluster
Services™, the Messaging Agent can detect the cluster automatically.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /cluster N/A N/A

See also /ip.

2.8.4 /dirdefaultconnections

Specifies the minimum number of direct access connections you want open at all times between the
Messaging Agent and eDirectory. The default is 10 connections. See Section 2.6, “Optimizing
Messaging Agent Performance,” on page 52.
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NetWare Messaging Agent  Linux Messaging Agent Windows Messaging Agent

Syntax: /dirdefaultconnections- --dirdefaultconnections= /dirdefaultconnections-number
number number

Example: /dirdefaultconnections-20  --dirdefaultconnections=30 /dirdefaultconnections-50

See also /diridletimeout and /dirmaxconnections.

2.8.5 /diridletimeout

Specifies the number of seconds after which idle direct access connections in excess of the default
number of connections are closed. The default is 30 seconds. See Section 2.6, “Optimizing
Messaging Agent Performance,” on page 52.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /diridletimeout-seconds --diridletimeout=seconds /diridletimeout-seconds
Example: /diridletimeout-20 --diridletimeout=60 /diridletimeout-90

See also /dirdefaultconnections.

2.8.6 /dirmaxconnections

Specifies the maximum number of direct access connections you want open between the Messaging
Agent and eDirectory. The default is 50 connections. See Section 2.6, “Optimizing Messaging
Agent Performance,” on page 52.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /dirmaxconnections-number  --dirmaxconnections=number /dirmaxconnections-number

Example: /dirmaxconnections-200 --dirmaxconnections=100 /dirmaxconnections-100

See also /dirdefaultconnections.

2.8.7 Idirpoolresettime

Specifies the number of minutes between the time when the Messaging Agent receives an error
response from a pooled LDAP server and the time when that LDAP server is reinstated into the pool
of available LDAP servers. The default is 5 minutes. See “Providing LDAP Access to eDirectory for
Messenger Users” on page 81.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /dirpoolresettime-minutes --dirpoolresettime=minutes  /dirpoolresettime-minutes
Example: /dirpoolresettime-10 --dirpoolresettime=10 /dirpoolresettime-10
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2.8.8 /dirquerymaxresults

Specifies the maximum number of query results you want the Messaging Agent to return when users
search for other users to add to their contact lists in the Messenger client. The default maximum is
100 contacts. See Section 2.6, “Optimizing Messaging Agent Performance,” on page 52.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax:  /dirquerymaxresults-contacts --dirquerymaxresults= /dirquerymaxresults-contacts
contacts
Example: /dirquerymaxresults-50 --dirquerymaxresults=200 /dirquerymaxresults-200

2.8.9 /dirreplicaipaddr (Linux and Windows only)

Specifies the IP address of an eDirectory replica for a Messaging Agent that is running on a
Windows server. See “Changing the eDirectory Access Method for Starting the Messaging Agent”
on page 29.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: N/A --dirreplicaipaddr=IP_address  /dirreplicaipaddr-/P_address
Example: N/A --dirreplicaipaddr=172.16.5.18  /dirreplicaipaddr-172.16.5.19

2.8.10 /diruseralias

Specifies the eDirectory attribute that the Messaging Agent searches on when users use the User ID
field to search for other Messenger users. By default, the Messaging Agent searches on the CN
attribute. See “Customizing Authentication and Searches by eDirectory Attribute” on page 91

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /diruseralias- --diruseralias= /diruseralias-
"eDirectory_attribute" "eDirectory_attribute" "eDirectory_attribute"
Example: /diruseralias-"Internet EMail  --diruseralias="Internet EMail /diruseralias-"Internet EMail
Address" Address" Address"

2.8.11 /diruserauthbind

Indicates that you want users to authenticate to eDirectory by using a bind rather than a compare
operation. See “Selecting Bind or Compare eDirectory Access for Users” on page 90.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /diruserauthbind --diruserauthbind /diruserauthbind
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2.8.12 /diruserforcedirect

Indicates that you want users to use direct access to eDirectory even though you have configured the
Messaging Agent to use LDAP access. See “Using LDAP Access for the Messaging Agent” on
page 30.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /diruserforcedirect --diruserforcedirect /diruserforcedirect

2.8.13 /home

Specifies the distinguished name (DN) of the Messaging Agent object where the Messaging Agent
configuration information is stored. There is no default location. You must use this switch in order to
start the Messaging Agent. See Section 2.1, “Starting the Messaging Agent,” on page 25.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /home-CN=agent_object, --home=CN=agent_object, /home-CN=agent_object,
OU=server_object, OU=server_object, OU=server_object,
OU=Messenger_system, OU=Messenger_system, OU=Messenger_system,
O=organization O=organization O=organization

Example: /home-CN=MessagingAgent, -

/home-CN=MessagingAgent,

OU=PRV-GWSERVER, home=CN=MessagingAgent, OU=PRV-GWSERVER,
OU=MessengerService, OU=PRV-GWSERVER, OU=MessengerService,
O=Novell OU=MessengerService, O=Novell

O=Novell

IMPORTANT: Use commas, rather than periods, between object names. If any object name
includes a space, surround the switch value with double quotation marks.

2.8.14 /nttppassword

Specifies the password for the Messaging Agent to prompt for before allowing Messaging Agent
status information to be displayed in your Web browser. Unless you are using SSL encryption, do
not use an existing eDirectory password because the information passes over the connection
between your Web browser and the Messaging Agent. See “Using the Messaging Agent Web
Console” on page 38.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /httppassword- --httppassword= /httppassword-
unique_password unique_password unique_password

Exampl /httppassword-AgentWatch --httppassword=AgentWatch  /httppassword-AgentWatch
e:

See also /httpuser.
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2.8.15 /httpport

Sets the HTTP port number used for the Messaging Agent to communicate with your Web browser.
The setting must be unique on the server where the Messaging Agent runs. See “Using the
Messaging Agent Web Console” on page 38.

NetWare Messaging Agent  Linux Messaging Agent Windows Messaging Agent
Syntax: /httpport-port_number --httpport=port_number /httpport-port_number
Example: /httpport-8314 --httpport=8315 /httpport-8316

2.8.16 /httpssl

Sets the availability of SSL encryption between the Messaging Agent and the Web console
displayed in your Web browser. Valid values are enable and disable. See “Using the Messaging
Agent Web Console” on page 38.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /httpssl-setting --httpssl=setting Inttpssl-setting
Example: /httpssl-enable --httpssl=enable /httpssl-enable

2.8.17 /httpuser

Specifies the username for the Messaging Agent to prompt for before allowing Messaging Agent
status information to be displayed in a Web browser. Providing a user name is optional. Unless you
are using SSL encryption, do not use an existing eDirectory username because the information
passes over the connection between your Web browser and the Messaging Agent. See “Using the
Messaging Agent Web Console” on page 38.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /httpuser-unique_username  --httpuser=unique_username /httpuser-unique_username
Example: /httpuser-NMWebConsole --httpuser=NMWebConsole  /httpuser-NMWebConsole

See also /httppassword.

2.8.18 lip

Binds the Messaging Agent to a specific IP address when the server where it runs uses multiple IP
addresses, such as in a clustering environment. Without the /ip switch, the Messaging Agent binds to
all available IP addresses and Messenger clients can communicate with the Messaging Agent on all
available IP addresses.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: lip-IP_address --ip=IP_address lip-IP_address
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NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Example: /ip-172.16.5.18 -ip=172.16.5.19 lip-172.16.5.20

See also /cluster.

2.8.19 /keepalive

Adjusts the default ping interval at which the Messenger clients notify the Messaging Agent that
they are still active. The default interval is every 10 minutes. This regular communication between
the Messaging Agent and the client prevents firewalls and routers from disconnecting connections
that seem to be inactive. You can decrease the interval if client users are being unexpectedly
disconnected. You can increase the interval to decrease network traffic. Use a setting of 0 (zero) to

turn off the ping activity.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /keepalive-minutes --keepalive=minutes /keepalive-minutes
Example: /keepalive-20 --keepalive=5 /keepalive-15

The ping interval can be adjusted for individual clients using the /keepalive startup switch with the
Messenger client.

2.8.20 /keyfile

Specifies the full path to the private file used to provide SSL encryption between the Messaging
Agent and other programs. See Section 2.3, “Establishing Messaging Security with SSL
Encryption,” on page 33.

Linux Messaging

NetWare Messaging Agent Windows Messaging Agent

Agent
Syntax:  /keyfile-[svA][vol:]\din\file --keyfile=/dir/file  /keyfile-[drive:|\dinfile
/keyfile-\\svAvoldinfile /keyfile-\\svAsharename\din\file
Example: /keyfile-\novell\nm\ma\certs\nm.key  ---keyfile=/certs/ /keyfile-\novell\nm\ma\certs\nm.key
/keyfile- gw.key /keyfile-
svr2\sys:\novell\nm\ma\certs\nm.key m:\novell\nm\mal\certs\nm.key
/keyfile- /keyfile-
\\svr2\sys\novell\nm\ma\certs\nm.ke \\svr2\c\novell\nm\ma\certs\nm.key

y

See also /keypassword.

2.8.21 /keypassword

Specifies the password used to encrypt the private SSL key file when it was created. See Section 2.3,
“Establishing Messaging Security with SSL Encryption,” on page 33.
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NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /keypassword-password --keypassword=password /keypassword-password
Example: /keypassword-gwssl --keypassword=gwssl| /keypassword-gwssl
See also /keyfile.

2.8.22 /language (Windows only)

Specifies the language to run the Messaging Agent in, using a two-letter language code as listed
below. When you install the Messenger agents, all language versions are automatically installed.

The initial default is the language used by the operating system. If that language is not available, the
Messaging Agent runs in English. You need to use this switch only if you need to override these
defaults.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: N/A N/A /language-code

Example: N/A N/A /language-fr

The table below lists the valid language codes:

Language Language Code
English EN
French FR
German DE
Portuguese PT
Spanish ES

2.8.23 /ldapipaddr

Specifies the LDAP server's network address as either an IP address or a DNS hostname. You can
specify multiple network addresses to provide failover capabilities for your LDAP servers. See
Section 3.2, “Customizing eDirectory Access for Users,” on page 80.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /Idapipaddr- -- /ldapipaddr-network_address
network_address Idapipaddr=network_address
Example: /Idapipaddr-172.16.5.18 --ldapipaddr=172.16.5.19 /Idapipaddr-172.16.5.20

/ldapipaddr-server1 server2  --Ildapipaddr server1 server2  /ldapipaddr-server1 server2
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If you specify multiple LDAP servers, use a space between each address. When so configured, the
Messaging Agent tries to contact the first LDAP server in order to access eDirectory. If that LDAP
server is down, the Messaging Agent tries the next LDAP server in the list, and so on until it is able
to access eDirectory.

See also /ldapport.

2.8.24 /ldapport

Specifies the port number that the LDAP server listens on for service requests. The default is 389.
See “Providing LDAP Access to eDirectory for Messenger Users” on page 81.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /ldapport-port_number --ldapport=port_number  /Idapport-port_number
Example: /ldapport-390 --ldapport=391 /Idapport-392
See also /ldapipaddr.

2.8.25 /Idappwd

Provides the password for the LDAP user that the Messaging Agent uses to log in to the LDAP
server. See “Providing LDAP Access to eDirectory for Messenger Users” on page 81.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /lIdappwd-LDAP_password  --ldappwd=LDAP_password /ldappwd-LDAP_password
Example: /Idappwd-nmidap --ldappwd=nmldap /ldappwd-nmlidap

See also /ldapuser.

2.8.26 /ldapssl

Indicates to the Messaging Agent that the LDAP server it is logging in to uses SSL encryption. See
Section 2.3, “Establishing Messaging Security with SSL Encryption,” on page 33.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /Idapssl --Idapssl /Idapssi
See also /ldapsslkey.

2.8.27 /ldapsslkey

Specifies the full path to the private SSL key file used with LDAP authentication. See “Providing
LDAP Access to eDirectory for Messenger Users” on page 81.
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NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax:  /Idapsslkey-[svA][vol:]\diAfile --ldapsslkey=/dir/file /\dapsslkey-[drive:]\diifile
/ldapsslkey-\\svAvoldin(file /ldapsslkey-
\\svAsharename\din\file

Example: /Idapsslkey- --ldapsslkey=/certs/ /lIdapsslkey-
\novell\nm\ma\certs\nmk gwkey.der novel\nm\ma\certs\\nmkey.d
ey.der er
/ldapsslkey- /ldapsslkey-
server2\sys:\novell\nm\ m:\novel\nm\mal\certs\nmkey
mal\certs\nmkey.der .der
/ldapsslkey- /ldapsslkey-
\\server2\sys\novell\nm\ \\server2\c\novell\nm\
ma\certs\nmkey.der ma\certs\nmke
y.der
See also /ldapssl.

2.8.28 /ldapuser

Specifies the username that the Messaging Agent can use to log in to the LDAP server to obtain
information from eDirectory. See “Providing LDAP Access to eDirectory for Messenger Users” on
page 81.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /ldapuser-LDAP_userID --ldapuser=LDAP_userID /ldapuser-LDAP_userlD
Example: /Idapuser-NMAuth --ldapuser=NMAuth /ldapuser-NMAuth
See also /Idappwd.

2.8.29 /log

Specifies the directory where the Messaging Agent will store its log files. The default location is the
\novell\nm\ma\log directory. See “Using Messaging Agent Log Files” on page 45.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: Nlog-[svA][vol:])\dir --log=/dir Nlog-[drive:]\dir
Nlog-\\svAvoldir /log-\\svAsharename\dir
Example: /log-\nmlog\ma --log=/nm/log/ma /log-\nmlog\ma
/log-\\server2\mail:\nmlog\ma /log-m:\nmlog\ma
Nlog-\\server2\mail\nmlog\ma Nlog-\\server2\c\mail\nmlog\ma

See also /loglevel, /logdays, /logmax, and /logdiskoff.
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2.8.30 /logdays

Specifies how many days to keep Messaging Agent log files on disk. The default is 14 days. See
“Using Messaging Agent Log Files” on page 45.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /logdays-days --logdays=days /logdays-days
Example: /logdays-7 --logdays=30 /logdays-90

See also /log, /loglevel, /logmax, and /logdiskoff.

2.8.31 /logdiskoff

Turns off disk logging for the Messaging Agent so no information about the functioning of the
Messaging Agent is stored on disk. The default is for logging to be turned on. See “Using Messaging
Agent Log Files” on page 45.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: Nlogdiskoff --logdiskoff /logdiskoff

See also /log, /loglevel, /logdays, and /logmax.

2.8.32 /loglevel

Controls the amount of information logged by the Messaging Agent. Logged information is
displayed in the log message box and written to the Messaging Agent log file during the current
agent session. The default is Normal, which displays only the essential information suitable for a
smoothly running Messaging Agent. Use Verbose to display the essential information, plus
additional information helpful for troubleshooting. Use Diagnostic to include very detailed, code-
specific information. See “Using Messaging Agent Log Files” on page 45.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: Nloglevel-level --loglevel=level /loglevel-level

Example: /loglevel-verbose --loglevel=diagnostic /loglevel-diagnostic

See also /log, /logdays, /logmax, and /logdiskoff.

2.8.33 /logmax

Sets the maximum amount of disk space for all Messaging Agent log files. When the specified disk
space is consumed, the Messaging Agent deletes existing log files, starting with the oldest. The
default is 128 MB. See “Using Messaging Agent Log Files” on page 45.
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NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /logmax-megabytes --logmax=megabytes /logmax-megabytes

Example: /logmax-64 --logmax=256 /logmax-256

See also /log, /loglevel, /logdays, and /logdiskoff

2.8.34 /maxconns

Specifies the maximum number of connections between the Messaging Agent and Messenger
clients. The default is 5120. See Section 2.6, “Optimizing Messaging Agent Performance,” on
page 52.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /maxconns-connections --maxconns=connections /maxconns-connections
Example: /maxconns-10000 --maxconns=10000 /maxconns-10000

See also /threads.

2.8.35 /mtpconnecttimeout

Specifies the number of seconds that the Messaging Agent waits for a response from the Archive
Agent before returning an error. The default is 5 seconds. See “Optimizing the Connection between
the Archive Agent and the Messaging Agent” on page 150.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /mtpconnecttimeout-seconds --mtpconnecttimeout= /mtpconnecttimeout-seconds
seconds
Example: /mtpconnecttimeout-30 --mtpconnecttimeout=60 /mtpconnecttimeout-60

See also /mtpdatatimeout.

2.8.36 /mtpdatatimeout

Specify in seconds the amount of time the Messaging Agent tries to send conversations to the
Archive agent before reporting an error. The default is 20 seconds. See “Optimizing the Connection
between the Archive Agent and the Messaging Agent” on page 150.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /mtpdatatimeout-seconds --mtpdatatimeout=seconds /mtpdatatimeout-seconds
Example: /mtpconnecttimeout-30 --mtpconnecttimeout=40 /mtpconnecttimeout-60

See also /mtpdatatimeout.
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2.8.37 /mtpipaddr

Specifies the network address of the Server where the Archive Agent runs, as either an IP address or
a DNS hostname. By default, the Messaging Agent uses the network address specified on the
Identification page of the Archive Agent object.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax:  /mtpipaddr-network_address  --mtpipaddr= /mtpipaddr-network_address
network_address
Example: /mtpipaddr-172.16.5.18 --mtpipaddr=172.16.5.19 /mtpipaddr-172.16.5.20
/mtpipaddr-server2 --mtpipaddr=server3 /mtpipaddr-server4

See also /mtpport.

2.8.38 /mtpport

Specifies the message transfer port number the Archive Agent listens on for conversations to
archive. By default, the Messaging Agent uses the message transfer port specified on the
Identification page of the Archive Agent object, which is 8312.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /mtpport-port_number --mtpport=port_number /mtpport-port_number
Example: /mtpport-8412 --mtpport=8413 /mtpport-8414
See also /mtpipaddr.

2.8.39 /mtpssl

Sets the availability of SSL encryption between the Archive Agent and the Messaging Agent. Valid
values are enable and disable. See Section 4.6, “Enhancing Archive Security with SSL Encryption,”
on page 142.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: Imtpssl-setting --mtpssl=setting Imtpssl-setting

Example: /mtpssl-enable --mtpssl=enable /mtpssl-enable

2.8.40 /nomtp

Disables the Messaging Agent's attempts to contact the Archive Agent. You might want to do this if
you do not plan to enable archiving.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /nomtp --nomtp /nomtp
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2.8.41 /nosnmp

Disables SNMP for the Messaging Agent. The default is to have SNMP enabled. See “Using SNMP
Monitoring Programs” on page 48.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Syntax: /nosnmp --nosnmp /nosnmp

2.8.42 /password

Provides the password for the Messaging Agent to use when accessing eDirectory in order to obtain
its configuration information from the Messaging Agent object. This switch is required in order to
start the Messaging Agent. See Section 2.1, “Starting the Messaging Agent,” on page 25. By default
after Messenger 2.0.2 Hot Patch 1 is installed, the password is obfuscated for security purposes. If
the password has been obfuscated, the password is prepended with $$: in the startup file. In order to
change the obfuscated password, you need to use the GWMPassword utility. For additional
information on how to use the GWMPassword utility, see Section 2.4, “Changing the Agent User
Password,” on page 35.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /password-eDir_password --password=eDir_password /password-eDir_password
Example: /password-NMAgent --password=NMAgent /password-NMAgent

See also /user.

2.8.43 /port

Sets the port number on which the Messaging Agent listens for service requests from Messenger
clients. The default is 8300. See Section 2.2, “Configuring the Messaging Agent in ConsoleOne,” on
page 31.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: Iport-port_number --port=port_number /port-port_number
Example: /port-8301 --port=8302 /port-8303

2.8.44 /queue

Specifies the directory where the Messaging Agent stores conversations to archive if it is unable to
communicate with the Archive Agent. The default is \novell\nm\ma\queue. See “Moving the
Messaging Agent Conversation Holding Queue” on page 153.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax:  /queue-[svA][vol:]\dir --queue=/dir /queue-[drive:]\dir
/queue-\\svAvoldir /queue-\\sviAsharename\din
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NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent

Example: /queue-\nmqueues\ma --queue=/nmqueues/ma  /queue-\nmqueues\ma
/queue- /queue-m:\nmqueues\ma
\\server2\mail:\nmqueues\ma /queue-

/queue- \\server2\c\mail\nmqueues\ma

\\server2\mail\nmqueues\ma

2.8.45 /ssl

Sets the availability of SSL encryption between the Messaging Agent, the Archive Agent, and
Messenger clients. Valid values are enable and disable. See Section 2.3, “Establishing Messaging
Security with SSL Encryption,” on page 33.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: [ssl-setting --ssl=setting /ssl-setting
Example: /ssl-enable --ssl=enable /ssl-enable

See also /certpath, /certfile, /keyfile, and /keypassword.

2.8.46 /threads

Specifies the maximum number of client/server threads the Messaging Agent can create. The default
is 15. See Section 2.6, “Optimizing Messaging Agent Performance,” on page 52.

NetWare Messaging Agent  Linux Messaging Agent Windows Messaging Agent
Syntax: lthreads-number --threads=number lthreads-number
Example: /threads-10 --threads=20 /threads-30

See also /maxconns.

2.8.47 |user

Provides the eDirectory username for the Messaging Agent to use when accessing eDirectory to
obtain its configuration information from the Messaging Agent object. This switch is required in
order to start the Messaging Agent. See Section 2.1, “Starting the Messaging Agent,” on page 25.

NetWare Messaging Agent Linux Messaging Agent Windows Messaging Agent
Syntax: /user-CN=User_object, --user=CN=User_object, /user-CN=User_object,

OU=org_unit,O=organization OU=org_unit,O=organization =~ OU=org_unit,O=organization
Example /user-CN=Messenger, --user=CN=Messenger, /user-CN=Messenger,

OU=Users,O=Novell OU=Users,O=Novell OU=Users,O=Novell

IMPORTANT: Use commas, rather than periods, between object names. If any object name
includes a space, surround the switch value with double quotation marks.
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Managing Messenger Client Users

Although users can begin to use the GroupWise® Messenger client immediately after you have set
up your Messenger system, as described in the Messenger 2.0 Installation Guide, you might want to
do some additional system setup, as described in the following sections:

¢ Section 3.1, “Adding Users to Your Messenger System,” on page 77

¢ Section 3.2, “Customizing eDirectory Access for Users,” on page 80

¢ Section 3.3, “Providing User Searches Based on E-Mail Addresses,” on page 92

¢ Section 3.4, “Setting User Policies,” on page 97

+ Section 3.5, “Distributing the Messenger Client Software,” on page 111

¢ Section 3.6, “Configuring the Messenger Client Software,” on page 120

¢ Section 3.7, “Excluding Users from Your Messenger System,” on page 129

These sections focus on the Messaging Agent, although some of the tasks apply to the Archive
Agent as well.

3.1 Adding Users to Your Messenger System

Users are considered to be part of your Messenger system if their User objects reside in a Novell®
eDirectory™ context listed in a scope profile. A default scope profile was established during
installation, as described in “Installing a Novell Messenger System” in the Messenger 2.0
Installation Guide.

Figure 3-1 User Configuration Page In the Messenger Installation Program

User Configuration
Select the context(z] that Novel Messenger should uze to N
authenticate and search for users

Lze the Add button below ta add a contest to the list. To remove a contest highlight it and
press the remave button.

ary, O =novell Add

Remaove |

™ Include sub contexts. If more granular contral is needed, uze ConzoleOne to
modify the scope profile object created by the install

Irtal Shield

Inztallation Guide |

Cancel

NOTE: GroupWise External Entity objects in the listed contexts are not considered part of your
Messenger system.
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You can add more users after installation.

¢ Section 3.1.1, “Adding New eDirectory Users,” on page 78

¢ Section 3.1.2, “Editing the Default Scope Profile to Include Additional eDirectory Users,” on
page 79

IMPORTANT: If users are addressed through various hostnames, you must create a different scope
profile for each hostname, as described in Section 3.3, “Providing User Searches Based on E-Mail
Addresses,” on page 92

3.1.1 Adding New eDirectory Users

Any time you add a new User object in eDirectory in a context listed in a Messenger scope profile,
that user is automatically part of your Messenger system.

To see what scope profiles have been defined for your Messenger system and to view the contents of
a scope profile:

1 In ConsoleOne®, browse to and expand the Messenger Service object.

2 Select the Scope Container object.

Novell ConsoleQne
File Edt Yiew Tools Help

e Em0c 1] 2ve slc s B e
L) hy World || ® DefaultscopeProiile
-8 NDS
4% DOCTEST?
=& corporate

BG4 MessengerService
ChatContainer
HostContainer
-t LDAPContainer

B pr-doctest2
€7 PRV-DOCTESTZW
[T = I SR S
1 | FI L 1 tems %
szer: adtnin.corporate ITree: DOCTEST2

Existing scope profiles are displayed in the right pane.
3 Right-click a scope profile, then click Properties.
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Praperties of DefaultScopeProfile

Scope Profile | NDS Rights ~ | Other | Rights to Files and Folders |
Gereral

Context List

O=corporate

o

A

Page Options...

Cancel

Help

The context list includes the contexts contained in the scope profile.

If you create new eDirectory users in any of the contexts listed in any of the scope profiles, no
additional configuration is necessary for them to be part of your Messenger system.

3.1.2 Editing the Default Scope Profile to Include Additional

eDirectory Users

There is no limit to the number of eDirectory contexts you can list in a scope profile. However, all
contexts in a scope profile must be in the same eDirectory tree where your Messenger system is

located.

To add users in the same eDirectory tree where your Messenger system is located:

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Select the ScopeContainer object.

3 Right-click the Default Scope Profile object, then click Properties.

Properties of DefaultScopeProfile

Scope Brofile || NDS Rights ~ | ther | Rights to Files and Folders |
General

Context List

O=corporats

et

A

3]

Page Options...

Cancel

Help

Initially, the context list includes those contexts selected during installation.
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4 Click Add.

Context List Entry

Contexd: | T

[ Include sub-contexts

oK | Cancel | Help |

5 Browse to and select an eDirectory context, then click OK.
6 If necessary, select Include sub-contexts in the Context List Entry dialog box.
7 Click OK to updated the context list with the new context.

8 Repeat Step 4 through Step 7 for each eDirectory context you want to add to the default scope
profile.

9 Click OK to save the updated default scope profile.

IMPORTANT: Be sure to avoid duplicating contexts in the context list, especially if you selected
the Include Sub-contexts option. If the same context appears multiple times in the context list,
Messenger users receive duplicate results when searching for contacts.

3.2 Customizing eDirectory Access for Users

During installation of your Messenger system and agents, you chose between direct access and
LDAP access to eDirectory, as described in “Installing a Novell Messenger System” in the
Messenger 2.0 Installation Guide.

Figure 3-2 Directory Access Page in the Messenger Installation Program

Directory Access
The Movell Meszenger agents can access elirectory directly or N

thraugh an LDAP server.

Specify how the agents should access the directory.

% Use direct access

Replica Address; I
[B.0. HRH. M. e K]

" Use LDAP to access the directary

Huost: I
(2, i st i ]

Part: 389
389 o7 B3E [SEL] I

Foot Certificate;
[e.q. z:publichrooteertder] I Browse... |
IristallShield

Installation Guide | < Back | Mext > I Cancel |

The access method chosen during installation applies initially to how the Messenger agents access
eDirectory to obtain their configuration information. If you want to change this method, see
“Changing the eDirectory Access Method for Starting the Messaging Agent” on page 29
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With no further configuration, the Messaging Agent also accesses eDirectory on behalf of users by
using the access method chosen during installation. The Messaging Agent accesses eDirectory for
users whenever they:

+ Start the Messenger client and authenticate to the Messenger system

¢ Search for users to add to their contact lists

¢ Display user information about contacts in their contact lists

+ Save Messenger client settings
The following tasks help you customize eDirectory access for Messenger users:

¢ Section 3.2.1, “Providing LDAP Access to eDirectory for Messenger Users,” on page 81

*

Section 3.2.2, “Providing Full Name Indexing,” on page 89

*

Section 3.2.3, “Selecting Bind or Compare eDirectory Access for Users,” on page 90

*

Section 3.2.4, “Forcing Direct eDirectory Access for Users,” on page 90

*

Section 3.2.5, “Customizing Authentication and Searches by eDirectory Attribute,” on page 91

3.2.1 Providing LDAP Access to eDirectory for Messenger
Users

To customize LDAP access for Messenger users, you create an LDAP profile where you provide
information about the LDAP servers that are available in your system. You need only one LDAP
profile for your Messenger system, no matter how many LDAP servers you have.

If you have already configured your default scope profile, as explained in “Editing the Default
Scope Profile to Include Additional eDirectory Users” on page 79, you can continue to use the
default scope information, while providing additional LDAP configuration information in the LDAP
profile. However, the LDAP profile allows you to provide scope information in a more detailed,
LDAP-specific manner. As you set up the LDAP profile, you can decide which source of scope
information you want to use for your Messenger system.

To set up an LDAP profile, complete the following tasks:

¢ “Creating an LDAP Profile” on page 81

¢ “Configuring the LDAP Profile” on page 82

+ “Assigning the LDAP Profile to Your Messenger System” on page 86
+ “Assigning Required Rights for eDirectory Access” on page 87

Creating an LDAP Profile

1 In ConsoleOne, browse to and expand the Messenger Service object.
2 Right-click the LDAP Container object, then click New > Object.

Managing Messenger Client Users

81



New Object X

Create object in:
tE DOCTEST2! Ok
LDAFPContainer.MessengerService corparate

Cancel
Clazs:

hnrLDAPProfile e
3 Select nnmLDAPProfile, then click OK.
New LDAP Profile X
Mame: ||
[ Define additional properties
K | Cancel | Help |

4 Specify a descriptive name for the LDAP Profile object, select Define additional properties,
then click OK.

5 Continue with “Configuring the LDAP Profile” on page 82.

Configuring the LDAP Profile

The LDAP profile has a General tab, where you identify the scope, query settings, and LDAP user
information.
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Figure 3-3 LDAP Profile General Page

Properties of LDAP Profile K

{LDAP Profile = || NDS Rights = | Other | Rights to Files and Forders |

Distinguished nams and scope 2

Biass DN | ﬂ
Base scope: |Search whole suktree ﬂ

Additional Dhls:

A3

ol

L

I Followe LDAP referrals

Guery Seftings
Query Meximum Results: 100 ::l
Guery Timeout (seconds) 30 ::I

User Seftings

Username: | Sel Password 3
Page Options | cance | | ten |

1 On the General tab, fill in the following fields if you want to use the LDAP profile, rather than
a scope profile, to define the scope of your Messenger system:

Base DN: Browse to and select the container object in eDirectory where the majority of User
objects are located. Your selection is displayed in the Base DN field as the distinguished name
(DN) of the container object. For example, OU=users,O=corporate.

Base scope: Select the scope you want searched for User objects:
¢ Search whole subtreee
¢ Search base DN and one level below
¢ Only search base DN

Searching only the base DN provides the fastest results. Searching the whole subtree provides
the most thorough search. The base scope you select depends on where User objects are located
in your eDirectory tree.

Additional DNs: If your eDirectory tree includes User objects that are located outside of the
base DN, list other DNs as needed. The additional DNs are searched in the order listed.

Follow LDAP referrals: Select this option if you want to take advantage of the LDAP referral
feature. The eDirectory replica that an LDAP server accesses might or might not contain all the
contexts that exist in the eDirectory tree. If the LDAP server does not find any results in the
contexts available in its eDirectory replica, it can refer the query to another LDAP server that
accesses a different eDirectory replica, where additional contexts might be available for
searching and where results might be obtained.

Selecting this option might add to the search time but might produce better results. Do not
select this feature if you do not want the Messaging agent to be referred to possibly unknown
LDAP servers.

IMPORTANT: If you previously associated a scope profile with your Messenger system, you
must remove it in order for the scope information provided in the above fields to take effect.
Right-click the Messenger Service object, then click Properties. On the General tab, clear the
contents of the Scope Profile field, then click OK to save the change. Also check for and
remove any scope profiles associated with policies or individual users that you want to use the
LDAP profile.
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2 On the General tab, fill in the following fields to control how you want information returned
when users search for other Messenger users to add to their contact lists in the Messenger
client:

Query Maximum Results: Specify the maximum number of users you want returned to the
Messenger client when users search for other users to add to their contact lists. The default is
100.

Query Timeout: Specify in seconds the maximum amount of time you want a search for
Messenger users to take. If no users are found within the allotted time, the Messenger user
receives no results from the search. The default is 30 seconds.

3 On the General tab, fill in the following fields to provide LDAP server login information if you
want the Messaging Agent to log in differently on behalf of Messenger users than it does when
logging in to obtain its configuration information:

Username: Specify the LDAP username that the Messaging Agent can use to access the LDAP
server (for example, CN=Admin,0OU=Users,O=Corporate). The Messaging Agent needs to log
in with Read, Write, and Browse rights to all User objects. This user must be added as a trustee
to the eDirectory Tree object (or to the top organizational container that holds your Messenger
system and users). Steps for this are provided later in this procedure.

Set Password: Click Set Password, type the password for the LDAP username twice for
verification, then click Set Password.

4 Click Apply to save the general LDAP settings.
5 Click LDAP Profile > Connections to display the Connections page.

Properties of LDAP Profile E|
LOAP Profile ~ || NDS Rights ~ | Gther | Rights to Files and Foiders |
Connections

Connection Seftings
Default Connections: 03
e Timeoul (seconds): [ 300 =3
Maxirun Connections: [ a0 -3

Connections List:

Al

[

Page Options ‘ Cancel | | Help |

6 Fill in the following fields to configure how the Messaging Agent connects to LDAP servers:

Default Connections: Specify the minimum number of connections that the Messaging Agent
can establish with each LDAP server on startup and maintain even when the connections are
idle. The default is 10.

Do not set the default number of connections greater than the number of client/server threads
defined for the Messaging Agent on the Performance page of the Messaging Agent object. This
results in open connections that could never be serviced by the Messaging Agent.

Idle connections occupy memory, but using an existing connection is faster than creating a new
connection. The default number of connections is always kept open, even if they are idle.
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Idle Timeout: Specify in seconds how long a connection between the Messaging Agent and an
LDAP server should remain open if it is idle and there are more than the minimum number of
connections open. The default is 30 seconds. Increase the idle timeout to maintain more open
connections. Decrease the idle timeout to conserve memory.

Maximum Connections: Specify the maximum number of connections that can exist between
the Messaging Agent and each LDAP server. The default is 30.

Below the Connection Settings fields, the Connections List defines which LDAP servers you
want the Messaging Agent to be able to connect to.

Connections List: The LDAP servers that you add to the connections list form a pool of LDAP
servers. When the Messenger client tries to connect to the Messenger system, if the first LDAP
server it contacts isn’t responding, the Messenger client automatically tries another LDAP
server in the pool until it is able to connect.

Click 4dd to provide information about an LDAP server.

LDAP Connection

.Host Address

| " DMS Hostname: |

Port: ::I
Preference: ::I

[Security Information

| I ssLEnabled

al |

oK ‘ Cancel ‘ Help ‘

Fill in the following fields:
IP Address or DNS Hostname: Specify the IP address or DNS hostname of the LDAP server.

Port: Specify the port number on which the LDAP server listens for service requests. The
typical port number for non-SSL connections is 389. The typical port number for SSL
connections is 636.

Preference: Assign the LDAP server a preference (or priority) of 0, 1, or 2. The Messaging
Agent attempts to contact all priority 0 LDAP servers before contacting priority 1 LDAP
servers and all priority 1 LDAP servers before any priority 2 LDAP servers.

IMPORTANT: For best performance, do not define more than one priority 0 LDAP server.

SSL Enabled: Select SSL Enabled if the LDAP server uses SSL encryption.

Root Certificate: Specify the full path to the root certificate on the LDAP server. Typically, the
root certificate is named rootcert .der. On a NetWare® server, it is located in
sys:\public.Ona Windows server, it is exported to a user-specified location after
installation of eDirectory for Windows.

If you do not specify a root certificate, your LDAP server must be configured to accept clear
text passwords in order for you to enable SSL encryption without a root certificate.

9 Click OK to save the information for the LDAP server.
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10 Repeat Step 7 through Step 9 for each LDAP server that you want to use to provide eDirectory
access.

When you specify multiple LDAP servers, they form a pool of available LDAP servers that the
Messaging Agent contacts in a round-robin fashion. This provides very reliable eDirectory
access for Messenger users.

11 Click OK to save the LDAP profile.
12 Continue with “Assigning the LDAP Profile to Your Messenger System” on page 86.

Corresponding Startup Switches: You can also use the /dirquerymaxresults,
/dirdefaultconnections, /diridletimeout, and /dirmaxconnections startup switches in the Messaging
Agent startup file to configure how the Messaging Agent interacts with LDAP servers. In addition,
if you have multiple LDAP servers, you can use the /dirpoolresettime startup switch to specify the
number of minutes between the time when the Messaging Agent receives an error response from a
pooled LDAP server and the time when that LDAP server is reinstated into the pool of available
LDAP servers. You can use the /Idapuser and /ldappwd startup switches to override the information
provided for the /user and /password startup switches during installation.

Assigning the LDAP Profile to Your Messenger System

The LDAP profile is not in effect until you have selected it on the General page of the Messenger
system object.

1 Right-click the Messenger Service object, then click Properties.

Properties of MessengerService El

Tiovail i NDS Rights ~ | Other | Rights to Files and Folders |

General i
Detau Policy: [p PolicyContainer. ice.corporste | #
LDAF Proe: | = 2
Scope Profile. [DefautScopsProfile ScopeContainer Messenger Service. corparte =
Host List i
Page Options... Cancel Help

2 In the LDAP Profile field, browse to and select the LDAP profile you just created.

3 Ifyou provided scope information for the LDAP profile in Step 1 in “Configuring the LDAP
Profile” on page 82, make sure that the Scope Profile field is empty.

Also check for and remove any scope profiles associated with policies or individual users that
you want to use the LDAP profile.

4 Click OK to save the LDAP profile information for your Messenger system.
5 Continue with “Assigning Required Rights for eDirectory Access” on page 87

86 Novell Messenger 2.0 Administration Guide



Assigning Required Rights for eDirectory Access

If the user you specified in Step 3 in “Configuring the LDAP Profile” on page 82 does not have
adequate rights, the Messaging Agent cannot access eDirectory successfully. Without sufficient
rights to the Messenger Service object, the Messaging Agent cannot access its configuration
information on the Messaging Agent object in eDirectory. Without sufficient rights to User objects,
the Messaging Agent cannot access users' contact lists, Messenger client settings, and other user-
specific information.

* “Assigning Trustee Rights to Access Agent Objects” on page 87
* “Assigning Trustee Rights to Access User Objects” on page 88

Assigning Trustee Rights to Access Agent Objects

1 Right-click the Messenger Service object, then click Properties.
2 Click NDS Rights > Trustees of This Object.
3 Click Add Trustee.

4 Browse to and select the user you specified in Step 3 in “Configuring the LDAP Profile” on
page 82.

Rights assigned to selected objects

On ohject: Mes=sengerService corporate

Property Rigiht=

[ Supervisor

[+ Browse
[ Create
[~ Rename

[ Delete

I# Inheritable

A Property ...
Delete Property

Ok | Cancel | Help ‘

5 Set the following trustee rights:
5a Select [Entry Rights], select Browse, then select Inheritable.
5b Select [All Attributes Rights], select Compare, Read, and Write, then select Inheritable.
5¢ Click OK to add the user, with the assigned trustee rights, to the list of trustees.

6 Click OK to save the updated list of trustees for the Messenger Service object.

7 Continue with “Assigning Trustee Rights to Access User Objects” on page 88
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Assigning Trustee Rights to Access User Objects
1 Right-click the eDirectory Tree object (or the top organizational container that holds User
objects), then click Properties.
2 On the Trustees of This Object page, click Add Trustee.

3 Browse to and select the user you specified in Step 3 in “Configuring the LDAP Profile” on
page 82.

Rights assigned to selected objects

On ohject: Mes=zengerService corporate

Property Rigiht=

I [Entry Rights] [ Supervizor

b [2)l Attributes Rights]
¥ Compare

[+ Read
[ wurite
[ Aod Selt

I# Inheritable

A Property ...
Delete Property

Ok | Cancel | Help ‘

4 Set the following trustee rights:
4a Select Entry Rights, select Browse, then select Inheritable.
4b Seclect All Attributes Rights, select Compare and Read, then select Inheritable.

4c Click Add Property, select Show All Properties, then select one of the following
properties:

+ nnmBlocking

+ nnmBlockingAllowList
+ nnmBlockingDenyList
+ nnmClientSettings

+ nnmContactList

+ nnmCustomStatusList

¢ nnmLastLogin

Properties that start with lowercase letters sort after all properties that start with uppercase
letters.

4d Click OK to add the selected property to the property list.

4e For the selected property, assign Compare, Read, and Write rights, then select Inheritable.
4f Repeat Step 4¢ through Step 4¢ for each Messenger property.

4g Click OK to add the user, with the assigned trustee rights, to the list of trustees.
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5 Click OK to save the updated list of trustees for User objects.

6 Stop and then start the Messenger agents to put the LDAP profile into effect.

3.2.2 Providing Full Name Indexing

When users search for a contact, the Messenger client uses the eDirectory indexes of User object

attributes in order to find users. By default, the eDirectory Full Name attribute is not indexed. As a
result, when users perform a name search, results are returned more slowly because all User objects
in the scope must be checked. Therefore, you should configure eDirectory on the Messenger server
so that it indexes the Full Name attribute.

This procedure requires the eDirectory snap-in to ConsoleOne, which can be obtained from the

Novell Product Downloads site (http://download.novell.com).

1 In ConsoleOne, browse to and right-click the Server object that represents your NetWare,
Linux, or Windows server, then click Properties.

2 Click Indexes to list the eDirectory attributes that are currently indexed.

Properties of prv-doctest2

Indexes

Supported Services I Resources | Users I SLP I ZENworks Imaging |

Inde:x Manage Page

Predicate Data | Wian Trai( EE

Mame
Aliased Ob...

State:
Online

Type
Operational

Rule
Value

Attribute
Aliased Ob...

CN

Online

Auto hdded

Value

CH

X

CH_S5 Online huto Added Substring CH
de online ruto hdded Value de
Equivalent._ . |Online System Value Equivalent_ .
extensionInio |Online systen Value extensionInta
Given Name Online huto hdded Value Civen Name
GUID online Operavional  |Value GUID
ldaphttrib._. |Online Systen Value ldapittrib_ ..
ldapClassList |Online huto Added Value ldapClassList
Meuber Online System Value Menber
Obituary Online Operational |Presence Obituary
Defersnce Online System Value Daference
Bevision Online System Value Bevision
Surnaue online ruto hdded Value Surname
uniguell Online huto Added Value unicqueID
unigueID_S5  |Online huto hdded Substring unicquelD

3 Click Add to add a new attribute to the list.

Create Index @

Index Drefinition

Incdlex Mame: | |
Attribute: |ACL v
Rule: |Presence v|

[ O H Cancel ][ Help ]

4 Fill in the following fields:
Index Name: Specify a descriptive name for the attribute, such as Full Name.

Attribute: Select Full Name.
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Rule: Select Value.

This matches the entire value or the just first part of the value of an attribute. For example,
value matching could be used to find entries with a Full Name that is equal to “Jensen” as well
as entries that begin with “Jen.”

5 Click OK to add the Full Name attribute to the list.
6 Click OK again to activate the index for the Full Name attribute.

3.2.3 Selecting Bind or Compare eDirectory Access for Users

When the Messenger agents authenticate to eDirectory on behalf of Messenger users (using either
direct access or LDAP access), they use either a bind or compare operation. By default, a compare
operation is used.

With a compare, the Messaging Agent provides the user's password to eDirectory or the LDAP
server. When responding to a compare request, eDirectory or the LDAP server compares the
password provided by the Messaging Agent with the user's password in eDirectory, and returns the
results of the comparison.

You can configure the Messaging Agent to use a bind operation instead of a compare. With a bind,
the Messaging Agent essentially logs in to eDirectory or the LDAP server. When responding to a
bind request, eDirectory and most LDAP servers enforce password policies such as grace logins and
intruder lockout, if such policies have been implemented.

Using a compare can provide faster access than a bind; there is typically less overhead involved
because password policies are not being enforced.

If you want Messenger users to authenticate by using a bind rather than a compare:

1 Edit the Messaging Agent startup file (strtup.ma).

On NetWare and Windows, the startup file is located in the Messenger Agent installation
directory. You can edit the startup file from the Messaging Agent console. See “Controlling the
Messaging Agent from the Messaging Agent Console” on page 38.

On Linux, the startup file is located in /etc/opt/novell/messenger.
2 Remove the comment character (;) from the /diruserauthbind switch.
3 Save the startup file.

4 Stop and then start the Messaging Agent so that it reads its updated startup file and uses a bind
operation when authenticating to eDirectory on behalf of Messenger users.

3.2.4 Forcing Direct eDirectory Access for Users

You can configure the Messaging Agent to use direct access to eDirectory on behalf of Messenger
users even if you have configured the Messaging Agent to use LDAP access when retrieving its
configuration information, as described in “Using LDAP Access for the Messaging Agent” on
page 30.

If you want Messenger users to use direct access to eDirectory:

1 Edit the Messaging Agent startup file (strtup.ma).
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On NetWare and Windows, the startup file is located in the Messenger Agent installation
directory. You can edit the startup file from the Messaging Agent console. See “Controlling the
Messaging Agent from the Messaging Agent Console” on page 38.

On Linux, the startup file is located in /etc/opt/novell/messenger.
2 Remove the comment character (;) from the /diruserforcedirect switch.
3 Save the startup file.

4 Stop and then start the Messaging Agent so that it reads its updated startup file and uses direct
access when authenticating to eDirectory on behalf of Messenger users.

3.2.5 Customizing Authentication and Searches by eDirectory
Attribute

By default, when Messenger users search by user ID, the Messaging Agent searches on the CN
(common name) eDirectory attribute. The CN attribute corresponds to the name of User objects in
the eDirectory tree. Typically, User objects are named based on users' names, such as SJones or
SophieJones. If your eDirectory tree uses the CN attribute for something less helpful in the
Messenger client (for example, employee numbers), you can use the /diruseralias startup switch in
the Messaging Agent startup file to configure the Messaging Agent to search on a different attribute
besides CN. For example, you might want the Messaging Agent to search based on the Internet
EMail Address. You can use any eDirectory attribute of type STRING.

To change the eDirectory attribute that the Messaging Agent searches on:

1 Edit the Messaging Agent startup file (strtup.ma)

On NetWare and Windows, the startup file is located in the Messenger Agent installation
directory. You can edit the startup file from the Messaging Agent console. See “Controlling the
Messaging Agent from the Messaging Agent Console” on page 38.

On Linux, the startup file is located in /etc/opt/novell/messenger.

2 Remove the comment character (;) from the /diruseralias switch.

3 Provide the eDirectory attribute in quotation marks:
Example: /diruseralias-"Internet EMail Address"

4 Save the startup file.

5 Stop and then start the Messaging Agent so that it reads its updated startup file and searches on
the specified eDirectory attribute instead of CN.

When you restart the Messaging Agent, Messenger users need to log in again in order to see the
results of this change.
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3.3 Providing User Searches Based on E-Mail
Addresses

By default, Messenger users can search for other users to add to their contact lists in the Messenger
client by first name, by last name, by first and last name, and by eDirectory user ID. You can add the
capability of searching on e-mail addresses by setting up Messenger addresses that are equivalent to
users' existing e-mail addresses. To set up Messenger addresses, you must add one or more
hostnames to your Messenger system.

¢ Section 3.3.1, “Establishing a Hostname for Your Messenger System,” on page 92
¢ Section 3.3.2, “Setting Up Multiple Hostnames,” on page 94

For another approach to this task, see “Customizing Authentication and Searches by eDirectory
Attribute” on page 91.

3.3.1 Establishing a Hosthame for Your Messenger System

If all of your Messenger users have e-mail addresses that are part of the same Internet domain (for
example, Corporate.com), you can set up your Messenger system to recognize that Internet domain
name as a Messenger address. This enables users to locate contacts by searching for their e-mail
addresses (for example, JSmith@Corporate.com).

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Right-click the Host Container object, then click New > Object.

New Object g|
Create object i

DOCTEST2/ Ok

HostContainer.MessengerService. corporate

Cancel ]
Class:

i Al

Hel
@ nnmHost i
3 Select nmmHost, then click OK.
New Host r5__<|
Matme: ||
[ Define additional properties
Ok I Cancel I Help I

4 Specify a descriptive name for the new Host object (or host profile)
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For simplicity, you might want to name the new host profile after the Internet domain name it
represents. For example, if users receive e-mail at username@Corporate.com, then you could
use Corporate as the name of the host profile.

5 Select Define Additional Properties, then click OK.

Properties of host object El

Host 7| NDS Rights ~ | Gther | Rights to Files and Folders |
Genersl |

Host Name: [

Seope Profile [ ﬂ ﬂ

Page Options ‘ Cancel | | Help |

6 In the Host Name field, specify the Internet domain name that appears in users' e-mail
addresses (for example, Corporate.com).

7 In the Scope Profile field, browse to and select the Default Scope Profile object, then click OK
to create the new host profile.

8 Right-click the Messenger Service object, then click Properties.

Properties of MessengerService El
Hovell Kiessenger ~ | NDS Rights = | Cther | Rights to Files and Folders |
Detau Policy: [p PolicyContainer. ice.corporste | £
LDAP Profile. | w2
Scope Profile. [DefautScopsProfile ScopeContainer Messenger Service. corparte =
Host List i
Page Options... Cancel Help

9 Beside the Host list, click Add.

10 Browse to and select the new host profile you created in Step 7 above.
11 Click OK to save the updated host list.

12 Stop and then start the Messaging Agent to put the new hostname into effect.

Messenger users can now specify e-mail addresses as well as eDirectory user IDs in the Messenger
client Use This User ID field.
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If archiving is enabled, authorized Messenger users can search the Messenger archive for users'
conversations by specifying their e-mail addresses. Conversations archived before the hostname was
established are not searchable by e-mail address.

3.3.2 Setting Up Multiple Hosthames

If your organization is large, it might be divided up into units. For example, Corporate.com might
include Development.Corporate.com, Sales.Corporate.com, and so forth. By setting up multiple
hostnames, you enable Messenger users to search for contacts within subsets of your organization.

In order to set up multiple hostnames, you must first set up a scope profile for each hostname.

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Right-click the Scope Container object, then click New > Object.

New Object X
Create object i
% DOCTEST2S Ok
ScopeContainer.MessengerService.corporate
Cancel
Class:
F Alias Help
18! nnmScopeProfile
3 Select nnmScopeProfile, then click OK.
New Scope Profile |
Matne: |
[ Define additional properties
Ok | Cancel | Help |

4 Type a descriptive name for the new scope profile, select Define Additional Properties, then
click OK.
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)

Properties of test

‘Scope Profiie 1| NDS Rights ~ | Cther | Rights to Files and Folders |
General

Context List:

Al

ik

Page Options ... 1 . Cancel ; Help

5 Click 4dd.

Context List Entry

Contexd: | e

[ Include sub-contexts

Ok | Cancel | Help |

6 Browse to and select one or more contexts that use the hostname you want to create.

7 If necessary, select Include sub-contexts for the selected contexts.

8 Click OK to add the contexts to the context list.

9 Repeat Step 5 through Step 8 for additional contexts that use the hostname you want to create.
10 Click OK to save the scope profile for the hostname.
11 Right-click the Host Container object, then click New > Object.
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New Object X

Create object in:
DOCTESTZ! Ok
HostContainer. MessengerService corparate

Cancel ]
Clazs:

F Alias

Helg
12 Select nnmHost, then click OK.
New Host E|
Marne: “
| Define additional properies
Ok I Cancel I Help I

13 Type a descriptive name for the new Host object.
It could be the same as the hostname you are setting up or it could be different, as needed.
14 Select Define additional properties, then click OK.

Prop s of host object g|
S Rights w | Other | Rights toFiles and Folders |
Host hame: |
Scope Profile I E| 2
Rage Options 0K Cancel ol Help

15 Fill in the following fields:

Host Name: Specify the hostname the corresponds to the scope profile you created in Step 10
above.

Continuing with the above example, to subdivide Corporate.com, you would specify
Development.Corporate.com.
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Scope Profile: Browse to and select the new scope profile you just created in Step 10 above.
16 Click OK to create the new Host object.

17 Repeat Step 2 through Step 16 for each hostname you want to establish in your Messenger
system.

18 Right-click the Messenger Service object, then click Properties.

Properties of MessengerService El

Hovell Kiessenger ~ | NDS Rights = | Cther | Rights to Files and Folders |

General
Detau Policy: [p PolicyContainer. ice.corporste | #
LDAP Profile. | w2
Scope Profile. [DefautScopsProfile ScopeContainer Messenger Service. corparte =
Host List i
Page Options... Cancel Help

19 Beside the host list, click Add.

20 Browse to and select the new Host objects to add them to the host list.

21 Click OK to save the updated host list.

22 Stop and then start the Messaging Agent to put the new hostnames into effect.

3.4 Setting User Policies

As an administrator, you can control how some Messenger client features work and you can
establish defaults for some Messenger client functionality by setting user policies. You can
configure user policies to apply to all Messenger users or to selected Messenger users.

¢ Section 3.4.1, “Editing the Default User Policy,” on page 98

¢ Section 3.4.2, “Creating a User Policy,” on page 99

¢ Section 3.4.3, “Customizing Messenger Client Features,” on page 101

¢ Section 3.4.4, “Customizing Personal History Features,” on page 102

¢ Section 3.4.5, “Controlling Users' Contact Lists,” on page 103

¢ Section 3.4.6, “Setting Up a Default Privacy List,” on page 105

¢ Section 3.4.7, “Selecting Default Display Attributes,” on page 106

¢ Section 3.4.8, “Creating A Custom Status,” on page 108

¢ Section 3.4.9, “Applying a Policy to Specific Users,” on page 110
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3.4.1 Editing the Default User Policy

If you use the same policy for all Messenger users, editing the default user policy affects all users. If
you have multiple user policies, editing the default user policy affects those users who are not
governed by another policy.

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Select the Policy Container object, right-click the Default Policy object, then click Properties.

Properties of DefaultPolicy @|

NDS Rights + | Cther | Riohts to Files and Folders |

I Enable Novell Messenger services

I™ Archive message sessions

IV Allow users ta search eDirectary for ather users

¥ Allow: users to send broadcast messages to other users
I7 Allow users to send system brosdoast messages

I Allow users to use chat rooms

I Mllow users to creste chat rooms

I allow users to change their password

[¥ Allow users to use Remember Password

BBEBREEERER

Defaul host [ | 2|
Scope profil | ﬂ A
Pagis Optins Cancel Hep |

3 Continue with the type of customization you want to perform:

Policy Property Page Policy Options

General Enable Novell Messenger Services
Archive Message Sessions
Allow Users to Search eDirectory for Other Users
Allow Users to Send Broadcast Messages to Other Users
Allow Users to Send System Broadcast Messages
Allow Users to Use Chat Rooms
Allow Users to Create Chat Rooms
Allow Users to Change Their Password
Allow Users to Use Remember Password
Default Host
Scope Profile

Personal History Allow Users to Print and Save Conversations
Allow Users to Use Personal History

Contact List Maximum Number of Contacts
Maximum Number of Folders
Contact List

Privacy Allowed/Blocked
Information List Selected Attributes
Custom Status Custom Status List
Used By Reference List
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4 Click OK.

5 After you modify the Default Policy object, stop and then start the Messenger agents to put the
new default policy into effect throughout your Messenger system.

3.4.2 Creating a User Policy

If you want to provide different policies for different users, you need to create multiple Policy
objects.

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Right-click the Policy Container object, then click New > Object.

New Object g|
Create object in:
¥4y DOCTEST2S Ok
FPolicyContainerMessengerSernvice. carporate
i Cancel
F Alias Help

3 Select nnmPolicy, then click OK.

New Policy

hame: ]
Movell Meszenger: 1 ﬂ il

Ok 1 Cancel | Help ]

4 Specify a descriptive name for the new policy, browse to and select the Novell Messenger
system that this policy belongs to, then click OK.

5 In the Policy Container, right-click the new policy object, then click Properties.
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Properties of test El

Folicy | NDS Rights ~ | Cther | Rights to Fies and Folders |
Gereral

[ Enable Novell Messenger services

I™ Archive message sessions

¥ Allow: users to search eDirectory for other users.

I Allow users to sent broadoast messages to other ussrs
I~ Allow users to send system brosdeast messages

I allow users to use chat rooms

I™ Ao users to creste chat rooms

I~ Allow users to charge their passvord

¥ Aliow users to use Remember Passward

BERREREEERE

Defeult host | | 2
Scope profie: [ & 2
Restore Default Settings
Fage Options... Cancel Help

6 Continue with the type of policy customization you want to perform:

Policy Property Page Policy Options

General Enable Novell Messenger Services
Archive Sessions
Allow Users to Search eDirectory for Other Users
Allow Users to Send Broadcast Messages to Other Users
Allow Users to Send System Broadcast Messages
Allow Users to Use Chat Rooms
Allow Users to Create Chat Rooms
Allow Users to Change Their Password
Allow Users to Use Remember Password
Default Host
Scope Profile

Personal History Allow Users to Print and Save Conversations
Allow Users to Use Personal History

Contact List Maximum Number of Contacts
Maximum Number of Folders
Contact List

Privacy Allowed/Blocked
Information List Selected Attributes
Custom Status Custom Status List
Used By Reference List

7 Click OK.

After you create a new policy, you do not need to restart the Messenger agents in order for the
updated policy to be in effect. The new policy is in effect the next time users governed by the
policy log in to Messenger, as described in “Applying a Policy to Specific Users” on page 110.
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3.4.3 Customizing Messenger Client Features

The options on the General page of the Policy object customize how the Messenger client works for
users governed by the policy you are creating or editing. You can set these options to enable or
disable certain functionality and to provide some settings that override comparable settings on the
Messenger Service object.

1 Edit or create a user policy.
2 Click Policy > General.

Properties of DefaultPolicy @|

NDS Rights + | Cther | Riohts to Files and Folders |

I Enable Novell Messenger services

I™ Archive message sessions

IV Allow users ta search eDirectary for ather users

¥ Allow: users to send broadcast messages to other users
I7 Allow users to send system brosdoast messages

I Allow users to use chat rooms

I Mllow users to creste chat rooms

I allow users to change their password

[¥ Allow users to use Remember Password

BBEBREEERER

Default host. | ﬂ ﬁ
Scope profil | ﬂ A
Page Options Cancel Help

3 Fill in the following fields:

Enable Novell Messenger Services: Use this option to enable or disable the Messenger client
for the users governed by this policy. It is enabled by default.

Archive Message Sessions: Use this option to enable or disable conversation archiving for
users governed by this policy. It is disabled by default. If you want to enable archiving, see
Chapter 4, “Enabling and Managing Archiving,” on page 131.

Allow Users to Search eDirectory for Other Users: Use this option to allow or prevent
Messenger users from building their contact lists by searching for users in eDirectory. It is
enabled by default. If you disable this option, users governed by this policy can only add
known eDirectory user IDs to their contact lists.

Allow Users to Send Broadcast Messages to Other Users: Use this option to enable or
disable users to send broadcast messages to other users. It is enabled by default. If you disable
this option, users governed by this policy cannot send broadcast messages to other users.

Allow Users to Send System Broadcast Messages: Use this option to enable or disable users
to send system broadcast messages to all users who are online. It is disabled by default. If you
enable this feature, users governed by this policy can send a broadcast message to all online
users.

Allow Users to Use Chat Rooms: Use this option to enable or disable users to use Messenger
chat rooms. It is enabled by default. If you disable this feature, users governed by this policy
cannot join Messenger chat rooms.

Allow Users to Create Chat Rooms: Use this option to enable or disable users to create
Messenger chat rooms. It is disabled by default. If you enable this option, users governed by
this policy can create Messenger chat rooms.
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Allow Users to Change Their Password: Use this option to enable or disable users to change
their eDirectory passwords from the Messenger client. It is disabled by default because
Messenger authenticates users by using their eDirectory passwords and you might not want
users changing their eDirectory passwords in the Messenger client. If you enable this option,
users governed by this policy have a Change Password item on the Tools menu in the
Messenger client where they can change their eDirectory passwords.

Allow Users to Use Remember Password: Use this option to enable or disable users to use
Remember Password. It is enabled by default. If you disable this option, users governed by this
policy cannot use Remember Password in the client.

Default Host: If you have set up multiple hosts in your Messenger system, as described in
Section 3.3, “Providing User Searches Based on E-Mail Addresses,” on page 92, browse to and
select the host that applies to the users governed by this policy.

4 Scope Profile: To override the scope profile defined on the General page of the Messenger
Service object for users governed by this policy, browse to and select the scope profile that lists
the contexts where users governed by the policy can search for User objects.

Each option is accompanied by a Lock button. When an option is unlocked, it can be overridden
by changing the option setting on the Novell Messenger General page of individual User
objects.

5 If you do not want an option to be changeable for individual Messenger users, click the Lock
button next to it.

6 Click Apply to save the general policy settings.
7 Continue with Section 3.4.4, “Customizing Personal History Features,” on page 102.
or

If you are finished configuring the policy and you are not modifying the Default Policy, skip to
“Applying a Policy to Specific Users” on page 110.

3.4.4 Customizing Personal History Features

The options on the History page of the Policy object customize how the Messenger client works for
users governed by the policy you are creating or editing. You can set these options to enable or
disable certain functionality and to provide some settings that override comparable settings on the
Messenger Service object.

1 Edit or create a user policy.

2 Click Policy > Personal History.
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Properties of test El

Bolicy | DS Rights + | Cther | Rights to Files and Folders |
Personal Histary
IV Mllow users ta prirt and save conversations @
I¥ Mllow users to use Persanal History &
Restare Default Settings
Page Options... « Cancel Help

3 Fill in the following fields:

Allow Users to Print and Save Conversations: Use this option to enable or disable users to
print or save their conversations. It is enabled by default. If you disable this feature, users
governed by this policy cannot print or save their conversations.

Allow Users to Use Personal History: Use this option to enable or disable users to use
Personal History. It is enabled by default. If you disable this feature, users governed by this
policy cannot use Personal History.

4 Tf you do not want an option to be changeable for individual Messenger users, click the Lock
button beside it.

5 Click Apply to save the general policy settings.
6 Continue with “Controlling Users' Contact Lists” on page 103.
or

If you are finished configuring the policy and you are not modifying the Default Policy, skip to
“Applying a Policy to Specific Users” on page 110.

3.4.5 Controlling Users' Contact Lists

By default, users build their own contact lists in the Messenger client and they can add as many as
100 contacts. As an administrator, you can control the size of the contact list and you can create a
default contact list for Messenger users, so that users governed by this policy have something to start
with when they first use the Messenger client.

1 Edit or create a user policy.

2 Click Policy > Contact List.
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)

Properties of test

DS Rights + | Other | Rights ta Files and Folders |

Cantact List |

Maximum nurmber of contacts: 100 j‘ Eﬁ'@
Maximum nurmber of folders: S0 j‘ Eﬁ'{@

Contact List: Elj' @

Add Uszer

Add Folder

i

Edit

Remave

!

Restore Defaultt Settings |

Page Options... L | Cancel Help

3 Fill in the following fields to control the size of users' contact lists:

Maximum Number of Contacts: Specify the maximum number of users that users governed
by this policy can add to their contact lists. The default is 100. Users' contact lists are stored on
their User objects in your Messenger system. Therefore, you might want to limit the amount of
space occupied by contact lists in eDirectory.

Maximum Number of Folders: Specify the maximum number of folders that users governed
by this policy can create in their contact lists. The default is 50.

4 If you want to create a default contact list for the users governed by this policy:

4a To add users to the default contact list, click Add User, browse to and select one or more
User objects, then click OK.

4b To add a folder in the default contact list, click Add Folder, select the new folder, click
Edit, specify the name of the folder, then click OK.

4c To add users to a folder, select the folder, click Add User, browse to and select one or more
User objects, then click OK.

You cannot drag and drop users into a folder.
4d To expand or collapse the list of users in a folder, double-click the folder.

4e To change the way a username displays in the default contact list, select the user, click
Edit, specify the username that you want to appear in the contact list, then click OK.

This does not rename the eDirectory User object.

4f To delete a user or folder from the default contact list, select the user or folder, then click
Remove.
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Folders do not need to be empty to be deleted. You are not prompted for confirmation.
There is no undo.

4g If you are creating an extensive default contact list, click Apply occasionally to save your
work.

New Messenger users see the default contact list when they first start the Messenger
client. Existing Messenger users who already have their own contact lists are not affected
by your default contact list.

Each contact list option is accompanied by a Lock button. When an option is unlocked, it
can be overridden by changing the option setting on the Novell Messenger General page
of individual User objects, or in the case of the contact list, by Messenger users
themselves.

5 If you do not want an option to be changeable for individual Messenger users, click the Lock
button next to it.

IMPORTANT: If you lock the contact list, users cannot change their contact lists in the
Messenger client.

6 Click Apply to save the contact list settings.
7 Continue with “Setting Up a Default Privacy List” on page 105.
or

If you are finished configuring the policy and you are not modifying the Default Policy, skip to
“Applying a Policy to Specific Users” on page 110.

3.4.6 Setting Up a Default Privacy List

By default, all users whose User objects are located in a context listed in a scope profile have access
to Messenger. Users control who can see their online status and who can send them messages. As an
administrator, you can establish a default privacy list for users governed by the policy you are
creating or editing.

1 Edit or create a user policy.

2 Click Policy > Privacy.

Properties of test @l

Allovyed, Blockex:
=Eweryone Else=
=
-
-
x|
Restore Default Settings
Page Optiohs [ Cancel Help.
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3 To add users to the Allowed list, click in the Allowed list, then click the + button.
or
To add users to the Blocked list, click in the Blocked list, then click the + button.
4 Browse to and select one or more users.

5 To move users from the one list to the other, select one or more users, then click the right-arrow
or left-arrow button.

6 To delete users from either list, select one or more users, then click the Remove button.

New Messenger users see the default privacy list when they first start the Messenger client.
Existing Messenger users who already have their own privacy lists are not affected by your
default privacy list.

The privacy list option is accompanied by a Lock button. When an option is unlocked, it can be
overridden by changing the option setting on the Novell Messenger General page of individual
User objects, or in the case of the privacy list, by Messenger users themselves.

7 If you do not want the default privacy list to be changeable for individual Messenger users,
click the Lock button.

IMPORTANT: If you lock the privacy list, users cannot change their privacy lists in the
Messenger client.

8 Click Apply to save the default privacy list.
9 Continue with “Selecting Default Display Attributes” on page 106.
or

If you are finished configuring the policy and you are not modifying the Default Policy, skip to
“Applying a Policy to Specific Users” on page 110.

3.4.7 Selecting Default Display Attributes

When Messenger users display contact property information in their Messenger contact lists, the
following information is displayed if it is available in eDirectory:

* First Name

*

Last Name

*

Department
+ Title
E-Mail Address

¢ Description

*

You can make more or less eDirectory information available for display in the Messenger client to
meet the needs of your users.

1 Edit or create a user policy.

2 Click Policy > Information List.
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Properties of test

+| NDS Rights = | Cther | Rights to Files and Folders |

Selected Attributes: d‘@

Internet Email Address
L
ou
Tle:
Description

Restore Default Settings

Al

[

Page Options... ( Cancel

Help

The information is listed according to its eDirectory attribute name. For example, L stands for
Location. The Messenger client automatically translates OU into Department and Internet
Email Address into E-mail Address, but any other attribute name changes must be made

manually.

3 If you want to clarify the meaning of an attribute for Messenger users:

3a Select an attribute, then click Edit,

Information Display List

Selected Attributes: |Description

Ok | Cancel ‘

Help |

3b Specify the name you want users to see when displaying contact properties, then click OK.

4 If the list includes information that you do not want users to be able to see, select an attribute,

then click Remove.
5 If you want to add more attributes to the list:
5a Click Add.

Information Display List

Selected Attrioutes: (|

Available Attributes |

Ok | Cancel ‘

Help |

3

5b If you want to add eDirectory attributes, click Available Attributes.
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Information Display List

Available Attributes:

accessCardiumber i‘
assistant

assistantPhone

Aucit: File Link

husinessCategory

carlLicense
city
ZH

Co =

QI | Cancel | Help |

All eDirectory attributes of type STRING or DN are listed.
5¢ Select one or more attributes, then click OK twice to return to the Information List page.
or

If you want to add LDAP attributes, specify one or more LDAP attributes, separating the
attributes with semicolons (;), then click OK to return to the Information List page.

5d Ifyou are using LDAP access to eDirectory and if you want to add telephone numbers and
fax numbers (which are not attributes of type STRING or DN in eDirectory), specify
telephoneNumber and/or faxNumber as attributes, then click OK to return to the
Information List page.

The information list option is accompanied by a Lock button. When an option is unlocked,
it can be overridden by changing the option setting on the Novell Messenger General page
of individual User objects.

6 If you do not want the default information list to be changeable for individual Messenger users,
click the Lock button.

7 Click Apply to save the information list.
8 Continue with “Creating A Custom Status” on page 108.
or

If you are finished configuring the policy and you are not modifying the Default Policy, skip to
“Applying a Policy to Specific Users” on page 110.

3.4.8 Creating A Custom Status

By default, the Messenger client provides the following selectable user statuses that indicate user
presence in the Messenger system:

Icon Status
Eq Online
& Busy
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Icon Status

@ Away
(%) Appear Offline

In the Messenger client, users can create their own custom statuses to indicate their presence. As an
administrator, you can create custom statuses to be available to all users governed by this policy.

1 Edit or create a user policy.

2 Click Policy > Custom Status.

Properties of test

Palicy ~ | WOS Rights + | Cther | Rights o Files andl Folders: |
Custom Status
Custom Status List 8y

Restore Default Settings

Add

i

Page Options...

Cancel

Help

Any existing custom status is listed.

3 Click Add to create a new custom status.

Custom Availability Status

Title: |

Auto-Reply Message:

oK

| Cancel |

Help |

4 Fill in the following fields:

Show As: Select Online, Away or Busy to determine the icon to accompany the custom status.

Title: Specify a descriptive name for the new status.

Auto-Reply Message: (Optional) Specify a message for the Messenger Agent to return
automatically whenever the new status is selected in the Messenger client.

5 Click OK to add the new custom status to the list.

6 Repeat Step 3 through Step 5 to create additional custom statuses.
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New Messenger users see your custom statuses when they first start the Messenger client.
Existing Messenger users who might have created their own custom statuses are not affected by
your custom statuses.

The custom status list option is accompanied by a Lock button. When an option is unlocked, it
can be overridden by changing the option setting on the Novell Messenger General page of
individual User objects, or in the case of the custom status list, by Messenger users themselves.

7 If you do not want the custom statuses to be changeable for individual Messenger users, click
the Lock button.

IMPORTANT: If you lock the custom status list, users cannot create their own custom statuses
in the Messenger client.

8 Click Apply to save the custom statuses, then continue with “Applying a Policy to Specific
Users” on page 110.

or

If you are modifying the Default Policy, click OK to save it.

3.4.9 Applying a Policy to Specific Users

After you have set the needed policy options, you select the Messenger users to be governed by the
policy.

1 Edit or create a user policy.
2 Click Policy > Used By.

P ies of test @|
+1| WS Rights = | Gther | Rights to Fies and Foiders |
Reference List
Add
Page Options ok | cancel | mpoy | hep |

Any users currently governed by the policy are listed.
3 Click Add, then browse to and select those users that you want to be governed by this policy.

You can select only User objects. You cannot select container objects, Group objects,
Organizational Role objects, GroupWise Distribution List objects, and so on.

The reference list option is accompanied by a Lock button. When an option is unlocked, it can
be overridden by changing the option setting on the Novell Messenger General page of
individual User objects.

4 Repeat Step 3 for each context where User objects are located.
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5 If you do not want the reference list to be changeable for individual Messenger users, click the
Lock button.

6 Click OK to save the user policy.

You do not need to restart the Messaging Agent in order for the new policy to be in affect. The new
policy takes effect for users governed by the policy the next time they log in to Messenger.

3.5 Distributing the Messenger Client Software

You have many alternatives for helping users install the Messenger client:

¢ Section 3.5.1, “Using the Novell Messenger Download Page,” on page 111
¢ Section 3.5.2, “Setting Up Auto-Update,” on page 112
¢ Section 3.5.3, “Configuring Your Web Server to Download the Messenger Client,” on page 113

¢ Section 3.5.4, “Distributing the Messenger Windows Client Software Using ZENworks for
Desktops,” on page 115

¢ Section 3.5.5, “Distributing the Cross-Platform Messenger Client Software Using Red Carpet
on Linux,” on page 120

3.5.1 Using the Novell Messenger Download Page

The Novell Messenger download page is available to users as soon as you finish running the
Messenger Installation program, as described in the Messenger 2.0 Installation Guide, and start the
Messaging Agent, as described in Section 2.1, “Starting the Messaging Agent,” on page 25.

In order for users to access the Novell Messenger download page in their Web browsers, you need to
tell them the IP address or DNS hostname of the server where the Messaging Agent is running and
the port number (8300 by default). So, for example, if you installed the Messaging Agent on a server
with an IP address of 172.16.5.18, the Novell Messenger download page is:

http://172.16.5.18:8300

When users view this URL, they see the following page:
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Figure 3-4 Novell Messenger Download Page
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When users click the Novell Messenger link, they download the nvlmsgr . exe file from the
\novell\nm\ma\software\client\win32 directory. By following the instructions on the
download page, users can install and start the Messenger client quickly and easily.

3.5.2 Setting Up Auto-Update

You can require Messenger users to update their Messenger client software whenever a new version

of the client is available

1 In ConsoleOne, browse to and right-click the Messenger Service object, then click Properties.

2 Click Novell Messenger > Client Update.

Properties of MessengerService

Hovell Messenger ~ | NDS Rights = | Gtner | Rights to Files and Folders |
Cliert Updiats

Cliert Dovvrload URL: are used both for web browser downloads and for auto-updates.

Cliert Download URLs:

Enable clizrt downioad through & browser

Enable cliert auto-update

Wersion |

|
BX

Date: [

L ol

Grace logins:

Update message:

To requirs a client update, specify the minimum version and date of the product. Leave the fislds blank if an update is not required.

Cancel

Page Options...

Help
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3 Fill in the following fields to configure the update process:

Client Download URLs: Click Add to specify each URL where the user's browser or the
Messenger client are redirected when attempting to download the updated client software.

The URLs in the list you create are tried in the order you list them. Make sure that the
Messenger nvimsgr . exe file is available for download from each URL in the list. For more
information, see “Configuring Your Web Server to Download the Messenger Client” on

page 113.

Enable Client Download Through a Browser: Select this option so that users can download
the updated Messenger client software from the Novell Messenger download page, as
described in “Using the Novell Messenger Download Page” on page 111.

Update Message: If desired, type the message that you want Messenger users to see when they
are notified about the Messenger client update.

4 If you want to require Messenger users to update, fill in the following fields:
Version: Specify the minimum acceptable version number for the Messenger client software.

Date: Click the Calendar button to specify the earliest acceptable date for the Messenger client
software.

If you fill in the Version and/or Date fields, users cannot run the Messenger client until they
update their software, unless you allow grace logins.

Grace Logins: Specify the number of times users can log in to the Messenger system without
updating their Messenger client software.

If you leave the Date and Version fields blank, users can choose whether or not to update their
Messenger client software when they are notified that a new version is available.

Client version information is stored on each user's workstation in the nmc132 . ver file.
5 Click OK to establish the update process.

When Messenger users start the Messenger client, they are notified whenever updated client
software is available.

3.5.3 Configuring Your Web Server to Download the Messenger
Client

By default, the Messaging Agent handles downloading Messenger client software to Messenger
users. If this activity seems to interfere with its ability to handle its instant messaging functions in a
timely manner, you can configure your Web server to download the client software instead. Before
performing the following steps, you should already have created your Messenger system and have
the Messenger agents running. You can download either Messenger client (Windows or Cross-
Platform) from a Messenger system on any platform (NetWare, Linux, or Windows).

1 In ConsoleOne, browse to and right-click the Messenger Service object, then click Properties.
2 Click Novell Messenger > Client Update.
3 Click Novell Messenger > Client Update.
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Properties of MessengerService El

Hovell Messenger ~ | NDS Rights = | Gther | Rights to Files and Folders |
Cliert Updiats

Cliert Dovvnload URLs are used both for web browser downloads and for auto-updates

Cliert Download URLs:

Enable clisnt downinad through 2 browser

Enable client auto-update

Wersion [

]
Date: | B
Grace logis: —

Updste message:

To require & client update, specify the mirimurn version and date of the product. Leave the fields blank if an update is not required.

Page Options... Cancel Help

4 Next to the Client Download URLs list, click Add.

Download URL

Downlosd URL: ||

Ol | Cancel | Help |

5 Specify the URL of your Web server, for example:
http://nm.novell.com:80

Be sure to include both the http:// and the port number where your Web server listens for
service requests.

6 Click OK to close the Download URL dialog box, then click OK again to save the updated
information on the Client Update page.

7 From the Messenger software subdirectory, copy the index . htm file and the
msgricon.gif file to the primary document directory of your Web server.

On NetWare and Windows, the Messenger software directory is
\novell\nm\ma\software. On Linux, itis /opt/novell/messenger/software.

If you want to provide the Novell Messenger download page in a language other than English,
copy the index.htm file from the appropriate language subdirectory beneath the Messenger
software directory.

8 Edit the index.htm file to remove all instances of ~down, for example:

Before:
/~down/client/win32/nvimsgr.exe

/~down/client/linux/nvlimsgr.bin

/~down/client/mac/nvlmsgr.sit

After:

/client/win32/nvlmsgr.exe
/client/xplat/linux/nvlimsgr.bin
/client/xplat/mac/nvimsgr.sit
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9 Depending on the requirements of your Web server, save the file as either index.htm or
index.html.

10 Under the primary document directory of your Web server, create a client subdirectory, then
create a platform-specific subdirectory in it, to create the following directory structure:

primary doc dir/client/win32
primary doc dir/client/xplat/linux
primary doc dir/client/xplat/mac

11 From the platform-specific subdirectory (win32, 1inux, or mac) of the Messenger software
directory, copy the appropriate Messenger file (nvlmsgr.exe, nvlimsgr.bin, or
nvlmsgr.sit) into the corresponding primary doc dir platform-specific subdirectory.

12 In the platform-specific primary doc dir subdirectory, create an ASCII text file named
files.txt with one of the following lines depending on your client platform:

client/win32/nvlmsgr.exe
client/xplat/linux/nvlmsgr.bin
client/xplat/mac/nvlimsgr.sit

13 After typing the appropriate, platform-specific line shown in Step 12, press Enter so that there
is an empty line at the end of the file.

14 Save the updated files. txt file.

15 Repeat Step 12 through Step 14 for each platform-specific subdirectory you created in Step 10,
so that you have three files. txt files, one for each platform.

16 Restart the Messenger agents to put the list of client download URLSs into effect.

You do not need to restart the Web server in order for Messenger users to be able to download the
Messenger client software.

3.5.4 Distributing the Messenger Windows Client Software
Using ZENworks for Desktops
You can use the Application Management functionality in Novell ZENworks® for Desktops to
distribute the Messenger client software to workstations. The following sections provide
instructions:

¢ “Understanding the Messenger Client .aot Files” on page 116

¢ “Creating a Messenger Client Application Object” on page 116

IMPORTANT: This information assumes that you are familiar with ZENworks for Desktops. For
background information, or for help completing the ZENworks tasks outlined in the steps below, see
the ZENworks for Desktops documentation at the Novell ZENworks documentation site (http://
www.novell.com/documentation-index/index.jsp?category=2ENworks).
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Understanding the Messenger Client .aot Files

The most effective way to create a Messenger client Application object is from an Application
Object Template (. aot) file. If desired, you can use the ZENworks for Desktops snAppShot™
utility to create a Messenger client . aot file, or you can use one of the predefined . aot files
included with Messenger:

¢+ english.aot: Creates an Application object you can use to install the English.

¢ multi.aot: Creates an Application object you can use to install all languages that are
available except English.

The . aot files contain the basic information required to create Messenger client Application
objects in Novell eDirectory. For example, the multi2.aot file can be used to create an
Application object that, when associated with users, causes the English, Czech, Hungarian, Polish,
and Russian versions of the Messenger client to be installed to a user's Windows workstation. For
this to work, you must have already installed the files for these language versions to a location that is
accessible to users.

Creating a Messenger Client Application Object

The following steps explain how to use ZENworks for Desktops 4 to create a Messenger client
Application object from one of the . aot files. If you are using a different version of ZENworks for
Desktops, the steps you need to complete might be slightly different.

1 Copy the contents of the \novellnm\ma\software\client\win32 directory to a
location on a server that is accessible to all users (for example,
\\server\volume\novell\messenger).

2 In ConsoleOne, right-click the container where you want to create the Messenger client
Application object, then click New > Object to display the New Object dialog box.

3 In the list of objects, select App.Application, then click OK to display the New Application
dialog box.

New Application Dbject x|

Create an Application ohject for;

- A simple application (no AOTLAXTIMS file)

@ #n application that has an AOTIAXT fils

© An application that has an M3 file
A application by using an existing Application object
A Weh application

- ATerminal Server application

To continue, click Next.

| et = I Cancal | | Help |

4 Select An Application that Has an .AOT/.AXT File, then click Next to display the AOT/.AXT
file path page.
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New Application Object - x|

Specifythe path to the AOTLAXT file you wantto use to create the Application
object

Palh to ADTLAT File
dizenihiulit] aot =

To continue, click Mesxt

= Back | Mest = I Cancel | Einish | Help |

5 Inthe Path to .AOT/.AXT File field, browse for and select the . aot file you want to use.

By default, the . aot files are located in the zen subdirectory in the downloaded GroupWise
Messenger 2 image.

For example, if you want to create an Application object to install the English, Czech,
Hungarian, Polish, and Russian versions of the Messenger client, select the multi2 . aot file.

6 Click Next to display the Application object information page, then customize the object name,
source path, and target path information if necessary.

New Application Object - x|
Cefine the following information far the Application object.

Ohbject Mame
|GruupWise Meszenger

SOURCE_PATH (location of installation files (i)

Hrtovelnmmatsofwarenclient
TARGET_PATH (client workstation directary path):
[criaveinmessenger =
To cortinue, click Mext.

<Back | Met> | caneat | Fron | peip |

Object Name: This is the name for the Application object created in eDirectory. You might
want to use a descriptive name (for example, “Messenger ECHPR Client” for the Czech,
Hungarian, Polish, and Russian versions.

SOURCE_PATH: This is the directory from which the Messenger client will be installed.
Specify the full path to the client directory (for example,
\\server\volume\novell\messenger). Unless all users have the same drive
mapping to the volume, make sure you use a UNC path.

This path is saved as the SOURCE_PATH variable. If you need to change it later, you can do so
on the Application object's Macros page (Application object > Common tab > Macros page).

TARGET_PATH: This is the workstation directory where the Messenger client will be
installed. Specify a path relative to the user's workstation.
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This path is saved as the TARGET PATH variable. If you need to change it later, you can do so
on the Application object's Macros page (Application object > Common tab > Macros page).

7 Click Next to display the system requirements page, then modify the system requirements if
necessary.

New Application Object x|

Add requirements to control availability of this application.

Showy | Type | Subject | Operator Value |
False = Disk size  Temp Direclo... greaterthan .. 1
False = Disk size  Windows Dir... greaterthan .. 1
False = Disksize  C greaterthan ... 2
False ﬂ% QS version Windows 98 greater than ...
False ﬂ% QS version Windows NT/.. greaterthan ...

To continue, click Mext.

Add = | Modify | Delete |

«Back | cancel | Firish | Help |

8 Click Next to display the user associations page.

New Application Dbject x|

Add user and workstation associations:

&|E| A2 = 2| Name |

Column Mame:

To continue, click Next.

Add Delete |

Cancel | Finigh | Help |

! <Back | et =

You can associate the Application object with the users and workstations you want it
distributed to at this time, or you can create the associations later.

9 After you have added the associations you want, click Next, review the information, then click
Finish to create the Application object.

10 Right-click the newly created Messenger client Application object, then click Properties.
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Properties of GroupWise Messenger e x|

Identification ~ | Distriaution Options + | Run Optians « | Associations | aveilekiity v | Common + | Faut Tolerand. [ ]v]
lcon

Application ican title: |GroupWise Messenger

Application lcan

E Modify

[ Disconnectable
[” ¥ait on force run
[ Determine force run order

order: [0 :|

¥ Show progress

Page Options. ok | Cancel | Apply Help

11 Click Common > Macros to display the Macros page.

12

Properties of GroupWise Messenger x|
entification = | Distrioution Options = | Run Gptions + | Associstions | svaiskiity = | Common ~ | Faut Toleranc [<] v
Macros
Macros
MName Value | Promptl
SOURCE_PATH Upry Ivimal Hwin32
TARGET_PATH CikovellMessengel
SHORT_TARGET_PATH CANoveliMESSEMN~1
PROGRAM_FOLDER Grouphiise Messenger
MESSEMGER_SERVER_ADDRESS |Replace with IP Address or Host Name for the Mess
MESSEMGER_SERVER_PORT 8300
DEFAULT_LANGUAGE EN
Delete |
Page Options... oK | Cancel | Anply | Help |

The MESSENGER_SERVER ADDRESS and MESSENGER _SERVER_PORT variables
provide the location of the Messaging Agent, so that users do not need to provide this
information when starting the Messenger client.

If you used one of the multix. aot files to create the Application object, the Macros list
includes a DEFAULT LANGUAGE variable. This variable specifies the interface language
that the Messenger client defaults to when it is installed. If necessary, individual users can
change the language when they start the Messenger client. If you modify the default language,
use the language codes listed under /1.

If you have users who use different language versions and you do not want them to be required
to change the default language, you can use the same .aot file to create multiple Application
objects. For each Application object, you should specify a default language and then associate
the Application object with the users who might want that default language.

Configure any other Application object settings required to provide the performance or
functionality you want.
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For example, you can configure the Application object so that the Messenger client is installed
immediately upon distribution to the user's workstation, without any intervention by the user.
Or, you can change the locations where the Messenger client's icon is displayed. For
information about Application object settings, see the ZENworks for Desktops documentation
at the Novell Documentation Web site (http://www.novell.com/documentation-index/
index.jsp?category=ZENworks).

After you associate the Application objects with the users you want, Novell Application
Launcher™ displays the Application object's icon on the users' workstations, if the workstation
meets the operating system requirements. If the Application object's icon does not appear
immediately, have the user refresh Novell Application Launcher.

13 If necessary, repeat the above steps to create additional Messenger client Application objects
from the Messenger client . aot files.

3.5.5 Distributing the Cross-Platform Messenger Client
Software Using Red Carpet on Linux

You can distribute the Messenger by using Red Carpet® on Linux. For additional information, see
the Red Carpet Web site (http://www.novell.com/products/desktop/update.html).

3.6 Configuring the Messenger Client Software

The following sections describe some specialized ways to configure the Messenger client software:

*

Section 3.6.1, “Using the Configuration File (setup.cfg) When Installing the Windows
Messenger Client,” on page 120

*

Section 3.6.2, “Using Startup Switches When Starting the Messenger Client,” on page 123

*

Section 3.6.3, “Using URL Commands in Your Web Browser on Windows,” on page 127

*

Section 3.6.4, “Changing the Messenger Server [P Address and Port Number,” on page 128

3.6.1 Using the Configuration File (setup.cfg) When Installing
the Windows Messenger Client

The Messenger configuration file (setup . cfqg) controls how the Windows Messenger client
software is installed by client users. It includes the following sections and parameters:

[NMSetup]
Path=
ProgramFolder=
LaunchNow=
ViewReadme=
IconOnDesktop=
LaunchOnStartup=
ServerAddress=
ServerPort=
ForceAddressAndPort=
UseWindowsColors=
ShowRememberPassword=

[Languages]
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[Show Dialogs]
HideAllDialogs=
SelectDestination=
SelectProgramFolder=
LanguageSelect=
SetupComplete=

After you change information in the setup . cfqg file, you must delete the nvimsgr.exe file,
then stop and restart the Messaging Agent so that it re-creates the nvlimsgr . exe file with the new
configuration information. The new configuration information then applies the next time users
install or update their client software.

+ “[NMSetup]” on page 121

¢ “[Languages]” on page 122

¢ “[Show Dialogs]” on page 123
[NMSetup]

The [NMSetup] section of the setup . cfg file enables you to control the options the Messenger
client Installation program presents to the user during installation.

Path=

Specify the path where you want the Installation program to install the client software.

ProgramFolder=

Specify the item on the Start > Programs menu where you want the Messenger client to appear. For
example, you can specify Novell Messenger or GroupWise.

LaunchNow=

By default, the Start Group Wise Messenger Now check box on the Setup Complete page is selected.
Specify No if you want it deselected by default when the user installs the client software.

ViewReadme=

By default, the View the GroupWise Messenger Readme check box on the Setup Complete page is
selected. Specify No if you want it deselected by default when the user installs the client software.

IconOnDesktop=

By default, the Put an Icon on the Desktop check box on the Setup Complete page is selected.
Specify No if you want it deselected by default when the user installs the client software.

LaunchOnStartup=

By default, the Messenger client starts when Windows starts. Specify No if you don’t want it to start
when Windows starts. Users then need to use the desktop icon to start the Messenger client.
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ServerAddress=

Defaults to the IP address of the server where the Messaging Agent is installed. If you move the
Messaging Agent to a different server, update this information to match. See “Changing the
Messenger Server IP Address and Port Number” on page 128.

ServerPort=

Defaults to 8300. Specify a different port number if the default port number is already in use on the
server. See “Changing the Messenger Server [P Address and Port Number” on page 128.

ForceAddressAndPort=

If you change the server address and/or port information, specify No if you want existing Messenger
client installations to continue using the original server address and/or port while new Messenger
client installations use the updated server and/or port information. Specify Yes for both existing and
new installations to use the updated information.

If you do not set ForceAddressAndPort=Yes after changing the server address and port
information, users need to use the /ipa and /ipp client startup switches to manually provide this
information when they start the Messenger client or they need to update the Address and Port values
of the \HKEY CURRENT USER\Software\Novell\Messenger\Login key in the
Windows registry. Using the ForceAddressAndPort=Yes parameter makes life much easier
for users. They are prompted to update their client software and the address and port information is
automatically changed for them.

UseWindowsColors=

By default, the Messenger client uses its own custom color scheme. Specify Yes to use standard
Windows colors instead.

ShowRememberPassword=

This setting controls whether the user sees the Remember Password option during the initial login to
the client.

The default setting displays the Remember Password option on the GroupWise Messenger Login
window. Setting ShowRememberPassword to No causes the Remember Password option to not
display during the initial login.

After the initial login, this option is controlled by its setting in ConsoleOne.

[Languages]

The [Languages] section of the setup. cfg file enables you to control what languages are
selected by default on the Language Selection page. Specify Yes for a language that you want
selected by default. Specify No for each language that you want deselected by default. For example:

ChineseSimplified=No
Chinese=No

Czech=No
BrazilianPortuguese=No
Danish=No

Dutch=No
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English=Yes
Finnish=No
French=Yes
German=Yes

If you suppress the Language Selection page, all selected languages are automatically installed on
users' workstations.

[Show Dialogs]

The [Show Dialogs] section of the setup.cfqg file enables you to control what interactions
take place when users install the Messenger client for the first time. If you choose to suppress a
page, use the corresponding parameter in the [NMSetup] section to provide the information that
the Installation program needs from the suppressed page.

HideAllDialogs=

Specify Yes for a completely non-interactive installation of the Messenger client. Provide all
required information in the [NMSetup] section.

SelectDestination=

Specify No to suppress the Choose Destination Location page during installation. Make sure you
have set the Path= parameter to the location where you want the client software to be installed on
users' workstations.

SelectProgramFolder=

Specify No to suppress the Select Program Folder page during installation. Make sure you have set
the ProgramFolder= parameter to the item on the Start > Programs menu where you want the
Messenger client to appear.

LanguageSelect=

Specify No to suppress the Language Selection page during installation. Make sure you have
specified Yes for each language in the [ Languages] section that you want to be installed on
users' workstations.

SetupComplete=

Specify No to suppress the Setup Complete page at the end of the installation. If you suppress this
page, users cannot review the Messenger client Readme. Make sure you have set the LaunchNow=
and TconOnDesktop= parameters to control whether the client starts automatically and whether
users have desktop icons to start the client.

3.6.2 Using Startup Switches When Starting the Messenger
Client

In general, Messenger client users do not need to be concerned with startup switches. However, they
can learn about client startup switches by looking up “startup options” in Messenger online help.
The client startup switches are summarized below as a reference for administrators:
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Windows Messenger Client  Linux/Mac Messenger Client

/background -background
/import -import
/initstatus /initstatus
/ipa -ipa

fipp -ipp
/keepalive -keepalive

N -l

/uor/@u -uor-@u
Ibackground

Starts the Messenger client without displaying the main window. By default, the client displays its
main window on the desktop.

Windows Messenger Client  Linux/Mac Messenger Client

Syntax: /background -background

limport

Specifies the name of a file containing Messenger contacts to import. The file is created in the
Messenger client by using File > Export Contact List. The . nmx extension identifies the file as a
Messenger contacts file. If the contacts file is not in the same directory where the client software is
located, you must provide a full pathname.

Windows Messenger Client Linux/Mac Messenger Client
Syntax: limport-[\director)\lfilename.nmx -import [/directory/lfilename.nmx
Example: /import-contacts.nmx -import contacts.nmx

/import-d:\shared\contacts.nmx -import /nm/contacts.nmx
flinitstatus

Specifies your presence at the time of login. The possible values are Away, Busy, and Offline.
Online is the default status if no initstatus argument is specified.

Windows Messenger Client  Linux/Mac Messenger Client

Syntax: [initstatus-presence -initstatus-presence

Example: /initstatus-away -initstatus-away
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lipa

Specifies the IP address or DNS hostname of the server where the Messaging Agent is running.

Windows Messenger Client Linux/Mac Messenger Client

Syntax: lipa-network_address -ipa network_address
Example: /ipa-172.16.5.18 -ipa 172.16.5.19
/ipa-nmserver -ipa nmserver2

On Windows, the Messenger user does not need to be aware of this information because the
Messenger server Installation program adds the network address and port information to the
setup. cfqg file that it installs into the \novell\nm\ma\software\client\win32
directory. When the user downloads the client software and installs it, the Messenger client
Installation program reads the server information in the setup . cfg file and updates the Windows
registry of the user's workstation with the information necessary for the Messenger client to start.
This startup switch, as well as the /ipp switch, are only needed to override the server information
automatically stored in the registry.

lipp

Specifies the port number on which the Messaging Agent listens for service requests. By default, the
port number is 8300.

Windows Messenger Client Linux/Mac Messenger Client
Syntax: lipp-port_number -ipp port_number
Example: /ipp-8400 fipp 8301

/keepalive

Overrides the current ping interval at which the Messenger client notifies the Messaging Agent that
it is still active. The default interval is every 10 minutes or as specified by the Messaging Agent /
keepalive startup switch. This regular communication between the Messaging Agent and the client
prevents firewalls and routers from disconnecting connections that seem to be inactive. You can
decrease the interval if a specific client user keeps getting unexpectedly disconnected. Use a setting
of 0 (zero) to turn off the ping activity.

Windows Messenger Client Linux/Mac Messenger Client
Syntax: /keepalive-minutes -keepalive-minutes
Example: /keepalive-5 -keepalive 0

N

Specifies the language to start the Messenger client in. By default, Messenger starts in the language
of the operating system, if it is available. If the operating system language is not available,
Messenger starts in English, but after it has started, you can choose a different language using Tools
> Options > User Interface Language.
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For the Windows client, this language is saved in the Windows registry and is used as the default
thereafter. For the Cross-Platform client, it is saved in the Java* preferences file for Messenger (~/
.java/.userPrefs/Novell/Messenger/prefs.xml on Linux and ~/Library/
Preferences/com.apple.java.util.prefs.plist on Macintosh*).

Windows Messenger Client Linux/Mac Messenger Client
Syntax: /I language_code -| language_code
Example: /I-ru -l de

Use one of the following language codes with the /1 switch to select the language for Messenger:

Table 3-1 Messenger Language Codes

Language Language Code Language Language Code
Arabic AR Hungarian HU
Czech CS Italian IT
Chinese-Simplified zhCN Japanese JA
Chinese-Traditional zhTW Korean KO
Danish DA Norwegian NO
Dutch NL Polish PL
English EN Portuguese PT
Finnish Fl Russian RU
French FR Spanish ES
German DE Swedish SV
Hebrew W

/u or I@u

Specifies the username to log in to your Messenger system with.

Windows Messenger Client  Linux/Mac Messenger Client

Syntax: /u-username -username
/@u-username /@username

Example: /u-LTanaka -u MPalu
/@u-SJones -@u GSmith

For the Windows client, the user's initial successful login is stored in the Windows registry and is
used as the default thereafter. If multiple users regularly need to run Messenger from the same
workstation, you could set up a shortcut on the desktop using the /u startup switch for each user.
Within Messenger, one user can log out and another log in using File > Log Out > Log In as a
Different User.
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For the Cross-Platform client, the user information is saved in the Java preferences file for
Messenger (~/.java/.userPrefs/Novell/Messenger/prefs.xml on Linux and ~/
Library/Preferences/com.apple.java.util.prefs.plist on Macintosh).

3.6.3 Using URL Commands in Your Web Browser on Windows

You can use URL commands in Web pages add applications to make specific Windows Messenger
client dialog boxes appear from those locations. Some URL commands take parameters. Use a
question mark (?) between the command and the parameter. Use an ampersand (&) between multiple
parameters.

The following URL commands are available:

+ “nim:launchNM” on page 127
+ “nim:startlm” on page 127

+ “nim:addContact” on page 127
¢ “nim:import” on page 128

¢ “nim:invite” on page 128

+ “nim:preferences” on page 128
+ “nim:close” on page 128

+ “nim:open” on page 128

+ “nim:exit” on page 128

nim:launchNM

Starts Messenger.

nim:startim

Opens the Send Instant Message dialog box so you can select a contact, or opens the Conversation
dialog box, if you use parameters to specify a contact and, optionally, a message.

Syntax:

nim:startIm

nim:startIm?username=username
nim:startIm?username=username&message=message

Example:

nim:startIm

nim:startIm?username=LTanaka
nim:startIm?username=LTanaka&message=Good+morning

Use a plus (+) between words in the message. The message must not include spaces.

See also “nim:invite” on page 128.

nim:addContact

Opens the Find dialog box so you can search for a new contact, or adds the specified contact to the
specified folder in the Messenger main window, if you use parameters to specify a contact and,
optionally, a folder.
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Syntax:

nim:addContact

nim:addContact?username=username
nim:addContact?username=username&Folder=folder name
Example:

nim:startIm

nim:startIm?username=LTanaka
nim:startIm?username=LTanaka&foldername=Team+Members

If the folder name consists of more than one word, use a plus (+) between words instead of a space.

nim:import

Opens the Import Contact List dialog box so you can browse to and select a . nmx file, or
immediately imports the contacts from the file into the Messenger main window, if you use a
parameter to specify the . nmx file.

Syntax:

nim:import
nim:import?filename=filename
Example:

nim:import
nim:import?filename=c:\temp\contacts.nmx

nim:invite
Equivalent to nim:startIm.

nim:preferences

Opens the Options dialog box.

nim:close

Closes the Messenger main window but does not exit the Messenger client.
nim:open

Opens the Messenger main window after it has been closed.

nim:exit

Exits Messenger.

3.6.4 Changing the Messenger Server IP Address and Port
Number

When you install and start the Messaging Agent, it creates the nvimsgr . exe file that users
download in order to install the Messenger client. The information in this file includes the IP address

of the server where the Messaging Agent is installed and the port number on which it listens for
requests from Messenger clients so that users do not need to concern themselves with this
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information. If you need to move the Messaging Agent to a different server, so that it is using a
different IP address and possibly port, each client installation needs to be updated with the new
information.
1 Install, configure, and start the Messaging Agent on the new Messaging Agent server.
2 Edit the setup. cfqg file in the following directory on the original Messaging Agent server:
\novell\nm\ma\software\client\win32
2a Scroll down to the ServerAddress= line and provide the new IP address.
2b On the ServerPort= line, provide a new port number if necessary.

2c Onthe ForceAddressAndPort= line, specify Yes so that all client installations and
updates receive the new information.

2d Save and exit from the setup.cfq file.

3 Stop the Messaging Agent on the original server.

4 Delete the nvimsgr . exe file from the following directory on the original server:
\novell\nm\ma\software\client\win32

5 Start the Messaging Agent again on the original server.

This creates a new nvlmsgr.exe file and, if you are using the auto-update feature as
described in “Setting Up Auto-Update” on page 112, the clients automatically install the
updated version of the client software, which includes the new address and port information.
When the updated clients start, they connect to the Messaging Agent on the new server.

3.7 Excluding Users from Your Messenger
System

The set of users that are included in your Messenger system are those users whose User objects are
located in an eDirectory context listed in a scope profile or an LDAP profile. If you need to exclude
specific users from your Messenger system even though their User objects fall within the scope of

your Messenger system, you can do so.

If you want to maintain a list of excluded users, you can create a policy to govern the excluded users,
as described in “Creating a User Policy” on page 99. On the General page of the Policy object,
deselect Enable Novell Messenger Services. On the Used by page of the Policy object, list those
users that you want to exclude from your Messenger system.

You can also edit the Novell Messenger General page of individual User objects and deselect Enable
Novell Messenger Services for individual users.
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Enabling and Managing Archiving

When you enable archiving, the Messaging Agent passes completed conversations to the Archive
Agent for storage on disk. The Archive Agent saves the conversations, indexes them, and searches
them when requested by authorized Messenger client users. If you do not need to archive everyone's
conversations, you can set up a policy to determine whose conversations are archived and whose are
not.

Archiving is optional. Because all users' conversations are stored together in the Messenger archive,
archiving is only necessary if you need to retain conversations for legal reasons, for example to
comply with a corporate e-mail retention policy that has been extended to instant messages.

The following sections help you enable and manage archiving in your Messenger system:

¢ Section 4.1, “Establishing the Master Archive Agent,” on page 131

¢ Section 4.2, “Starting the Archive Agent,” on page 133

¢ Section 4.3, “Enabling Archiving in Your Messenger System,” on page 139

¢ Section 4.4, “Granting Authorized User Access to the Archive,” on page 139
+ Section 4.5, “Configuring the Archive Agent in ConsoleOne,” on page 140

¢ Section 4.6, “Enhancing Archive Security with SSL Encryption,” on page 142
¢ Section 4.7, “Changing the Agent User Password,” on page 142

¢ Section 4.8, “Configuring and Indexing the Messenger Archive,” on page 143
¢ Section 4.9, “Establishing Archive Maintenance,” on page 145

¢ Section 4.10, “Monitoring the Archive Agent,” on page 146

¢ Section 4.11, “Optimizing Archive Agent Performance,” on page 149

¢ Section 4.12, “Managing the Archive Server,” on page 151

¢ Section 4.13, “Using Archive Agent Startup Switches,” on page 155

4.1 Establishing the Master Archive Agent

If you installed the Archive Agent along with the Messaging Agent when you created your
Messenger system, both Messenger agents were installed on the same server. This initial Archive
Agent was automatically established as the master Archive Agent on the Archive page of the
Messenger Service object.

To verify this:

1 In ConsoleOne®, browse to and right-click the Messenger Service object, then click Properties.
2 Click Novell Messenger > Archive.
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Properties of MessengerService

Hovell Kiessanger ~ | NDS Rights = | Cther | Rights to Files and Folders |

Master Archive Agent: 4 rchiveAgent prv-doctest2Server MessengerService corparate

Passphrase: [Reyt Bo039G 792398541 97431 X 3622033
Session Timeaut (minutes); [ & -3

Store Maintenance

Delay howrsy [ 2 -3

Interval (hours): |—4::‘

Excpire (days): ’7902:‘

Page Options...

Cancel

Help

Observe that a randomly generated passphrase has been provided. The passphrase is used for
encrypting conversations as they are saved into the archive. You can change the passphrase if

you want.

3 To change the passphrase, type a string of characters in the Passphrase field.

A passphrase must be longer than 7 characters and can be up to 100 characters in length.

4 Click OK.

You might want to continue to run both Messenger agents on the same server. However, the
Messaging Agent is CPU intensive because it handles users' conversations and eDirectory™
searches in memory, and the Archive Agent is file intensive because it archives conversations and
indexes the archive on disk. Therefore, you might want to run them on different servers.

If you want to continue running the initial Archive Agent on the same server with the Messaging
Agent, skip to Section 4.2, “Starting the Archive Agent,” on page 133.

If you want to install the Archive Agent on a different server from where the Messaging Agent is

running:

1 In ConsoleOne, delete the initial Archive Agent object.

2 Run the Messenger Installation program as described in the Messenger 2.0 Installation Guide.

3 On the Install Components page, deselect Messaging Agent and Administration Files.
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Nowell Messenger, Server Setup

Install Components

™ Messzaging Agent:
v Archive Agent:

[ Administration Files:

Installation Guide

Select the components to install to the Movel Messenger server. N

Handlez all meszage routing and presence notification for the
spstemn. & Movell Messenger system must have a Messaging
Agent inztalled.

Handles archiving and searching of conversations. & Naowvell
Meszenger system with archiving enabled must have an Archive
Agent inztalled.

Install the files neceszan to administer Movell Messenger
through Conzole0ne.

< Back Mext > |

Cancel |

4 Continue through the installation, providing the information necessary for installing the

Archive Agent.

5 Continue with Section 4.2, “Starting the Archive Agent,” on page 133.

4.2 Starting the Archive Agent

When you finish creating your Messenger system, the Installation program can start the Messenger
agents for you. If you installed the Messenger agents on a Windows server, the Archive Agent
console appears on the Windows server console.

& Nowell Messenger Archive Agent @ g@@

Statuz
Processing -

File Configuration Log  Actions  Help

Archivetgent SERVER. MezzengarService Windaw:  Up Time: 0 Dayz O Hre 1 Mine

Statistics
Fequests:
Fiequests Pending:
Archives: 1]

Lzers: i]
Archive Queus: ]

0 Emors: 1]
0 Oueries: 1]

14:50:56 EC4 CFG Meszage Transfer Protocol: Enabled ~
14:50:56 EC4 CFG Meszage Transfer Protocol Port 8312

14:50:56 EC4 CFG Log Path: c:\MaovellMMhashlags

14:50:56 EC4 CFE Log to digk: Yes

14:50:56 EC4 CFG Log Level: Mormal

14:50:56 EC4 CFG Log Max Age [in days): 14

14:50:56 EC4 CFG Log kax Size (in ME]: 1

14:50:56 EC4 CFG YWeb Console: Dizabled

14:50:56 EC4 ARC Archive queue initialization. ..

14:50:56 EC4 MTP Meszage Transfer Protocol initialization...

14:50:58 EC4 APL Client/Server initiglization...

14:50:59 E3C TCP Starting MhA4-TCP-LISTEMNER

14:50:59 444 TCP Starting MM&4-TCP-DISPATCHER b?

If you installed the Messenger agents on a NetWare® server, the Archive Agent console appears on
the NetWare server console.

If you installed the Messenger agents on a Linux server, the Archive Agent, by default, runs as a
daemon and has no comparable user interface. However, you can start it in a terminal window so
that status messages are displayed, as described in “Starting the Linux Archive Agent in a Terminal
Window” on page 135, and you can monitor the Archive Agent from your Web browser, as
described in “Using the Archive Agent Web Console and GroupWise Monitor” on page 148.
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The following sections help you start the Archive Agent manually, or automatically whenever the
server restarts:

¢ Section 4.2.1, “Starting the NetWare Archive Agent,” on page 134
¢ Section 4.2.2, “Starting the Linux Archive Agent,” on page 134
¢ Section 4.2.3, “Starting the Windows Archive Agent,” on page 136

¢ Section 4.2.4, “Changing the eDirectory Access Method for Starting the Archive Agent,” on
page 137

4.2.1 Starting the NetWare Archive Agent

The Messenger Installation program creates the nmstart . ncf file in the Messenger agent
installation directory (sys: \novell\nm by default). This file contains lines similar to the
following example:

load sys:\novell\nm\ma\nmma.nlm @sys:\novell\nm\ma\strtup.ma
load sys:\novell\nm\aa\nmaa.nlm @sys:\novell\nm\aa\strtup.aa

If you are running the Archive Agent on a different server from where the Messaging Agent is
running, edit the nmstart.ncf file and comment out the first line so that the Messaging Agent
does not start when the nmstart.ncf file is run.

To start the Archive Agent manually:

1 Enter sys:\novell\nm\nmstart.ncf at the NetWare server console prompt.

The Archive Agent console appears.
To start the Archive Agent automatically when the NetWare server restarts:
1 Add the following line to the autoexec.ncf file in the sys: \system directory:
sys:\novell\nm\nmstart.ncf

If you want to start the Archive Agent in protected mode, you must be using LDAP access to
eDirectory. See “Using LDAP Access for the Archive Agent” on page 138. In addition, when you
stop the Archive Agent agent in protected mode, you must manually unload the address space.

4.2.2 Starting the Linux Archive Agent

You have several alternatives for starting the Archive Agent on Linux:

¢ “Starting the Linux Archive Agent as a Daemon” on page 134
¢ “Starting the Linux Archive Agent in a Terminal Window” on page 135

¢ “Configuring the Linux Archive Agent to Start Automatically as a Startup Service” on
page 135

Starting the Linux Archive Agent as a Daemon

To start the Archive Agent as a daemon, use the startup script provided in the /etc/init.d
directory.

1 At the Linux server, become root by entering su and the root password.
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2 Change to the /etc/init.d directory.
3 To start the Archive Agent, enter the following command:
./novell-nmaa start
You can also use the stop, restart, and status options for these agents from the same directory.

Messenger agent log files are created in the /var/opt/novell/log/messenger
directory. The Messenger agents can be monitored by using the agent Web consoles from your
Web browser, as described in “Using the Messaging Agent Web Console” in “Managing the
Messaging Agent” in the Novell Messenger 2.0 Administration Guide.

Starting the Linux Archive Agent in a Terminal Window

To start the Archive Agent in a terminal window, run the Archive Agent executable.

1 At the Linux server, become root by entering su and the root password.
2 Change to the /opt/novell/messenger/bin directory.
3 To start the Archive Agent, enter the following command:

./nmaa @/etc/opt/novell/messenger/strtup.aa

Agent status information and messages are displayed in the terminal window.

To stop the Archive Agent when it is running in a terminal window, press Ctrl+C and the Archive
Agent performs a normal shutdown.

Configuring the Linux Archive Agent to Start Automatically as a Startup Service
A startup service starts automatically each time the server reboots.

¢ “Configuring the Archive Agent as a Startup Service on SUSE Linux” on page 135

¢ “Configuring the Archive Agent as a Startup Service on Red Hat Linux™ on page 135
Configuring the Archive Agent as a Startup Service on SUSE Linux

1 At the Linux server, become root by entering su and the root password.
2 If eDirectory for Linux is installed, enter the following command:
insserv novell-nmaa

or

If eDirectory for Linux is not installed, use the following command to override the dependency
on the ndsd service:

insserv —-f novell-nmaa

If you later want to remove the Archive Agent as a startup service, enter the following command in
a terminal window:

insserv -r novell-nmaa

Configuring the Archive Agent as a Startup Service on Red Hat Linux

1 At the Linux server, become root by entering su and the root password.

2 Enter the following command:
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chkconfig --add novell-nmaa

If you later want to remove the agents as startup services, enter the following command in a terminal
window:

chkconfig --del novell-nmaa

4.2.3 Starting the Windows Archive Agent

Follow the instructions for the Windows installation option you chose:

+ “Starting the Archive Agent as a Windows Application” on page 136

+ “Starting the Archive Agent as a Windows Service” on page 136

Starting the Archive Agent as a Windows Application
To start the Archive Agent manually:

1 Click Start > Programs > Novell Messenger Agents > Archive Agent.

You might want to create a desktop shortcut for this action.
To start the Archive Agent automatically whenever the server restarts:

1 Click Start > Settings > Taskbar & Start Menu > Advanced > Add.
2 Browse to the directory where you installed the Archive Agent (\novell\nm\aa).
3 Double-click nmaa.exe, then add the startup file (strtup.aa) to the command line.

Example: nmaa.exe @strtup.aa
4 Click Next.
5 Select the Startup folder, provide a name for the shortcut, then click Finish.

Starting the Archive Agent as a Windows Service
To start the Archive Agent manually:

1 Click Start > Settings > Control Panel.
2 Double-click Administrative Tools > Services.

3 Right-click the Novell Messenger Archive Agent service, then click Start.
To start the Archive Agent automatically whenever the server restarts:

Click Start > Settings > Control Panel.

Double-click Administrative Tools > Services.

Right-click the Novell Messenger Archive Agent service, then click Properties.
Set Startup Type to Automatic.

A B WON =

Click OK to save the Windows service startup setting.

If you do not want to run the Messaging Agent along with the Archive Agent, make sure that
the Novell Messenger Messaging Agent service is disabled.
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To start the Archive Agent without a user interface on the Windows server desktop:

Click Start > Settings > Control Panel.
Double-click Administrative Tools > Services.

Right-click the Novell Messenger Archive Agent service, then click Properties.

A WODN =

Click Log On, then deselect Allow Service to Interact with Desktop.

If you suppress the Archive Agent console in this manner, the Archive Agent can still be
monitored from the Archive Agent Web console, as described in “Using the Archive Agent
Web Console and GroupWise Monitor” on page 148.

5 Click OK to save the Windows service logon setting.

4.2.4 Changing the eDirectory Access Method for Starting the
Archive Agent

The Archive Agent cannot start if it cannot read its configuration settings from the Archive Agent
object in Novell® eDirectory. During installation, an eDirectory access method was selected, as
described in “Installing a Novell Messenger System” in the Messenger 2.0 Installation Guide.

Figure 4-1 Directory Access Page in the Messenger Installation Program

Nowvell Messenger Server Setup El
Directory Access
The Movell Meszenger agents can access eDirectory directly or N
thraugh an LDAP server.

Specify how the agents should access the directory,

* Use direct access

7 Use LDAP to access the directarny

Installation Guide 1 < Back i Mext > 1 Cancel 1

The information for that eDirectory access method was stored in the Archive Agent startup file as
settings for the following startup switches:

Table 4-1 Startup Switches Settings

Access Method Startup Switch Description
Use Direct /dirreplicaipaddr ~ Specifies the IP address of the server where the eDirectory replica
Access resides (for direct access on a Linux or Windows server; not

applicable on a NetWare server).

Use LDAP to  /Idapipaddr Specifies the IP address of the LDAP server.
Access the
Directory
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Access Method Startup Switch Description

/Idapport Specifies the port number on which the LDAP server listens for
service requests. Port 636 indicates an SSL connection; port 389
indicates a non-SSL connection.

/Idapssl Indicates whether or not the LDAP server uses an SSL connection,
depending on whether or not you filled in the Root Certificate field.

/Idapsslkey Specifies the full path to the root certificate for the server if SSL is in
use.

To change the eDirectory access method selected during installation, follow the appropriate set of
instructions:

¢ “Using LDAP Access for the Archive Agent” on page 138

+ “Using Direct Access for the Archive Agent” on page 138

Using LDAP Access for the Archive Agent

1 Edit the Archive Agent startup file (strtup.aa).
On Linux, the startup file is located in /etc/opt/novell/messenger.

On Windows, the startup file is located in the Messenger Agent installation directory. You can
edit the startup file from the Messaging Agent console. See “Controlling the Archive Agent
from the Archive Agent Console” on page 147.

2 On Linux and Windows, comment out the /dirreplicaaddr switch.

On a NetWare server, this switch does not apply, because the eDirectory replica resides on the
NetWare server.

3 Scroll down to the bottom of the startup file.

4 Remove the comment character (;) from the /ldap* switches and provide the required LDAP
information.

5 Save the startup file.

6 Stop and then start the Archive Agent so that it reads its updated startup file and uses LDAP
access to eDirectory.

Using Direct Access for the Archive Agent

1 Edit the Archive Agent startup file (strtup.aa).
On Linux, the startup file is located in /etc/opt/novell/messenger.

On Windows, the startup file is located in the Messenger Agent installation directory. You can
edit the startup file from the Messaging Agent console. See “Controlling the Archive Agent
from the Archive Agent Console” on page 147.

2 On a Linux and Windows, remove the comment character (;) from the /dirreplicaaddr switch
and provide the IP address of the eDirectory replica that you want the Archive Agent to access.

On a NetWare server, this switch does not apply, because the eDirectory replica resides on the
NetWare server.

3 Scroll down to the bottom of the startup file.

4 Comment out the /Idap* switches.
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Removing the LDAP information causes the Archive Agent to access the eDirectory replica
directly.

5 Save the startup file.

6 Stop and then start the Archive Agent so that it reads its updated startup file and uses direct
access to eDirectory.

4.3 Enabling Archiving in Your Messenger
System

If you want to archive the conversations of all Messenger users, select Archive Sessions on the
General page of the Default Policy object, as described in “Editing the Default User Policy” on
page 98. After you edit the default policy, you must stop and then start the Messenger agents in order
to put the modified policy into effect throughout your Messenger system. Thereafter, they next time
users log in to the Messenger system, their conversations are archived.

If you want to archive the conversations of some users but not others, you must create a policy that
lists the users whose conversations you want to archive, as described in “Creating a User Policy” on
page 99. You do not need to stop and then start the Messenger agents after creating the new policy.

The next time the users governed by the policy log in to the Messenger system, their conversations

will be archived.

When users' conversations are being archived, the GroupWise® Messenger client displays a page
icon notifying users that their conversations are being logged into the archive.

4.4 Granting Authorized User Access to the
Archive

The Messenger archive is a single archive containing the conversations of all Messenger users for
whom archiving is enabled. Therefore, access to the archive should be granted only to users who can
appropriately view everyone's conversations. Users who can search the Messenger archive must be
added to the Messenger access control list (ACL).

1 In ConsoleOne, browse to and right-click the Messenger Service object, then click Properties.
2 Click Novell Messenger > Archive ACL.

Properties of MessengerService @

lovell essanger ~ | NDS Rights = | Ctner | Rights to Files and Foiders |
Archive ACL
User List
Add
Page Opfions... ( Cancel Help
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3 Click 4dd, then browse to and select those users that you want to grant access to the Messenger
archive.

You can select only User objects. You cannot select container objects, Group objects,
Organizational Role objects, GroupWise Distribution List objects, and so on.

Repeat Step 3 for each context where User objects are located.
Click OK to save the Messenger archive access control list.

Stop and then start the Archive Agent to put the access control list into effect.

N OO g b

Have authorized users log out and back in to the Messenger system in order to add the Search
Archive item on the File menu.

4.5 Configuring the Archive Agent in
ConsoleOne
The advantage to configuring the Archive Agent in ConsoleOne, as opposed to using startup

switches in the Archive Agent startup file, is that the Archive Agent configuration settings are stored
in eDirectory.

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Select the Messenger Server object where the Archive Agent runs.

Mowvell ConsoleQne
File Edit ‘iew Tools Help

Heo|» e

14D) My iorld

=8 NDE

5§ DOCTEST?
-2 corporate
E@ MessengerSerice
ChatContainer
HastCortainer

%4 LDAPContainer

¥4y PolicyCantainer

B [predoctestzSare—
'] ScopeCaontainer
 predoctest2

6@ PRV-DOCTEST2W

<| L AT = I Ty m..~| = T %

szer: adtnin.corporate ITree: DOCTEST2

2] 2|%|8|&[E o] |H]B|6|

3 Right-click the Archive Agent object, then click Properties.

The table below summarizes the Archive Agent configuration settings in the Archive Agent object
property pages and how they correspond to Archive Agent startup switches (as described in
Section 4.13, “Using Archive Agent Startup Switches,” on page 155):

Table 4-2 Archive Agent Configuration Settings

ConsoleOne Properties

Pages and Settings Corresponding Tasks and Startup Switches

Identification Page
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ConsoleOne Properties
Pages and Settings

Corresponding Tasks and Startup Switches

IP Address

DNS Host Name

Bind to This Address
Client/Server Port
Message Transfer Port
Description

General Page

Enable Messenger Services

Enable SNMP

Work Path
Security Page

Certificate Path

SSL Certificate

SSL Key File

Set Password

Enable SSL for Client/Server
Enable SSL for Message
Transfer Protocol

Log Settings Page

Log Level

Enable Disk Logging
Log Files Path

Log Maximum Age
Log Maximum Size

Web Console Page

HTTP Port

HTTP Username

HTTP Password

Enable SSL for Web Console

Performance Page

Maximum Number of Users
Client/Server Threads

Archive Page
Queue Path

Passphrase
Delay
Interval
Expire

Displays the Archive Agent server information established during
installation.

Turns on and turns off the availability of archiving and archive searching
for Messenger users.

See “Using SNMP Monitoring Programs” on page 149,
See also /nosnmp.

See “Moving the Archive Agent Working Directory” on page 151.

See Section 4.6, “Enhancing Archive Security with SSL Encryption,” on
page 142.
See also /certpath, /certfile, /keyfile, /keypassword, and /ssl.

See “Using Archive Agent Log Files” on page 148.
See also /loglevel, /log, /logdays, /logmax, and /logdiskoff.

See “Using the Archive Agent Console on NetWare and Windows” on
page 146.
See also /httpport, /httpuser, /httppassword, and /httpssl.

See Section 4.11, “Optimizing Archive Agent Performance,” on page 149.
See also /maxconns and /threads.

See “Moving the Archive Queue Directories” on page 153.

See also /queue.

See Section 4.1, “Establishing the Master Archive Agent,” on page 131
See Section 4.12.5, “Maintaining the Archive Store,” on page 152
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4.6 Enhancing Archive Security with SSL
Encryption

Messenger archive security is initially established with the archive passphrase, as described in
Section 4.1, “Establishing the Master Archive Agent,” on page 131. The passphrase enables the
Archive Agent to encrypt conversations as they are saved on disk.

Secure Sockets Layer (SSL) ensures secure communication between programs by encrypting the
complete communication flow between the programs. The Messenger Installation program offered
the opportunity to configure the Messenger agents for SSL encryption. If you did not set up SSL
encryption during installation, you can easily do so after installation. You can use the same
procedure for setting up SSL encryption for the Archive Agent as for the Messaging Agent. For
instructions, see Section 2.3, “Establishing Messaging Security with SSL Encryption,” on page 33.

4.7 Changing the Agent User Password

When the Messaging Agent and Archive Agent are installed, the user’s eDirectory password that is
used to read the configuration that starts the agents is stored in the startup file for each agent. Prior to
Messenger 2.0.2 Hot Patch 1, this password was stored in plain text. By default in Messenger 2.0.2
Hot Patch 1, the password is obfuscated to prevent the password from being read.

If you want to check whether the password has been obfuscated, look in the startup files. The
password is prepended with $$: if it has been obfuscated.

The GWMPassword utility is used to change the password in the startup file for both the Messaging
Agent and the Archive Agent.

For additional information on how to use GWMPasword, see Section 2.4, “Changing the Agent
User Password,” on page 35.

4.7.1 Changing the Agent User Password On NetWare or
Windows

Before starting to use the utility, you must verify the following prerequisites:
¢ Ifyou are changing the password on a NetWare server, a drive must be mapped to the location
of the startup file.
¢ Ifyou are using the utility on a workstation and changing the password on a Windows server, a
drive must be mapped to the location of the startup file.

To change the password:

1 In Windows, click Start > Run, then enter cmd to open a command window.
2 Use the following command to change the password:

c:\gwm202\server\utility\gwmpwd\gwmpwd.exe —--startup=<path to
startup file> --password=<new password>

Replace c:\gwm202 with the location that the hot patch files where extracted.
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4.7.2 Changing the Agent User Password on Linux

1 After installing Messenger 2.0.2 Hot Patch 1, change to the /opt/novell/messenger/
bin/ directory.

For complete instructions on installing Messenger 2.0.2 Hot Patch 1, see the Messenger 2.0.2
Readme file located on the GroupWise Messenger 2 Web site (http://www.novell.com/
documentation/nm?2).

2 Become root by entering sux and the root password.

3 Use the following command to change the password:

./gwmpwd --startup=<path to startup file> --password=<new
password>

4.8 Configuring and Indexing the Messenger
Archive

Information about the Messenger archive is stored in the File Module object in the Archive Agent

container.

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Expand the Messenger Server object where the Archive Agent runs, then double-click the
Archive Agent object.

Nowvell ConsoleQne

File Edit “ew Taools Help

HeE ™ 0 e gl 2e|e &l v = B e
15D Wy wiorld ~| | @ FileModule
=g NDS

&

5-4% DOCTEST2

- comporate

=] L4 MessengerSerice

; ChatContainer

HostCaontainer

4 LDAP Container
“3 PolicyContainer

pri-doctest? i

1 items %

pser. admin.corporate

[Tree: DOCTEST2

3 Right-click the File Module object, then click Properties.
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4 Fill in the following fields to configure the Messenger Archive:
Store Path: Specify the full path to the directory where you want the archive created.

By default, the archive is created in the store subdirectory of the Archive Agent installation
directory. You should choose a location that has adequate disk space to store the expected
volume of conversations for the amount of time for which they must be retained. If you need to
move an existing archive to a location where additional disk space is available, see “Moving
the Archive” on page 152.

Maximum File Size: Specify the maximum size of the archive file. The default is 10 MB
compressed.

When an archive file reaches this size, a new archive file is started.
5 Fill in the following fields to configure QuickFinder™ indexing for the archive:

Delay: Specify the number of hours after midnight when you want the Archive Agent to begin
its first indexing cycle for the day. The default is 2 hours after midnight (2:00 a.m.)

Update Interval: Specify the number of hours between indexing cycles. The default is 4
hours. So, by default, the Archive Agent indexes conversations at 2:00 a.m., 6:00 a.m., 10:00
a.m., 2:00 p.m., 6:00 p.m., and 10:00 p.m. Increase the interval to index less frequently;
decrease the interval to index more frequently. One hour is the smallest indexing interval you
can specify.

Compress Interval: Specify the number of hours between index compression cycles. The
default is 24 hours (once a day at the time specified in the Delay field).

6 Click OK to save the archive settings.
7 Stop and then start the Archive Agent to put the settings into effect.

From the Archive Agent console and Web console, you can perform indexing and compression for
the archive at any time. See “Controlling the Archive Agent from the Archive Agent Console” on
page 147 and “Using the Archive Agent Web Console and GroupWise Monitor” on page 148.
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4.9 Establishing Archive Maintenance

The Messenger archive is stored in a database format that requires occasional maintenance:

¢ Section 4.9.1, “Expiring Old Conversations,” on page 145

¢ Section 4.9.2, “Repairing the Archive,” on page 146

4.9.1 Expiring Old Conversations

It might not be practical to store all conversations indefinitely. Establishing archive maintenance
procedures keeps your archive current and eliminates obsolete conversations.

1 In ConsoleOne, browse to and right-click the Messenger Service object.

2 Click Properties > Novell Messenger > Archive.

Properties of MessengerService

Hlovell Miessenger | NDS Rights = | Ctner | Rights to Files and Folders |
Archive

Master Archive Agent

|Archivesgert prv-doctest2Server MessengerService corporate

2]

Passphrase: [Ret BB039GTIZIBS 1917431 K3622UTH
Session Timeaut (minutes); [ & -3

Stare Maintenance

Delay thowsy: [ 23

htervalthowrsy [ 4 -3

Excpire (days) ligo:ﬂ

Page Options...

Cancel

Help

3 Fill in the following fields to control when the Archive Agent performs maintenance on the
archive, including when old conversations are expired and deleted from the Messenger archive

and when the expiration process takes place.

Delay: Specify the number of hours after midnight when you want the Archive Agent to
perform maintenance. The default is 2 hours after midnight (2:00 a.m.)

Interval: Specify how often to perform maintenance. The default is 4 hours.

Expire: Specify the number of days you want to keep conversations in the archive. The default
is 90 days. Specify 0 (zero) to disable expiration and retain all conversations indefinitely.

4 Click OK to save the archive maintenance settings.

5 Stop and then start the Archive Agent to put the maintenance settings into effect.

When the Archive Agent expires conversations, it does not reduce the physical size of the
Messenger archive. However, the archive does not grow again until the space reclaimed by expiring

conversations has been filled.
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4.9.2 Repairing the Archive

If the Messenger archive is damaged for any reason, you can repair it at the Archive Agent console
and Web console. For instructions, see “Controlling the Archive Agent from the Archive Agent
Console” on page 147 and “Using the Archive Agent Web Console and GroupWise Monitor” on
page 148.

4.10 Monitoring the Archive Agent

By monitoring the Archive Agent, you can determine whether or not its current configuration is
meeting the archiving and indexing needs being placed upon it. You have a variety of tools to help
you monitor the operation of the Archive Agent:

¢ Section 4.10.1, “Using the Archive Agent Console on NetWare and Windows,” on page 146
¢ Section 4.10.2, “Using the Archive Agent Web Console and GroupWise Monitor,” on page 148

*

Section 4.10.3, “Using Archive Agent Log Files,” on page 148

*

Section 4.10.4, “Using Novell 6.5 Remote Manager,” on page 149

*

Section 4.10.5, “Using SNMP Monitoring Programs,” on page 149

4.10.1 Using the Archive Agent Console on NetWare and
Windows

The following topics help you use the Archive Agent console on NetWare and Windows:

+ “Monitoring the Archive Agent from the Archive Agent Console” on page 146
¢ “Controlling the Archive Agent from the Archive Agent Console” on page 147

NOTE: The Archive Agent console is not available on Linux. Use the Web console instead, as
described in “Using the Archive Agent Web Console and GroupWise Monitor” on page 148.

Monitoring the Archive Agent from the Archive Agent Console

The Archive Agent console provides information, status, and statistics about the Archive Agent to
help you assess its current functioning.
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Figure 4-2 Archive Agent Console
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The Archive Agent console includes several areas of information:

Table 4-3 Archive Agent Console

Information Description

Information Box  Identifies the Archive Agent, displays description information provided in ConsoleOne,

and shows how long the Archive Agent has been running.

Status Box Displays the number of current users who are searching the archive and the number
of conversations that are queued for archiving. The rotating processing bar shows that

the Archive Agent is running.

Statistics Box Displays the number of requests that the Archive Agent has received from client users
who are searching the archive or from the Messaging Agent, along with the number of
requests that it has been unable to respond to. Pending requests might indicate a
need to optimize Archive Agent performance so that it can keep up with the demands

being placed upon it.

Log Message Box Displays the same information that is being written to the Archive Agent log file. The
amount of information displayed depends on the current log settings for the Archive
Agent. See “Using Archive Agent Log Files” on page 148. The information scrolls up

automatically.

Controlling the Archive Agent from the Archive Agent Console

You can perform the following tasks to monitor and control the Archive Agent from the Archive

Agent console at the Messenger server:

Table 4-4 Archive Agent Keyboard Shortcuts

Task NetWare

Stop the Archive Agent F7
Edit the startup file

F10 > Edit Startup File

Configuration > Edit Startup File
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Task NetWare Windows

Display current agent N/A Configuration > Agent Settings

settings

Display the current log file F9 Log > Auto Scroll Off > scroll as needed

Display a selected log file

Change log settings for the
current agent session

Start a new log file

Index the archive

Compress the archive
indexes

Perform maintenance on the

F10 > View Log Files

F10 > Logging Options

F10 > Cycle Log

F10 > Actions > Update
Indexes

F10 > Actions > Compress
Indexes

F10 > Actions > Verify and

Log > View Log
Log > Log Settings

Log > Cycle Log

Actions > Update Indexes

Actions > Compress Indexes

Actions > Verify and Repair Archive

archive Repair Archive

Display online help F1 Help > Help

4.10.2 Using the Archive Agent Web Console and GroupWise
Monitor

The Archive Agent Web console enables you to monitor and control the Archive Agent from any
location where you have access to a Web browser and the Internet. This provides substantially more
flexible access than the Archive Agent console, which can only be accessed from the server where
the Archive Agent is running.

You can use the same procedure to set up the Archive Agent Web console as the Messaging Agent
Web console. For instructions, see “Using the Messaging Agent Web Console” on page 38. In
addition, you can compress the archive indexes and perform maintenance on the archive from the
Web console.

As with the Messaging Agent, you can access the Archive Agent Web console from GroupWise
Monitor. For setup and usage instructions, “Using GroupWise Monitor” on page 47.

4.10.3 Using Archive Agent Log Files

Error messages and other information about the Archive Agent are written to log files as well as
displaying on the Archive Agent console. Log files can provide a wealth of information for
resolving problems with Archive Agent functioning. On NetWare and Windows, the default location
for log files is the 1ogs subdirectory of the Archive Agent installation directory. On Linux, the
default location is /var/opt/novell/log/messenger/aa.

You can use the same procedure for Archive Agent log files as for Messaging Agent log files. For
instructions, see “Using Messaging Agent Log Files” on page 45.
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4.10.4 Using Novell 6.5 Remote Manager

If the Archive Agent is running on a NetWare 6.5 server, you can use the IP Address Management
feature in Novell Remote Manager (NetWare Remote Manager > Manage Server > IP Address
Management) to view the IP address and port configuration for the Archive Agent. This is also true
for the Messenger Agent running on a NetWare 6.5 server.

You access Novell Remote Manager by entering the following URL in a Web browser:
http://server_address:8008

For example:

http://137.65.123.11:8008

For more information about using Novell Remote Manager, see the NetWare 6.5 documentation
(http://www.novell.com/documentation/nw65).

4.10.5 Using SNMP Monitoring Programs

You can monitor the Archive Agent from the Management and Monitoring component of Novell
ZENworks® for Servers, ManageWise®, or any other SNMP management and monitoring program.
When properly configured, the Archive Agent sends SNMP traps to network management consoles
for display along with other SNMP monitored programs. It also responds to requests for
configuration and status information from SNMP management and monitoring programs.

You can use the same procedure for setting up the Archive Agent as for the Messaging Agent. For
instructions, see “Using SNMP Monitoring Programs” on page 48.

4.11 Optimizing Archive Agent Performance

You can adjust how the Archive Agent functions to optimize its performance. Before attempting
optimization, you should run the Archive Agent long enough to observe its efficiency and its impact
on other network applications running on the same server. See Section 4.10, “Monitoring the
Archive Agent,” on page 146.

Also, remember that optimizing your network hardware and operating system can make a difference
in Archive Agent performance.

¢ Section 4.11.1, “Optimizing Connections between the Archive Agent and Messenger Users,”
on page 149

¢ Section 4.11.2, “Optimizing the Connection between the Archive Agent and the Messaging
Agent,” on page 150

4.11.1 Optimizing Connections between the Archive Agent and
Messenger Users

1 In ConsoleOne, browse to and expand the MessengerService object.
2 Select the Messenger Server object.

3 Right-click the Archive Agent object, then click Properties.

4 Click Agent > Performance.
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Properties of ArchiveAgent @

Agent "~ | NDS Rigrts + | Other | Rights to Files and Folders |
Rerformance
Maximum number of users 5120 ::4
CliertiServer threads 15 ::j
Page Options... Cancel Help

5 Fill in the following fields to configure how the Archive Agent communicates with Messenger
users:

Maximum Number of Users: Specify the maximum number of Messenger users that you
want the Archive Agent to be able to search the archive for at once. The default is 5120, which
should be adequate for a very large Messenger system.

Client/Server Threads: Specify the number of client/server threads that you want the Archive
Agent to start. The Archive Agent uses its client/server threads to search the archive for
Messenger users, to communicate with the Messaging Agent in order to receive conversations
to archive, and to maintain and index the archive.

The default number of client/server threads is 15. For a large Messenger system with archiving
enabled for all users, you could increase the number to 50 or more, depending on the system
resources of the server where the Archive Agent is running.

6 Click OK to save the Archive Agent performance settings.
7 Stop and then start the Messaging Agent to put the new performance settings into effect.
Corresponding Startup Switches:

You can also use the /maxconns and /threads startup switches in the Archive Agent startup file to
configure Archive Agent performance.

4.11.2 Optimizing the Connection between the Archive Agent
and the Messaging Agent

By default, the Messaging Agent waits 5 seconds for a response when trying to contact the Archive
Agent. If no response is received from the Archive Agent, the Messaging Agent tries again three
more times. If all four attempts fail, the Messaging Agent reports an error, then waits 10 minutes
before it tries again.

When the Messaging Agent attempts to send conversations to the Archive Agent, the Messaging
Agent tries for 20 seconds before reporting an error.

On some networks, these wait intervals might not be sufficient when the Messaging Agent and the
Archive Agent are running on different servers. As a result, the Messaging Agent might report an
error when, by waiting longer, the needed connection or data transfer can take place.
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Use the /mtpconnecttimeout switch in the Messaging Agent startup file to increase the number of
seconds the Messaging Agent waits for a response from the Archive Agent before reporting an error.

Use the /mtpdatatimeout switch in the Messaging Agent startup file to increase the number of
seconds the Messaging Agent attempts to send conversations to the Archive Agent before reporting
an error.

4.12 Managing the Archive Server

As your Messenger system grows and evolves, you might need to reconfigure the server where the
Archive Agent runs or move Archive Agent directories to different locations.

¢ Section 4.12.1, “Binding the Archive Agent to a Specific [P Address,” on page 151

¢ Section 4.12.2, “Changing the Archive Server's IP Address or DNS Host Name,” on page 151

¢ Section 4.12.3, “Moving the Archive Agent Working Directory,” on page 151

¢ Section 4.12.4, “Moving the Archive,” on page 152

¢ Section 4.12.5, “Maintaining the Archive Store,” on page 152

¢ Section 4.12.6, “Moving the Archive Queue Directories,” on page 153

4.12.1 Binding the Archive Agent to a Specific IP Address

On a server with multiple IP addresses, the Archive Agent binds to all available IP addresses and
Messenger clients can communicate with the Archive Agent on all available IP addresses unless you
bind it to a specific address.

You can use the same procedure to bind the Archive Agent as Messaging Agent. See “Binding the
Messaging Agent to a Specific IP Address” on page 54

4.12.2 Changing the Archive Server's IP Address or DNS Host
Name

If you change the IP address or DNS hostname of the server where the Archive Agent is running,
you must update the server information for your Messenger system as well.

You can use the same procedure for the Archive Agent as for the Messaging Agent. See “Changing

the Messaging Server's Network Address” on page 55.

4.12.3 Moving the Archive Agent Working Directory

The Archive Agent uses its working directory for saving various temporary files during archiving
and indexing. By default, the Archive Agent and the Messaging Agent share the same working
directory if they are running on the same server.

You can use the same procedure to move the Archive Agent working directory as to move the
Messaging Agent working directory. See “Moving the Messaging Agent Working Directory” on
page 56.
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4.12.4 Moving the Archive

Depending on the volume of conversations to archive and the length of time conversations must be
retained, the Messenger archive can grow to be quite large. On NetWare and Windows, the default
location for the archive is \novell\nm\aa\store. On Linux, the defaultis /var/opt/
novell/messenger/aa/store. If necessary, you can move it to a different location where
more disk space is available. However, the archive must reside on the same server where the
Archive Agent runs.

Stop the Archive Agent.
Copy the Messenger archive (store directory) to the desired location.

In ConsoleOne, browse to and expand the Messenger Service object.

A OWON -

Expand the Messenger Server object where the Archive Agent runs, then double-click the
Archive Agent object.

5 Right-click the File Module object, then click Properties.

Praperties of FileModule El

iaduie NDS Rights v | Other | Rights to Files and Folders |

Store Seftings |

Store path: [var optinavelies sengerfaistors Jical|
Masimu tile size (MB) =

GuickFinder Maintenance

Delay (hours) [ =%

Undte interval (hours), =

Compress interval (hours) 24 ::‘

Page Options | cancel | | e |

In the Store Path field, browse to and select the new location of the Messenger archive.
Click OK to save the new archive location.

Start the Archive Agent.

© 0 N O

Delete and regenerate the archive indexes from the Archive Agent console. See “Controlling
the Archive Agent from the Archive Agent Console” on page 147.

4.12.5 Maintaining the Archive Store

When messages are added to the archive store, they are not immediately indexed. Before a user can
search for a message in the archive, it must be indexed. You can set when the store starts indexing,
the interval time between indexing, and how long a message should be kept in the archive.

1 Stop the Archive Agent.

2 In ConsoleOne, browse to and expand the Messenger Service object.

3 Expand the Messenger Server object where the Archive Agent runs, then double-click the
Archive Agent object.
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4 Right-click the File Module object, then click Properties.

Praperties of FileModule §|
Moduie ™ }| NDS Rigtts = | Other | Rights to Files and Folders: |
Store Setings |
Store path: [earioptinovalinessenaer faistore =

Mendmum file size (MB) ]—mil
GuickFinder Maintenance
Delay (hours) |72::‘
Undiate interval chours): |74::‘
Compress interval thours), |724::‘

Page Options ‘ Cancel | Help |

5 Inthe Delay field, select the number of hours to wait until the first index is created, based upon
how many hours after 12 A.M.

6 In the Update interval field, select the number of hours to wait between indexings.
7 In the Compress interval field, select the number of hours between QuickFinder compression.
8 Click OK to save the new archive location.

9 Start the Archive Agent.

4.12.6 Moving the Archive Queue Directories

When archiving is enabled, the Messaging Agent passes conversations to the Archive Agent when
the conversations are completed. If the Messaging Agent cannot communicate with the Archive
Agent when it has a conversation to archive, it saves the conversation in its holding directory
(queue) until it can communicate with the Archive Agent again. When the Archive Agent receives a
conversation to archive, if it is already busy processing other conversations, it temporarily stores the
conversation in its holding directory (queue). Either of these holding queues can be moved if
necessary.

+ “Moving the Messaging Agent Conversation Holding Queue” on page 153

+ “Moving the Archive Agent Conversation Holding Queue” on page 154

Moving the Messaging Agent Conversation Holding Queue

On NetWare and Windows, the default location for the Messaging Agent holding queue is
\novell\nm\ma\queue. On Linux, the default location is /var/opt/novell/
messenger/ma/queue.

To move the Messaging Agent queue:

1 Stop the Messaging Agent.

2 Ifthere are conversations waiting to be passed to the Archive Agent, copy the Messaging Agent
queue directory and its contents to the desired location.

3 In ConsoleOne, browse to and expand the Messenger Service object.
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4 Sclect the Messenger Server object.
5 Right-click the Messaging Agent object, then click Properties.
6 Click Agent > Messaging.

Properties of MessagingAgent El
%] NDS Rights = | ther | Rights to Files and Folders |
Messaging Queus Path: | Warioptinovelimessengeralgueue il
[# Enable cliert downinad through & browser
Page Options 1 Cancel ] l Help ]

7 In the Messaging Queue Path field, browse to and select the new location of the Messaging
Agent queue.

8 Click OK to save the new location.

9 Start the Messaging Agent.

Moving the Archive Agent Conversation Holding Queue

On NetWare and Windows, the default location for the Archive Agent holding queue is
\novell\nm\aa\queue. On Linux, the default locationis /var/opt/novell/
messenger/aa/queue.

1 Stop the Archive Agent.

While the Archive Agent is stopped, the Messaging Agent is storing conversations to archive in
its holding queue.

2 If there are conversations waiting to be archived in the Archive Agent holding queue, copy the
Archive Agent queue directory and its contents to the new location.

In ConsoleOne, browse to and expand the Messenger Service object.
Select the Messenger Server object.

Right-click the Archive Agent object, then click Properties.

Click Agent > Archive.

o a A~ W
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Praperties of FileModule El
NDS Rights v | Other | Rights to Files and Folders |

Hoduie
Store: Settings |

Store pathc [varioptinavelimessengeriamistore el
Masdmun tile size (M), =

QuickFinder Mairtenance

Delay (hours} [ =%

Upclate interval (hours) 1 ::‘

Conipress irterval (hours): l—ij

Page Options... Cancel Help

7 In the Queue Path field, browse to and select the new location of the Archive Agent holding
queue.

8 Click OK to save the new location.
9 Start the Archive Agent.

4.13 Using Archive Agent Startup Switches

You can override settings provided in ConsoleOne by using startup switches in the Archive Agent
startup file (strtup.aa). On NetWare and Windows, the startup file is located in the Messenger
Agent installation directory. On Linux, the startup file is located in /etc/opt/novell/
messenger.You can override startup switches provided in the startup file by using startup
switches on the command line. For more information about starting the Archive Agent, see
Section 4.2, “Starting the Archive Agent,” on page 133.

This section contains information on the following Archive Agent startup switches:

¢ Section 4.13.1, “/certfile,” on page 158

¢ Section 4.13.2, “/certpath,” on page 158

¢ Section 4.13.3, “/cluster (NetWare only),” on page 159
¢ Section 4.13.4, “/dirdefaultconnections,” on page 159
¢ Section 4.13.5, “/diridletimeout,” on page 159

¢ Section 4.13.6, “/dirmaxconnections,” on page 160

¢ Section 4.13.7, “/dirpoolresettime,” on page 160

¢ Section 4.13.8, “/dirquerymaxresults,” on page 160

¢ Section 4.13.9, “/dirreplicaipaddr (Linux and Windows only),” on page 160
¢ Section 4.13.10, “/diruseralias,” on page 161

¢ Section 4.13.11, “/diruserauthbind,” on page 161

¢ Section 4.13.12, “/diruserforcedirect,” on page 161

+ Section 4.13.13, “/home,” on page 161

¢ Section 4.13.14, “/httppassword,” on page 162
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¢ Section 4.13.15, “/httpport,” on page 162
¢ Section 4.13.16, “/httpssl,” on page 162
¢ Section 4.13.17, “/httpuser,” on page 163
¢ Section 4.13.18, “/ip,” on page 163
¢ Section 4.13.19, “/keyfile,” on page 163
¢ Section 4.13.20, “/keypassword,” on page 164
¢ Section 4.13.21, “/language (Windows only),” on page 164
¢ Section 4.13.22, “/Idapipaddr,” on page 165
¢ Section 4.13.23, “/ldapport,” on page 165
¢ Section 4.13.24, “/ldappwd,” on page 165
¢ Section 4.13.25, “/Idapssl,” on page 166
¢ Section 4.13.26, “/Idapsslkey,” on page 166
¢ Section 4.13.27, “/lIdapuser,” on page 166
¢ Section 4.13.28, “/log,” on page 167
¢ Section 4.13.29, “/logdays,” on page 167
¢ Section 4.13.30, “/logdiskoft,” on page 167
¢ Section 4.13.31, “/loglevel,” on page 167
¢ Section 4.13.32, “/logmax,” on page 168
¢ Section 4.13.33, “/maxconns,” on page 168
¢ Section 4.13.34, “/mtpipaddr,” on page 168
¢ Section 4.13.35, “/mtpport,” on page 169
¢ Section 4.13.36, “/mtpssl,” on page 169
¢ Section 4.13.37, “/nomtp,” on page 169
¢ Section 4.13.38, “/nosnmp,” on page 169
¢ Section 4.13.39, “/password,” on page 169
¢ Section 4.13.40, “/port,” on page 170
¢ Section 4.13.41, “/queue,” on page 170
¢ Section 4.13.42, “/ssl,” on page 170
¢ Section 4.13.43, “/threads,” on page 171
¢ Section 4.13.44, “/user,” on page 171
The table below summarizes the Archive Agent startup switches and how they correspond to

configuration settings in ConsoleOne. These startup switches must begin with a dash (-) when used
in the Cross-Platform client.

Table 4-5 Archive Agent Startup Switches

NetWare Archive . . Windows Archive .
Agent Linux Archive Agent Agent ConsoleOne Setting
[certfile --certfile [certfile SSL Certificate

156 Novell Messenger 2.0 Administration Guide



NetWare Archive Linux Archive Agent

Windows Archive

ConsoleOne Setting

Agent Agent
/certpath --certpath [certpath Certificate Path
/cluster N/A N/A N/A

/ -
dirdefaultconnectio dirdefaultconnection

ns S
/diridletimeout --diridletimeout

/dirmaxconnections --
dirmaxconnections

/dirpoolresettime --dirpoolresettime

/dirqguerymaxresults -

dirquerymaxresults
/dirreplicaipaddr --dirreplicaipaddr
[diruseralias --diruseralias
/diruserauthbind --diruserauthbind

/diruserforcedirect  --diruserforcedirect

/home --home
/httppassword --httppassword
/httpport --httpport
/httpuser --httpuser
/httpssl --httpssl

lip -ip

/keyfile --keyfile
/keypassword --keypassword
/language --language
/Idapipaddr --ldapipaddr
/ldapport --ldapport
/ldappwd --ldappwd
/Idapssl --ldapssl
/Idapsslkey --ldapsslkey
/ldapuser --ldapuser

/log --log

/logdays --logdays
Nlogdiskoff --logdiskoff

/

dirdefaultconnection

S

/diridletimeout

/dirmaxconnections

/dirpoolresettime

/dirquerymaxresults

/dirreplicaipaddr
/diruseralias
/diruserauthbind

/diruserforcedirect

/home

/httppassword

/httpport
/httpuser
/httpssl

lip

/keyfile

/keypassword

/language
/ldapipaddr
/ldapport
/ldappwd
/Idapssl
/Idapsslkey
/ldapuser
/log
/logdays
/logdiskoff

Default Number of Connections (LDAP
profile)

Idle Timeout (LDAP profile)

Maximum Number of Connections
(LDAP profile)

N/A

Maximum Query Results

N/A

N/A

N/A

N/A

N/A

HTTP Password

HTTP Port

HTTP Username

Enable SSL for Web Console

Host IP Address with Bind to this
Address selected

SSL Key File

SSL Set Password

N/A

LDAP Connection IP Address
LDAP Connection Port

LDAP Profile Set Password
LDAP Connection SSL Enabled
LDAP Connection Root Certificate
LDAP Profile Username

Log Files Path

Log Maximum Age

Enable Disk Logging
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NetWare Archive

Linux Archive Agent

Windows Archive

ConsoleOne Setting

Agent Agent

/loglevel --loglevel lloglevel Log Level

/logmax --logmax /logmax Log Maximum Size

/maxconns --maxconns /maxconns Maximum Number of Users

/mtpipaddr --mtpipaddr /mtpipaddr Host Address

/mtpport --mtpport /mtpport Message Transfer Port

/mtpssl --mtpssl /mtpssl Enable SSL for Message Transfer
Protocol

/nomtp --nomtp /nomtp N/A

/nosnmp --nosnmp /nosnmp Enable SNMP

/password --password /password Set Password

/port --port /port Client/Server Port

/queue --queue /queue Messaging Queue Path

/ssl --ssl /ssl Enable SSL for Client/Server

/threads --threads /threads Client/Server Threads

user --user user Username

4.13.1 /certfile

Specifies the full path to the public certificate file used to provide secure SSL communication

between the Archive Agent and other programs. See Section 4.6, “Enhancing Archive Security with

SSL Encryption,” on page 142.

NetWare Archive Agent

Linux Archive
Agent

Windows Archive Agent

Syntax: [certfile-[svA][vol:]\din\file
[certfile-\\svAvoldinfile
Example: /certfile-\novel\nm\ma\certs\nm.crt

[certfile-
svr2\sys:\novell\nm\ma\certs\nm.crt
[cerftfile-
\\svr2\sys\novell\nm\ma\certs\nm.crt

--certfile /dir/file

--certfile /certs/
gw.crt

[certfile-[drive:]\dinfile
[certfile-\\svAsharename\din\file

[certfile-
\novel\nm\ma\certs\nm.crt
[certfile-
m:\novell\nm\ma\certs\nm.crt
[certfile-
\\s2\c\novell\nm\ma\certs\nm.crt

See also /certpath, /keyfile, and /keypassword.

4.13.2 /certpath

Specifies the full path to the directory where public certificate files are stored on your system. See
Section 4.6, “Enhancing Archive Security with SSL Encryption,” on page 142.
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Linux Archive

NetWare Archive Agent Windows Archive Agent

Agent
Syntax: [certpath-[svA][vol:]\dir/certpath- --certpath /dir [certpath-[drive:]\dir
\\svAvoldir [/certpath-\\svAsharename\dir
Example: /certpath-\novel\nm\aa\certs --certpath /certs /certpath-\novell\nm\aa\certs
[certpath-svr2\sys:\novell\nm\aa\certs [/certpath-m:\novel\nm\aa\certs
[certpath- [certpath-
\\svr2\sys\novell\nm\aa\certs \\svr2\c\novell\nm\aa\certs

See also /certfile, /keyfile, and /keypassword.

4.13.3 /cluster (NetWare only)

Informs the Archive Agent that it is running in a clustering environment. The issues are the same as
for the Messaging Agent. See “Implementing Messenger in a NetWare Cluster” in “Novell Cluster
Services on NetWare” in the GroupWise 8 Interoperability Guide.

If you are running the Archive Agent on the latest version of NetWare 6.x and Novell Cluster
Services™, the Archive Agent can detect the cluster automatically.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /cluster N/A N/A

See also /ip.

4.13.4 /dirdefaultconnections

Specifies the minimum number of direct access connections you want open at all times between the
Archive Agent and eDirectory. The default is 10 connections.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /dirdefaultconnections- --dirdefaultconnections /dirdefaultconnections-number
number number
Example: /dirdefaultconnections-20 --dirdefaultconnections 30  /dirdefaultconnections-50

See also /diridletimeout and /dirmaxconnections.

4.13.5 /diridletimeout

Specifies the number of seconds after which idle direct access connections in excess of the default
number of connections are closed. The default is 30 seconds

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /diridletimeout-seconds --diridletimeout seconds /diridletimeout-seconds
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NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Example: /diridletimeout-20 --diridletimeout 60 /diridletimeout-90

See also /dirdefaultconnections.

4.13.6 /dirmaxconnections

Specifies the maximum number of direct access connections you want open between the Archive
Agent and eDirectory. The default is 50 connections.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /dirmaxconnections-number --dirmaxconnections number [/dirmaxconnections-number

Example: /dirmaxconnections-200 --dirmaxconnections 150 /dirmaxconnections-100

See also /dirdefaultconnections.

4.13.7 /dirpoolresettime

Specifies the number of minutes between the time when the Archive Agent receives an error
response from a pooled LDAP server and the time when that LDAP server is reinstated into the pool
of available LDAP servers. The default is 5 minutes. See “Providing LDAP Access to eDirectory for
Messenger Users” on page 81.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax:  /dirpoolresettime-minutes --dirpoolresettime-minutes  /dirpoolresettime-minutes
Example: /dirpoolresettime-10 --dirpoolresettime-15 /dirpoolresettime-20

4.13.8 /dirquerymaxresults

Specifies the maximum number of query results you want the Archive Agent to return to users in the
Messenger client. The default maximum is 100 contacts.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /dirquerymanxresults-results --dirquerymaxresults results  /dirquerymaxresults-results
Example: /dirquerymaxresults-50 --dirquerymaxresults 150 /dirqguerymaxresults-200

4.13.9 /dirreplicaipaddr (Linux and Windows only)

Specifies the IP address of an eDirectory replica for an Archive Agent that is running on a Windows
server. See “Changing the eDirectory Access Method for Starting the Archive Agent” on page 137.
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NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: N/A --dirreplicaipaddr /IP_address [dirreplicaipaddr-/IP_address
Example: N/A --dirreplicaipaddr 173.16.5.18 [dirreplicaipaddr-173.16.5.19

4.13.10 /diruseralias

Specifies the eDirectory attribute that the Archive Agent searches on for users in the Messenger
client. By default, the Archive Agent searches on the CN attribute. If you use this startup switch for
the Messaging Agent, as described in “Customizing Authentication and Searches by eDirectory
Attribute” on page 91, you should use it for the Archive Agent as well, to keep searching
functionality consistent.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /diruseralias- --diruseralias /diruseralias-
"eDirectory_attribute" "eDirectory_attribute" "eDirectory_attribute"
Example: /diruseralias-"Internet EMail  --diruseralias "Internet EMail  /diruseralias-"Internet EMail
Address" Address" Address"

4.13.11 /diruserauthbind

Indicates that you want users to authenticate to eDirectory by using a bind rather than a compare
operation.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /diruserauthbind --diruserauthbind /diruserauthbind

4.13.12 /diruserforcedirect

Indicates that you want users to use direct access to eDirectory even though you have configured the
Archive Agent to use LDAP access. See “Using LDAP Access for the Archive Agent” on page 138.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /diruserforcedirect --diruserforcedirect /diruserforcedirect

4.13.13 /home

Specifies the distinguished name (DN) of the Archive Agent object where the Archive Agent
configuration information is stored. There is no default location. You must use this switch in order to
start the Messaging Agent. See Section 4.2, “Starting the Archive Agent,” on page 133.
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NetWare Archive Agent

Linux Archive Agent

Windows Archive Agent

Syntax: /home-CN=agent_object, --home CN=agent_object, /home-CN=agent_object,
OU=server_object, OUs=server_object, OU=server_object,
OU=Messenger_system, OU=Messenger_system, OU=Messenger_system,
O=organization O=organization O=organization

Example: /home-CN=ArchiveAgent, --home CN=ArchiveAgent, /home-CN=ArchiveAgent,

OU=PRV-GWSERVER,
OU=MessengerService,
O=Novell

OU=PRV-GWSERVER,
OU=MessengerService,
O=Novell

OU=PRV-GWSERVER,
OU=MessengerService,
O=Novell

IMPORTANT: Use commas, rather than periods, between object names. If any object name
includes a space, surround the switch value with double quotation marks.

4.13.14 /httppassword

Specifies the password for the Archive Agent to prompt for before allowing Archive Agent status
information to be displayed in your Web browser. Unless you are using SSL encryption, do not use
an existing eDirectory password because the information passes over the connection between your
Web browser and the Archive Agent. See “Using the Archive Agent Web Console and GroupWise
Monitor” on page 148.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /httppassword-

unique_password

--httppassword
unique_password

/httppassword-
unique_password

Example: /httppassword-AgentWatch --httppassword AgentWatch /httppassword-AgentWatch

See also /httpuser.

4.13.15 /httpport

Sets the HTTP port number used for the Archive Agent to communicate with your Web browser.
The setting must be unique on the server where the Archive Agent runs. See “Using the Archive
Agent Web Console and GroupWise Monitor” on page 148.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /httpport-port_number --httpport port_number /httpport-port_number

Example: /httpport-8313 --httpport 8314 /httpport-8315

4.13.16 /httpssl

Sets the availability of SSL encryption between the Archive Agent and the Web console displayed in
your Web browser. Valid values are enable and disable. See “Using the Archive Agent Web Console
and GroupWise Monitor” on page 148.
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NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /httpssl-setting --httpssl setting /httpssl-setting

Example: /httpssl-enable --httpssl enable /httpssl-enable

4.13.17 /httpuser

Specifies the username for the Archive Agent to prompt for before allowing Archive Agent status
information to be displayed in a Web browser. Providing a username is optional. Unless you are
using SSL encryption, do not use an existing eDirectory username because the information passes
over the connection between your Web browser and the Archive Agent. See “Using the Archive
Agent Web Console and GroupWise Monitor” on page 148.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /httpuser-unique_username --httpuser unique_username /httpuser-unique_username

Exampl /httpuser-NMWebConsole --httpuser NMWebConsole  /httpuser-NMWebConsole
e:

See also /httppassword.

4.13.18 fip

Binds the Archive Agent to a specific IP address when the server where it runs uses multiple IP
addresses, such as in a clustering environment. Without the /ip switch, the Archive Agent binds to
all available IP addresses and Messenger clients can communicate with the Messaging Agent on all
available IP addresses.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: lip-IP_address --ip IP_address lip-IP_address
Example: /ip-172.16.5.18 --ip 172.16.5.19 /ip-172.16.5.20

See also /cluster.

4.13.19 /keyfile

Specifies the full path to the private file used to provide SSL encryption between the Archive Agent
and other programs. See Section 4.6, “Enhancing Archive Security with SSL Encryption,” on
page 142.

Linux Archive

NetWare Archive Agent Agent

Windows Archive Agent

Syntax: /keyfile-[svA][vol:\dinfile --keyfile /dirlfile  Ikeyfile-[drive:]\dinfile
/keyfile-\\svAvoldifile /keyfile-\\svAsharename\din\file
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Linux Archive

NetWare Archive Agent Windows Archive Agent

Agent
Example: /keyfile- --keyfile /certs/ /keyfile-\novell\nm\ma\certs\nm.key
\novell\nm\ma\certs\nm.key gw.key /keyfile-
/keyfile- m:\novell\nm\ma\certs\nm.key
svr2\sys:\novell\nm\ma\certs\nm.k /keyfile-
ey \\svr2\c\novel\nm\ma\certs\nm.key
/keyfile-
\\svr2\sys\novell\nm\ma\certs\nm.k
ey

See also /keypassword.

4.13.20 /keypassword

Specifies the password used to encrypt the private SSL key file when it was created. See Section 4.6,
“Enhancing Archive Security with SSL Encryption,” on page 142.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /keypassword-password --keypassword password /keypassword-password
Example: /keypassword-gwssl --keypassword gwssl| /keypassword-gwssl|
See also /keyfile.

4.13.21 /language (Windows only)

Specifies the language to run the Archive Agent in, using a two-letter language code as listed below.
When you install the Messenger agents, all language versions are automatically installed.

The initial default is the language used by the operating system. If that language is not available, the
Archive Agent runs in English. You only need to use this switch if you need to override these

defaults.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: N/A N/A /language-code
Example: N/A N/A /language-fr

The table below lists the valid language codes:

Language Language Code
English EN
French FR
German DE
Portuguese PT
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Language Language Code

Spanish ES

4.13.22 /Idapipaddr

Specifies the LDAP server's network address as either an IP address or a DNS hostname. You can
specify multiple network addresses to provide failover capabilities for your LDAP servers. See
Section 3.2, “Customizing eDirectory Access for Users,” on page 80.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /ldapipaddr-network_address  --ldapipaddr /Idapipaddr-
network_address network_address
Example: /Idapipaddr-172.16.5.18 --ldapipaddr 172.16.5.19 /Idapipaddr-172.16.5.20
/lIdapipaddr-server1 server2 --ldapipaddr server1 server2 /Idapipaddr-server1 server2

If you specify multiple LDAP servers, use a space between each address. When so configured, the
Archive Agent tries to contact the first LDAP server in order to access eDirectory. If that LDAP
server is down, the Archive Agent tries the next LDAP server in the list, and so on until it is able to
access eDirectory.

See also /ldapport.

4.13.23 /Idapport

Specifies the port number that the LDAP server listens on for service requests. The default is 389.
See “Providing LDAP Access to eDirectory for Messenger Users” on page 81.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /ldapport-port_number --ldapport port_number /ldapport-port_number
Example: /Idapport-390 --ldapport 391 /lIdapport-392
See also /ldapipaddr.

4.13.24 /Idappwd

Provides the password for the LDAP user that the Archive Agent uses to log in to the LDAP server.
See “Providing LDAP Access to eDirectory for Messenger Users” on page 81.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /lIdappwd-LDAP_password  --ldappwd LDAP_password  /ldappwd-LDAP_password

Example: /Idappwd-nmlidap --ldappwd nmldap /ldappwd-nmlidap

See also /ldapuser.

Enabling and Managing Archiving

165



4.13.25 /Idapssl

Indicates to the Archive Agent that the LDAP server it is logging in to uses SSL encryption. See
Section 4.6, “Enhancing Archive Security with SSL Encryption,” on page 142.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /Idapssl --ldapssl /Idapssl
See also /ldapsslkey.

4.13.26 /Idapsslkey

Specifies the full path to the private SSL key file used with LDAP authentication. See “Providing
LDAP Access to eDirectory for Messenger Users” on page 81.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /ldapsslkey-[svA][vol:]\dinfile --ldapsslkey /dir/file /\dapsslkey-[drive:]\dinfile
/ldapsslkey-\\svri\voldinfile /ldapsslkey-
\\svAsharename\dir\file
Example: /Idapsslkey- --ldapsslkey /certs/ /ldapsslkey-
\novell\nm\aa\certs\nmkey gwkey.der novell\nm\aa\certs\\nmkey.
.der der
/ldapsslkey- /ldapsslkey-
server2\sys:\novell\nm\ m:\novell\nm\aa\certs\nmk
aa\certs\nmkey.der ey.der
/ldapsslkey- /ldapsslkey-
\\server2\sys\novell\nm\ \\server2\c\novell\nm\
aa\certs\nmkey.der aa\certs\nmk
ey.der
See also /ldapssl.

4.13.27 /ldapuser

Specifies the username that the Archive Agent can use to log in to the LDAP server to obtain
information from eDirectory. See “Providing LDAP Access to eDirectory for Messenger Users” on
page 81.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /Idapuser-LDAP_user_ID --Ildapuser LDAP_user_ID /ldapuser-LDAP_user_ID
Example: /Idapuser-NMAuth --ldapuser NMAuth /ldapuser-NMAuth

See also /ldappwd.

166 Novell Messenger 2.0 Administration Guide



4.13.28 llog

Specifies the directory where the Archive Agent stores its log files. The default location is the
\novell\nm\aa\log directory. See “Using Archive Agent Log Files” on page 148.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: Nlog-[svA][vol:]\dir --log /dir Nog-[drive:]\dir
Nlog-\\svr\voldir Nlog-\\svAsharename\dir
Example: /log-\nmlog\aa --log /nm/log/aa /log-\nmlog\aa
/log-\\server2\mail:\nmlog\aa /log-m:\nmlog\aa
/log-\\server2\mail\nmlog\aa Nlog-\\server2\c\mail\nmlog\aa

See also /loglevel, /logdays, /logmax, and /logdiskoff.

4.13.29 /logdays

Specifies how many days to keep Archive Agent log files on disk. The default is 14 days. See
“Using Archive Agent Log Files” on page 148.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /logdays-days --logdays days /logdays-days
Example: /logdays-7 --logdays 30 /logdays-30

See also /log, /loglevel, /logmax, and /logdiskoff.

4.13.30 /logdiskoff

Turns off disk logging for the Archive Agent so no information about the functioning of the Archive
Agent is stored on disk. The default is for logging to be turned on. See “Using Archive Agent Log
Files” on page 148.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: Nlogdiskoff --logdiskoff /logdiskoff

See also /log, /loglevel, /logdays, and /logmax.

4.13.31 /loglevel

Controls the amount of information logged by the Archive Agent. Logged information is displayed
in the log message box and written to the Archive Agent log file during the current agent session.
The default is Normal, which displays only the essential information suitable for a smoothly running
Archive Agent. Use Verbose to display the essential information, plus additional information helpful
for troubleshooting. Use Diagnostic in include code-specific information. See “Using Archive
Agent Log Files” on page 148.
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NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: lloglevel-level --loglevel level Nloglevel-level

Example: /loglevel-verbose --loglevel diagnostic /loglevel-diagnostic

See also /log, /logdays, /logmax, and /logdiskoff.

4.13.32 /logmax

Sets the maximum amount of disk space for all Archive Agent log files. When the specified disk
space is consumed, the Archive Agent deletes existing log files, starting with the oldest. The default
is 128 MB. See “Using Archive Agent Log Files” on page 148.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /logmax-megabytes --logmax megabytes /logmax-megabytes
Example: /logmax-64 --logmax 256 /logmax-256

See also /log, /loglevel, /logdays, and /logdiskoff

4.13.33 /maxconns

Specifies the maximum number of connections between the Archive Agent and Messenger clients.
The default is 5120. See “Optimizing Connections between the Archive Agent and Messenger
Users” on page 149.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /maxconns-connections --maxconns connections /maxconns-connections
Example: /maxconns-10000 --maxconns 10000 /maxconns-10000

See also /threads.

4.13.34 /mtpipaddr

Specifies the network address of the Server where the Messaging Agent runs, as either an IP address
or a DNS hostname. By default, the Archive Agent uses the network address specified on the
Identification page of the Messaging Agent object.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /mtpipaddr-network_address --mtpipaddr network_address [/mtpipaddr-network_address

Example: /mtpipaddr-172.16.5.18 --mtpipaddr-172.16.5.19 /mtpipaddr-172.16.5.20
/mtpipaddr-server2 --mtpipaddr server3 /mtpipaddr-server4

See also /mtpport.
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4.13.35 /mtpport

Specifies the message transfer port number the Messaging Agent listens on for conversations to
archive. By default, the Archive Agent uses the message transfer port specified on the Identification
page of the Messaging Agent object, which is 8312.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /mtpport-port_number --mtpport port_number /mtpport-port_number
Example: /mtpport-8412 --mtpport 8413 /mtpport-8413
See also /mtpipaddr.

4.13.36 /mtpssl

Sets the availability of SSL encryption between the Archive Agent and the Messaging Agent. Valid
values are enable and disable. See Section 4.6, “Enhancing Archive Security with SSL Encryption,”
on page 142.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: Imtpssl-setting --mtpssl setting Imtpssl-setting
Example: /mtpssl-enable --mtpssl enable /mtpssl-enable

4.13.37 /Inomtp

Disables the Archive Agent's attempts to contact the Messaging Agent.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /nomtp --nomtp /nomtp

4.13.38 /nosnmp

Disables SNMP for the Archive Agent. The default is to have SNMP enabled. See “Using SNMP
Monitoring Programs” on page 149.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /nosnmp --nosnmp /nosnmp

4.13.39 /password

Provides the password for the Archive Agent to use when accessing eDirectory in order to obtain its
configuration information from the Archive Agent object. This switch is required in order to start
the Archive Agent. See Section 4.2, “Starting the Archive Agent,” on page 133.
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NetWare Archive Agent Linux Archive Agent Windows Archive Agent

Syntax: /password- --password /password-
eDirectory_password eDirectory_password eDirectory_password
Example: /password-NMAgent --password NMAgent /password-NMAgent

See also /user.

4.13.40 /port

Sets the port number on which the Archive Agent listens for service requests from Messenger
clients. The default is 8310. See Section 4.5, “Configuring the Archive Agent in ConsoleOne,” on

page 140.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /port-port_number --port port_number Iport-port_number
Example: /port-8410 --port 8411 /port-8412

4.13.41 /queue

Specifies the directory where the Archive Agent stores conversations it receives from the Messaging
Agent while it is archiving other conversations. The default is \novell\nm\aa\queue. See
“Moving the Archive Agent Conversation Holding Queue” on page 154

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax:  /queue-[svA][vol:]\dir --queue /dir /queue-[drive:|\dir

/queue-\\svr\vol\dir /queue-\\sviAsharename\din
Example: /queue-\nmqueues\aa --queue /nmqueues/ /queue-\nmqueues\aa

/queue- aa /queue-m:\nmqueues\aa

\\server2\mail:\nmqueues\aa /queue-

/queue- \\server2\c\mail\nmqueues\aa

\\server2\mail\nmqueues\aa

4.13.42 /ssl

Sets the availability of SSL encryption between the Archive Agent, the Messaging Agent, and
Messenger clients. Valid values are enable and disable. See Section 4.6, “Enhancing Archive
Security with SSL Encryption,” on page 142.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: [ssl-setting --ssl setting [ssl-setting
Example: /ssl-enable --ssl enable /ssl-enable

See also /certpath, /certfile, /keyfile, and /keypassword
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4.13.43 /threads

Specifies the maximum number of client/server threads the Archive Agent can create. The default is
15. See “Optimizing Connections between the Archive Agent and Messenger Users” on page 149.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /threads-number --threads number /threads-number
Example: /threads-10 --threads 20 /threads-20

See also /maxconns.

4.13.44 |user

Provides the eDirectory username for the Archive Agent to use when accessing eDirectory to obtain
its configuration information from the Archive Agent object. This switch is required in order to start
the Messaging Agent. See Section 4.2, “Starting the Archive Agent,” on page 133.

NetWare Archive Agent Linux Archive Agent Windows Archive Agent
Syntax: /user-CN=User_object, --user CN=User_object, /user-CN=User_object,

OU=org_unit,0=organization OU=org_unit,O=organization OU=org_unit,0=organization
Example: /user-CN=Messenger, --user CN=Messenger, /user-CN=Messenger,

OU=Users,O=Novell OU=Users,0=Novell OU=Users,0=Novell

IMPORTANT: Use commas, rather than periods, between object names. If any object name
includes a space, surround the switch value with double quotation marks.

See also /password.
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Managing Chat Rooms

When you initially create your Messenger system, there are no chat rooms. In order for users to start
using chat rooms you must to do some additional system setup, as described in the following
sections:

¢ Section 5.1, “Creating Chat Rooms,” on page 173

¢ Section 5.2, “Editing Chat Room Settings,” on page 175

¢ Section 5.3, “Allowing Users to Use Chat Rooms,” on page 180

+ Section 5.4, “Allowing Users to Create Chat Rooms,” on page 180

5.1 Creating Chat Rooms

There are two ways to create a chat room: in the client interface and in ConsoleOne®. Users must be
granted access to create a chat room in the client interface. Chat rooms that are created in
ConsoleOne are not visible until the chat room service is re-initialized, or the Messaging Agent is
restarted.

¢ Section 5.1.1, “Creating a Chat Room in ConsoleOne,” on page 173

¢ Section 5.1.2, “Creating a Chat Room in the Client,” on page 174

5.1.1 Creating a Chat Room in ConsoleOne

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Select the Chat container.

Nowvell ConsoleQne
File Edit “ew Taools Help

HeZ 0|31 2e e & s ES e
LD My world =
-8 NDS
5§45 DOCTEST2
- comporate
: MessengerService
TR ChatContainer

- HostContainer
G LDAP Container

£ -"“) FolicyContainer
=~ pre-doctest2Serve
F- =) Archivesgent
[+ SropeContainer

[l pre-doctestz o
PR - B e Y
4 | | LIJ iterns 5]

pser. admin.corporate ITreE. DOCTESTZ

Existing scope profiles are displayed in the right pane.
3 Right-click the Chat container, then click New > Object.
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New Object 3

Create object it

DOCTESTZ! QK
ChatContainer. MessengerService corparate
Zancel i
Class:

F Alias Help

B nnmchat

4 Select nnmChat, then click OK.

New Chat Room

Directary 1D (CHY: |

Cheat room narme: |

Ok | Cancel | Help |

5 Type a directory ID name (this is the name that displays in eDirectory™) and a chat room name
(this is the name that users see), then click OK.

The chat room is created; however, you might want to change some additional settings after
creation. For more information about editing chat room settings, see Section 5.2.1, “Editing
Chat Room Settings In ConsoleOne,” on page 176.

When you create a chat room in ConsoleOne, you must either re-initialize the chat service, or
restart the Messaging Agent.

5.1.2 Creating a Chat Room in the Client

By default users cannot create chat rooms in the client interface. They must be granted access in
ConsoleOne before the can create a chat room. For information on how to allow users to create chat
rooms in the client, see Section 5.4, “Allowing Users to Create Chat Rooms,” on page 180.

1 Click Tools > Chat Rooms, then click Create.
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Chat Room Properties gl

General | Access | Information

Owier:
Change Dwner

|user'| |

Chat roonn narne:

|Suppolt |

Dezcription:

Far support questions

Welcome meszage:

‘welcome ta the support chat room.

The welcome mezzage will be seen when people enter the chat roam.

Mawimum participants: S

[ &lways archive

Allaw chat room to be searchable

I QK. H Cancel ” Apply

N

(Optional) Select the owner of the chat room.

By default, the owner is the user who is creating the chat room.

Type the chat room name.

(Optional) Type a description, and welcome message for the chat room.

(Optional) Select the maximum number of participants.

(Optional) Select if you want to archive the chat room.

(Optional) Select if you want the chat room to be searchable.

(Optional) Click the Access tab, then select the access rights for all users and a particular user.

Click OK to create the chat room.

5.2 Editing Chat Room Settings

You can edit the chat room settings either in ConsoleOne or in the client interface. The client must
be granted access to modify the settings in the client interface. For information on how to allow
users to create and edit chat rooms in the client, see Section 5.4, “Allowing Users to Create Chat
Rooms,” on page 180.

© 0 N O 0 A~ W

¢ Section 5.2.1, “Editing Chat Room Settings In ConsoleOne,” on page 176
¢ Section 5.2.2, “Editing Chat Room Settings in the Client,” on page 178
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5.2.1 Editing Chat Room Settings In ConsoleOne

In ConsoleOne, you can change the general settings and the access settings for a chat room.
¢ “General Settings” on page 176
* “Access Settings” on page 177

General Settings

1 In ConsoleOne, browse to and expand the Messenger Service object.
2 Select the Chat object to edit.

Nowvell ConsoleQne

File Edit “ew Taools Help

e B ® e 1] 2 v e & e s a6
@My\u’\for\d T supnort

=g NDS

o-gF DOCTESTZ2

- comporate

-4 MessengerService
{5 HostContainer
i LDAP Container
#-¥4 PolicyContainer
=-F pre-doctestzServe
B ArchiveAgent
| ScopeContainer

[ prv-doctest =
o D mm s e e A
| | LH 1 iterms 5]

pser. admin.corparate

[Tree: DOCTEST2

Existing scope profiles are displayed in the right pane.
3 Right-click the chat object, then click Properties.

Praperties of support

&
Chat ~"| NDS Rights = | Other | Rights to Files and Folders |
Genersl

Cwner:

[adimin carporate

Chat room name:

[Support Chat Room
Description:

Welcome message

I Maximum particioants: =
I~ Always archive messages inthis room

[¥ Chat room is searchable

Page Options...

concel | | e |

4 Sclect an owner of the chat room. You can click ﬂ to browse for the owner in the eDirectory
tree.

5 Type a chat room name. This is the name that users see.
6 (Optional) Type a description for the chat room.

7 (Optional) Type a welcome message for the chat room.
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8 (Optional) Select the maximum number of participants, then specify the number of
participants.

9 (Optional) Select if you want to always archive the chat room messages.

10 (Optional) Select if you want to make the chat room searchable. By default, the chat room is
searchable.

11 Click OK to save the settings.
Access Settings

1 In ConsoleOne, browse to and expand the Messenger Service object.

2 Select the Chat object to edit.

Nowvell ConsoleQne

File Edit “ew Taools Help

He|® ® 0 2e e alse v ns el
@My\-’\ror\d R support

=4 NDS

&% DOCTESTZ2

- comporate

B @ MessengerService

:
HostCaontainer
i LDAP Container
¥4y PalicyCantainer
B predoctestzServe
= ArchiveAgent
%) ScopeContainer

~-[] pre-doctestz -
o T mea s e |
5 | |LH 1 tems= % |

pser. admin.corparate iTreE. DOCTESTZ

Existing scope profiles are displayed in the right pane.
3 Right-click the chat object, then click Properties.
4 Click Chat > Access.

Praperties of support g|

Chat +"| NDS Rights + | Other | Rights to Files and Folders |
Access

User Rights

Rights
ekl Liser

= ¥ gend I Moty Rights I Moderator

Set Password ‘ |
Page Options... Cancel Help

5 By default general user access is displayed in the access list. To add another user to the access
list, click Add User-.

6 Browse to and select the user in the eDirectory tree, then click OK.
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7 Select the access rights for the user.

View: Allows the user to view the chat room.

Send: Allows the user to send a message to the chat room.

Modify Rights: Allows the user to modify the rights to the chat room.

Moderator: Allows the moderator to delete a user and change the topic of the chat room.
8 (Optional) Click Set Password to set a password for the chat room.

This requires users to enter a password to join the chat room. There is only one password for all
participants in the chat room.

9 Click OK to save the settings.

5.2.2 Editing Chat Room Settings in the Client

In the client, you can change the general settings and the access settings for the chat room.

¢ “General Settings” on page 178
* “Access Settings” on page 179

General Settings

You can edit the settings for a chat room only if the administrator has granted you access to create
chat rooms. The default access does not allow you to create a chat room.

1 Click Tools > Chat Rooms, select the chat room to edit, then click Properties.

Chat Room Properties D_<|

Generdl | Access | Information

Owrer:
Change Dwiner

Lizer

Chat room name:

Support

Deszcription:

For support questions

Welcome message:

Wwielcome to the support chat room.

The welcome meszage will be seen when people enter the chat room.
M aximum participants: 50 o

[ &lwaysz archive

Allaw chat room to be searchable

I ak, H Cancel H Apply

2 (Optional) Select the owner of the chat room.

By default, the owner is the user who is creating the chat room.
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3
4
5
6
7
8
9

Type the chat room name.

(Optional) Type a description, and welcome message for the chat room.

(Optional) Select the maximum number of participants.

(Optional) Select if you want to archive the chat room.

(Optional) Select if you want the chat room to be searchable.

(Optional) Click the Access tab, then select the access rights for all users and a particular user.

Click OK to save the settings.

Access Settings

You can modify the access rights for a chat room if you have been granted rights to do so.

1 Click Tools > Chat Rooms, select the chat room to modify, then click Properties.

Chat Room Properties &l

General | Access | |nformation

Uzer Rights

Mame Rightz

<Eeneral Us

Send [ Modify Rights [ Moderator

Moderators can delete users and change the Chat Room T opic.,

l QK. ” Cancel ” Apply ]

By default general, user access is displayed in the access list. To add another user to the access

list, click Find User.

Type the user's name in the Name field, then click Next.
Select the user in the list, then click Finish.

Select the access rights for the user:

View: Allows the user to view the chat room.

Send: Allows the user to send a message to the chat room.

Modify Rights: Allows the user to modify the rights to the chat room.

Moderator: Allows the moderator to delete a user and change the topic of the chat room.

Click Set Password to set a password for the chat room.
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This requires users to enter a password to join the chat room. There is only one password for all
participants in the chat room.

7 Click OK or Apply to save the settings.

5.3 Allowing Users to Use Chat Rooms

By default, users are allowed to use chat rooms. However, you can disable this functionality for all
users, for a user policy, or for a certain user.

1 Right-click either the default policy (all users), a user policy (users governed by the policy), or
a user, then click Properties.

2 Select Allow Users to Use Chat Rooms.

3 Click OK to save the settings.

5.4 Allowing Users to Create Chat Rooms

By default users are not allowed to create chat rooms. However, you can enable this functionality for
all users, for a user policy, or for a certain user.

1 Right-click either the default policy (all users), a user policy (users governed by the policy), or
a user, then click Properties.
2 Select Allow Users to Create Chat Rooms.

3 Click OK to save the settings.
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Securing Novell Messenger

This section provides specific instructions on how to install, configure, and maintain Novell®
Messenger 2 in the most secure way possible.

¢ Section 6.1, “Limiting Physical Access to Messenger Servers,” on page 181
¢ Section 6.2, “Securing File System Access,” on page 181
¢ Section 6.3, “Securing the Messenger Agents,” on page 181

*

Section 6.4, “Securing Directory Access,” on page 185

*

Section 6.5, “Securing the Messenger System,” on page 186

6.1 Limiting Physical Access to Messenger
Servers

Servers where Messenger data resides should be kept physically secure, so unauthorized persons
cannot gain access to the server consoles.

6.2 Securing File System Access

In ConsoleOne®, Server objects for servers where Messenger agents reside should be assigned
appropriate trustees and rights to prevent access from unauthorized persons.

For additional data security, encrypted file systems should be used on servers where Messenger
agents and archives reside.

6.3 Securing the Messenger Agents

¢ Section 6.3.1, “Enabling SSL for Client/Server Connections,” on page 181

+ Section 6.3.2, “Enabling SSL for the Message Transfer Protocol,” on page 182
Section 6.3.3, “Enabling SSL for the Web Console,” on page 183

Section 6.3.4, “Enabling Password Protection for the Web Console,” on page 183

*

*

*

Section 6.3.5, “Securing the Data Files,” on page 183

6.3.1 Enabling SSL for Client/Server Connections

All the connections between the client and the server should be configured to use SSL. To do this,
SSL must be configured for the agents. For information on configuring SSL for the agents and for
the client, see “Creating Your Messenger System” for NetWare® and Windows and “Configuring the
Linux Messenger Agents for SSL” for Linux in the Messenger 2.0 Installation Guide. To secure the
client, simply use the port number specified for secure connections when connecting to the server.
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6.3.2 Enabling SSL for the Message Transfer Protocol

When installing the agents, you have the option to configure SSL for the agents. If you chose to use
SSL for the connection between the agents and the clients, the Message Transfer Protocol is
automatically configured to use SSL as well. For more information, see “Creating Your Messenger
System” for NetWare and Windows and “Configuring the Linux Messenger Agents for SSL” for
Linux in the Messenger 2.0 Installation Guide.

Configuring SSL for the Message Transfer Protocol After Installation

In order for the Message Transfer Protocol to use SSL, you must enable SSL for the agents. If you
chose not to use SSL during the installation, you can configure SSL for the agents in ConsoleOne.

Before the agents and the Message Transfer Protocol can use SSL encryption, you must send a
Certificate Signing Request (CSR) to a Certification Authority (CA) and receive a public certificate
file in return. The CSR includes the hostname of the server where the Messaging Agent runs. The
Messaging Agent and the Archive Agent can use the same certificate if they run on the same server.
The CSR also includes your choice of name and password for the private key file that must be used
with each certificate. This information is needed when configuring the Messaging Transfer Protocol
to use SSL encryption. For more information, see Section 2.3.1, “Generating a Certificate Signing
Request and Private Key,” on page 34.

After you have a public certificate and a private key file available on the server where the Messaging
Agent runs, you are ready to configure the Messaging Agent to use SSL encryption.

1 In ConsoleOne, browse to and expand the Messenger Service object.
2 Right-click the Messenger ArchiveAgent object, then click Properties.
3 Click Agent > Security.

Properties of ArchiveAgent El
Agent + | NDS Rights ~ | Other | Rights to Fies and Folders |
Securty
Certiinats Fath: fapthavellmessengericerts
Security
SSL Certificate: server pemm @
SSL Key File: server key [E]
Set Password
Enable SSL for Cliert/Server
Enable SSL for Message Transfer Protocal
Restors Detault Settings
Page Options... Cancel Help

4 Fill in the following fields:

Certificate Path: This field defaults to \novell\nm\certs for NetWare and Windows,
and /opt/novell/messenger/certs for Linux.
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6

IMPORTANT: The certificate path must be located on the same server where the Messenger
agents are installed. If your SSL certificate and key file are located on a different server, you
must copy them into the directory specified in the Certificate Path field so they are always
accessible to the Messenger agents.

SSL Certificate: Browse to and select the public certificate file. Or, if it is located in the
directory specified in the Certificate Path field, you can simply type the filename.

SSL Key File: Browse to and select your private key file. Or, if it is located in the directory
specified in the Certificate Path field, you can simply type the filename.

Set Password: Provide the key file password you established when you submitted the
certificate signing request.

Enable SSL for Client/Server: Select this option to enable SSL encryption for your client and
server.

Enable SSL for Message Transfer Protocol: Sclect this option to enable SSL encryption for
your Messenger Transfer Protocol.

Click OK to save the SSL settings.
Restart the Messaging Agent to begin using SSL encryption.

6.3.3 Enabling SSL for the Web Console

The Web console should already be configured to use SSL when SSL is configured during the
installation. However, additional configuration is needed to enable SSL for the Web console. For
information on how to secure and configure the Web console, see “Setting Up the Messaging Agent
Web Console” on page 38 and Section 4.10.2, “Using the Archive Agent Web Console and
GroupWise Monitor,” on page 148.

6.3.4 Enabling Password Protection for the Web Console

The Web console should be configured to use SSL and password protection, but password protection
needs to be enabled. For information on how to enable password protection for the Web console, see
“Setting Up the Messaging Agent Web Console” on page 38 and Section 4.10.2, “Using the Archive
Agent Web Console and GroupWise Monitor,” on page 148.

6.3.5 Securing the Data Files

*

“Securing the Data Store” on page 183
“Securing the Queue Files” on page 184
“Securing the Log Files” on page 184
“Securing the Startup Files” on page 185
“Securing the Root Certificate” on page 185

Securing the Data Store

The data store files should be protected from tampering. The data store files are identified by an
eight-digit hexadecimal number followed by either .maf or .mai. They are found in the
following default locations:

Securing Novell Messenger

183



Table 6-1 Messenger Data Store File Locations

Platform Directory Store Files

NetWare sys:\Novell\NM\aa\store XXXXXxxX.maf
XXXXXXXX.mai

Linux /var/opt/novell/messenger/aa/store xxxxxxxx.maf
XXXXXXXX.mai

Windows C:\Novell\NM\aa\store xxxxxxxx.maf
XXXXXXXX.mai

Securing the Queue Files

The queue files should be protected from tampering. The queue files are identified by an eight-digit
hexadecimal number followed by three numbers. They are found in the following default locations:

Table 6-2 Messenger Queue File Locations

Platform Directory Queue Files

NetWare sys:\Novell\NM\ma\queue XXXXXXXX.NNnN
sys:\Novell\NM\aa\queue

Linux /var/opt/novell/messenger/ma/queue XXXXXXXX.NNN
/var/opt/novell/messenger/aa/queue

Windows C:\Novell\NM\ma\queue XXXXXXXX.NNn
C:\Novell\NM\aa\queue

Securing the Log Files

The log files for all Messenger agents should be protected from access by unauthorized persons.
Some contain very detailed information about your Messenger system and Messenger users. They
are found in the following default locations:

Table 6-3 Messenger Agent Log File Locations

Platform Directory Log Files
NetWare vol:\Novell\MA\logs mmddnma . nnn
vol:\Novell\AA\logs mmddnaa.nnn
Linux /var/opt/novell/log/messenger/ma/ mmddnma . nnn
/var/opt/novell/log/messenger/aa mmddnaa.nnn
Windows C:\Novell\MA\logs mmddnma . nnn
C:\Novell\AA\logs mmddnaa . nnn
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Securing the Startup Files

The startup files for all Messenger agents should be protected from tampering. They are found in the

following default locations:

Table 6-4 Messenger Agent Startup File Locations

Platform Directory

Startup Files

NetWare sys:\Novell\NM\ma
sys:\Novell\NM\aa

strtup.ma
strtup.aa

Linux /etc/init.d

novell-nmma
novell-nmaa

Windows C:\Novell\NM\ma

strtup.ma

C:\Novell\NM\aa strtup.aa

Securing the Root Certificate

The root certificate files should be protected from tampering. The root certificate files are copied to
the following default locations:

Table 6-5 Root Certificate File Locations

Platform Directory Startup Files

NetWare sys:\Novell\NM\certs certname.der

Linux /opt/novell/messenger/certs certname.der

Windows C:\Novell\NM\certs certname.der

6.4 Securing Directory Access

¢ Section 6.4.1, “Enabling SSL for LDAP,” on page 185
¢ Section 6.4.2, “Creating a Proxy User for LDAP Access,” on page 185
¢ Section 6.4.3, “Using DirUserAuthBind,” on page 186

6.4.1 Enabling SSL for LDAP

You should use LDAP instead of direct access mode if the eDirectory™ tree is on a different
machine than the agents. When connecting with LDAP, SSL should be used to secure the
connection. For additional information on how to secure the LDAP connection, see “eDirectory
Access and Authentication” in the Messenger 2.0 Installation Guide.

6.4.2 Creating a Proxy User for LDAP Access

The admin user should not be used when connecting with LDAP access. Instead, a proxy user
should be created with limited rights. For information on what rights the LDAP proxy user must
have, see “eDirectory Access and Authentication” in the Messenger 2.0 Installation Guide.
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6.4.3 Using DirUserAuthBind

When a user authenticates, DirUserAuthBind binds the user to the directory tree so password
policies can be enforced. DirUserAuthBind is a startup switch in the startup files for both agents.

For additional information on configuring DirUserAuthBind, see Section 3.2.3, “Selecting Bind or
Compare eDirectory Access for Users,” on page 90.

6.5 Securing the Messenger System

¢ Section 6.5.1, “Configuring Remember Passwords,” on page 186
¢ Section 6.5.2, “Understanding History and Save Conversation Security,” on page 186

¢ Section 6.5.3, “Using Scopes as Security,” on page 187

6.5.1 Configuring Remember Passwords

Messenger can be configured to remember passwords for the client login. However, this can cause
security concerns. If a workstation is left unlocked, anyone can log in as that user if the Remember
Password setting is selected. In addition, some third-party software packages, such as Gaim, might
store the passwords in plain text.

For security reasons, the ability to remember passwords should be disabled. For information on how
to disable the Remember Password option, see Section 3.4.3, “Customizing Messenger Client
Features,” on page 101.

6.5.2 Understanding History and Save Conversation Security

¢ “History Security” on page 186

+ “Saved Conversation Security” on page 187

History Security

When the history option is enabled, the history files are stored on the client workstation in the
following locations by default:

Table 6-6 Default History File Locations

Operating System  Location

Windows C:\Documents and Settings\username\Local Settings\Application
Data\Novell\GroupWise Messenger\history

Linux /home/username/ .novell//messenger/history

Macintosh /User/username/ .novell/messenger/history

The history files are stored as XML files, so anyone with access to the machine can view the files.
For maximum security, the History option should be disabled. For information on how to disable the
History option, see Section 3.4.3, “Customizing Messenger Client Features,” on page 101.
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Saved Conversation Security

A saved conversation is stored as a text file, so anyone with access to the machine can view the file.
For maximum security, the ability to save conversations should be disabled. For information on how
to do this, see Section 3.4.3, “Customizing Messenger Client Features,” on page 101.

6.5.3 Using Scopes as Security

When the Messenger system is created, a default scope profile is created, and you are prompted for
the location of users to add to the default scope profile. You can also create custom scope profiles.
Users can only see users in contexts defined by their scope profiles. Multiple scope profiles can be
created with different ranges of contexts. These scope profiles can be assigned to users to limit the
other users they can see. For example, many companies create a separate scope profile for
executives, to allow them to use Messenger but not be seen or accessed by other users. This could
also be used for different departments or business units.

To create a new Messenger scope profile:

In ConsoleOne, browse to and expand the Messenger Service object.
Right-click the Scope Container object, then click New > Object.

Select nnmScopeProfile, then click OK.

Specify the name of the scope profile, then select Define additional properties.
Click OK.

Click A4dd.

Specify the context for the users to be added to the new scope, then select Include sub-contexts
to include sub-contexts if desired.

Click OK twice.

9 Right-click a User object to add a user, or click a Policy object to add a group of users assigned
to a policy, then click Properties.

10 Click the Novell Messenger > General Tab.
11 In the Scope profile box, specify the new scope profile, then click OK.

N OO g A ON -

(]

12 Restart the Messenger agents.
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Documentation Updates

This section lists updates to the Administration Guide that have been made since the initial release of
Novell® Messenger 2. The information helps you to keep current on documentation updates and, in
some cases, software updates (such as a Support Pack release).

The information is grouped according to the date when the Administration Guide was republished.
Within each dated section, the updates are listed by the section title.

The Messenger 2 Administration Guide has been updated on the following dates:

¢ Section A.1, “November 17, 2008,” on page 189
¢ Section A.2, “May 16, 2007,” on page 189
¢ Section A.3, “June 15, 2006 (Messenger 2 SP 1),” on page 189

A.1 November 17, 2008

Location Change
Entire Document Updated document to current template and current Novell style
Entire Document Changed all instances of GroupWise Messenger CD to

Downloaded GroupWise Messenger 2 image.

A.2 May 16, 2007

Location Change

Section 2.4, “Changing the Agent User Password,” Added a section on how to change the password
on page 35 for the user that is used to start the agents.

“/password” on page 73 Added information about obscured passwords.

Section 2.4, “Changing the Agent User Password,” Added a section on how to change the password
on page 35 for the user that is used to start the agents.

A.3 June 15, 2006 (Messenger 2 SP 1)

Location Change

“Securing Novell Messenger” on  Added a section on how to secure your Messenger system.
page 181

“Configuring the LDAP Profile” on  Recommended defining only one priority 0 LDAP server.
page 82
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Location

Change

Section 3.2.2, “Providing Full
Name Indexing,” on page 89

Section 3.5.2, “Setting Up Auto-
Update,” on page 112

Entire Guide

Explained how to index the Full Name attribute to improve user
searchers for contacts.

Added the new Enable Client Auto-Update option.

Page design reformatted to comply with revised Novell®
documentation standards.
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